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Notice
The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material, including 
but not limited to, the implied warranties of merchantability and fitness for a particular 
purpose. Agilent Technologies shall not be liable for errors contained herein or for incidental 
or consequential damages in connection with the furnishing, performance, or use of this 
material.

LIMITED WARRANTY
The material contained in this document is provided “as is,” and is subject to being changed, 
without notice, in future editions. Further, to the maximum extent permitted by applicable 
law, Agilent disclaims all warranties, either express or implied with regard to this manual 
and any information contained herein, including but not limited to the implied warranties of 
merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or 
for incidental or consequential damages in connection with the furnishing, use, or 
performance of this document or any information contained herein. Should Agilent and the 
user have a separate written agreement with warranty terms covering the material in this 
document that conflict with these terms, the warranty terms in the separate agreement will 
control.

Assistance
Product maintenance agreements and other customer assistance agreements are available for 
Agilent Technologies products. For any assistance, refer to “Contacting Agilent” in the 
“Troubleshooting and Maintenance” chapter of the PLTS Installation and Reference Guide.
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Software Licensing
The Physical Layer Test System has two licensing options. The options are:

Node-Locked allows use of PLTS software only on a single personal computer. The license 
resides on and is tied to the local PC via a hardware address.

Network-Server
Floating allows the sharing of a licences (or multiple licences) across a network. The 

PLTS software may be installed on an unlimited number of personal 
computers. The license(s) reside on a networked drive/folder and are 
checked out on a first-come, first-served basis.

Refer to the “Installing the Physical Layer Test System Software” chapter of the PLTS 
Installation and Reference Guide for the licensing procedure.

Software Compatibility
This user’s guide is compatible with Physical Layer Test System software revisions 2.500 and 

above. 

Document Conventions
This document uses a few conventions to make reading easier.

• Menu and dialog box items are shown in bold face type. When described in text, menus and 
sub-menus are separated by right arrows, as in File > Open > Data…

• Window and dialog box names are shown in italic font.

• Keyboard entries are shown in mono-spaced typeface.

• Network analyzer keys are displayed in condensed, bold font.
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Embedded Operating System Risk

PNA Network Analyzers

The Agilent PNA-family of network analyzers make use of Embedded Operating Systems 
(EOS) technology. The EOS is Windows1 2000, a standard personal computer-based operating 
system. The PNA is essentially a network analyzer with a personal computer behind the front 
panel.

EOS devices, including the PNA may be connected to computer networks. When connected, 
these devices are open to numerous security exploits, worms, and viruses. In addition, they 
can become a threat to other EOS devices, servers, end-user PCs, and to the network itself.

Precautions are taken to ensure that the PNA has no security issues, such as worms or 
viruses, prior to shipping. To maintain the health of the PNA, it is recommended that you 
install anti-virus software and the latest service packs on the PNA before connecting the PNA 
to a computer network.

Infiniium DCA Oscilloscopes

On your 86100C, you can access Microsoft Windows XP Professional just as you would on your 
personal computer. Use Windows XP Professional to manage files and folders, add, remove, 
and setup printing, configure networking, and install applications. The ability to access the 
operating system is not available on 86100A/B instruments.

Although the 86100C is an instrument and not a personal computer, the operating system is 
accessible. This makes it possible for you to install applications such as virus protection 
software. If the performance of the Infiniium DCA application decreases while running other 
applications, you may need to close those applications that are demanding processor 
resources. It is also suggested that you schedule automatic virus scans for times when you are 
not making measurements. Refer to the 86100C Help for complete information.

1. Windows and MS Windows are U.S. registered trademarks of Microsoft Corporation.
iv



Contents
I. Calibration and Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1. Setting Up and Making Measurements using the VNA-Based PLTS  . . . . . 3
Navigating the Startup Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

How to Perform the Initial Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
How to Perform a Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
How to Make a Measurement  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Analyzing the Measurement Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

2. Performing Error Correction on the VNA-Based PLTS. . . . . . . . . . . . . . . . 23
What Is Measurement Calibration? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Why Is Calibration Needed? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
When Is Calibration Needed? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
How to Verify a Calibration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Establishing a Golden Device  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
How to Perform a Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Selecting a Calibration Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Performing an SOLT Calibration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
Performing a TRL Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Performing an LRM Calibration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Characterizing Adapters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

3. Setting Up, Calibrating, and Making Measurements using the TDR-Based 
PLTS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Starting the Startup Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Performing the Initial Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

To Verify the Software Recognizes the PLTS Hardware. . . . . . . . . . . . . . . . . . . . . . . 92
To Select the Appropriate Level of Calibration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
To Set Up the TDR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
To Select the Calibration and Measurement Parameters  . . . . . . . . . . . . . . . . . . . . . 97

Performing a Calibration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
To Select a Calibration Kit and Define the Calibration File Name . . . . . . . . . . . . . 100
To Define a Calibration Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
To Choose the Calibration Type. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
To Perform a Module Calibration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
To Set the Reference Plane at the End of the Cables . . . . . . . . . . . . . . . . . . . . . . . . 111

Making a Measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
To Connect the DUT . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
 v



Contents
To Select the Initial Displayed Format of the Measurement . . . . . . . . . . . . . . . . . . 119
To Modify the Measurement Stimulus and Measured Parameters . . . . . . . . . . . . . 120
To Run the Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122

II. Data Analysis, Exporting, and Utilities . . . . . . . . . . . . . . . . . 125

4. Analyzing Data in the Frequency Domain . . . . . . . . . . . . . . . . . . . . . . . . . . 127
About S-Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129

Common Frequency Measurements with S-Parameters  . . . . . . . . . . . . . . . . . . . . . 129
How to Interpret S-Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130

Single-Ended (Unbalanced) S-Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
Mixed Mode (Balanced) S-Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

Viewing Data in the Frequency Domain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
Opening a Frequency Domain Plot Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
Viewing All 16 S-Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
Viewing a Single S-Parameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
Creating a Custom S-Parameter Plot Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

Selecting Frequency Domain Display Formats  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
Setting the Scale  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

Quick Scale Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

5. Analyzing Data in the Time Domain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
TDR/TDT Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149
Analyzing Time-Domain Signatures. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Practical Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156

Masking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Time Domain Windowing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
Response Resolution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
Range Resolution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
Spatial Resolution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
Automated Start and Stop Settings In Time Domain  . . . . . . . . . . . . . . . . . . . . . . . 162
Uncoupled Start Frequency and Step Frequency Setting  . . . . . . . . . . . . . . . . . . . . 166

Checking the Validity of a Time-Domain Calculation . . . . . . . . . . . . . . . . . . . . . . . . . 167
Viewing Data in the Time Domain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168

Opening a Time Domain Plot Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
vi



Contents
Viewing All 16 Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169
Viewing a Single Parameter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Creating a Custom Time Domain Plots Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

Optimizing the Time Domain Time Scale for Viewing  . . . . . . . . . . . . . . . . . . . . . . . . 173
Changing the Start Time and Stop Time Manually . . . . . . . . . . . . . . . . . . . . . . . . . 175

Selecting Time Domain Display Formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Setting the Scale  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180

Quick Scale Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
Gating . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183

6. Analyzing Data using Eye Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
The Eye Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187

Time Domain Windowing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
Uncoupled Start Frequency and Step Frequency Setting  . . . . . . . . . . . . . . . . . . . . 193

Designing a Bit Pattern for Eye Diagrams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
Viewing Data using Eye Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

Opening a Eye Diagram Plot Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
Viewing All Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
Viewing a Single Eye Diagram  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
Creating a Custom Eye Diagram Plots Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . 203

7. Analyzing Transmission Line Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . 205
Transmission Line Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207
Extracting Fitted RLCG Parameters from S-Parameters . . . . . . . . . . . . . . . . . . . . . . 209
Coupled-Transmission Line Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
CPTL RLCG Extraction Procedure. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214
RLCG Output Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
Export Data Formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218
Considerations When Extracting RLCG Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . 222
The Parameters for Each RLCG Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224
Viewing Transmission Line Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225

Opening a Transmission Line Plot Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
Viewing All Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Viewing a Single RLCG Parameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229
Creating a Custom RLCG Plot Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
Viewing Fitted and Smoothed RLCG W-Element Traces . . . . . . . . . . . . . . . . . . . . . 231

Setting the Scale  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
Quick Scale Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238
 vii



Contents
Exporting Transmission Line Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240

8. Importing and Exporting Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241
Importing Data Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244

CITIFile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
Touchstone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245

Exporting Data Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
Plot(s) to Clipboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
Plot(s) to Image File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 248
Frequency Domain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249
CITIFile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
Touchstone. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251
Time Domain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252
TDA Systems MeasureXtractor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 254
RLCG. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256

File Formats  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
CITIfile  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
S4P (Touchstone)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264

RLCG Data Formats  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268
HSPICE W-Element/ADS ML2CTL Model Formats. . . . . . . . . . . . . . . . . . . . . . . . . 268
HSPICE W-Element Tabular/ADS MDIF Formats. . . . . . . . . . . . . . . . . . . . . . . . . . 270

9. Removing Unwanted Effects from the Measurement . . . . . . . . . . . . . . . . 273
Gating . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276

To Add a Gate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276
To Move a Gate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
To Delete a Gate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280

Reference Plane Adjustment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281
To Use Port Reference Adjustment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283

10. Using Analysis Tools and Utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Markers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291

Time-Domain, Frequency-Domain, and RLCG Markers . . . . . . . . . . . . . . . . . . . . . 291
Frequency Domain Polar and Smith Chart Markers . . . . . . . . . . . . . . . . . . . . . . . . 296
Eye Diagram Markers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299

Click and Drag Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
viii



Contents
Math . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
Creating a Math Formula. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
Applying a Math Formula  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310
Using Quick Math. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311

Data Sharing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313
Characterization Report Generator  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315
Copying and Pasting Plot Formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 320
Renaming Plots  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 322
Printing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 324

Print Setupº. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325
Print Previewº . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327
Printº . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329

File Converter  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332

III. Appendix . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335

A. Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337
Setting Up the General Purpose Interface Bus Manually. . . . . . . . . . . . . . . . . . . . . . 339
Using the Network Analyzer to Make 2-Port Measurements . . . . . . . . . . . . . . . . . . . 341
Converting a CitiFile to a PLTS Adapter File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 342
IF Gain Adjustment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 344

Adjustment Test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 344
 ix



Contents
x



I Calibration and Measurements
1



Part I provides detailed information about making measurements using both the VNA-based 
and TDR-based physical layer test systems. Part I also provides information about error 
correcting each system for optimum accuracy.

Chapter 1, “Setting Up and Making Measurements using the VNA-Based PLTS”

Provides information about making a measurement using the VNA-based PLTS.

Chapter 2, “Performing Error Correction on the VNA-Based PLTS”

Provides information about performing error correction on the VNA-based 
PLTS.

Chapter 3, “Setting Up, Calibrating, and Making Measurements using the 
TDR-Based PLTS”

Provides information about performing error correction and making a 
measurement using the TDR-based PLTS.
2



1 Setting Up and Making Measurements 
using the VNA-Based PLTS
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Setting Up and Making Measurements using the VNA-Based PLTS
This chapter guides you through setting up the initial measurement definitions, performing 
the system calibration, making a measurement, and analyzing the measurement results. It 
uses a simple balanced transmission line that was supplied with the system as a sample 
device-under-test (DUT). See Figure 1-1.

Figure 1-1 Balanced Transmission Line Sample DUT

The Startup Wizard steps you through the initial setup, the calibration, and the 
measurement. 

1. Initial setup includes:

• System Hardware Verification
• Calibration Level Selection
• Calibration and Measurement Parameter Selection

2. Calibration includes:

• Calibration Type Selection and Calibration Kit Selection
• Calibration (SOLT Mechanical, SOLT Electronic, TRL, or LRM)
• Adapter Characterization

3. Measurement includes:

• Device Under Test Connection
• Analysis Type Selection
• Stimulus Verification
• Running a Measurement

After the measurement is made, the main Physical Layer Test System (PLTS) window gives 
you the flexibility to perform analysis on the measured data in a variety of ways.

• Frequency Domain. Allows for analysis in Balanced and Single-Ended mode.

• Time Domain. Allows for analysis in Differential and Single-Ended mode. 

• Eye Diagram. Allows for analysis in Differential and Single-Ended mode.

• Transmission Line (RLCG). Allows for analysis in Differential, Common, W-Element, 
and Self/Mutual modes.
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Navigating the Startup Wizard
Navigating the Startup Wizard
When PLTS is first started, the Startup Wizard is displayed. The Startup Wizard Welcome 
Screen is displayed in Figure 1-2. It is also displayed anytime a new measurement is initiated, 
such as after selecting New from the File menu, or clicking on the new file icon on the toolbar. 

Figure 1-2 Startup Wizard Welcome Screen

The Startup Wizard Welcome Screen gives you two choices, New Measurement or Load 
Measurement. The selected choice has a green check mark to the right of the label. New 
Measurement leads you through the process of calibrating and making a measurement. 
Load Measurement loads measurement data from an existing file that you must select. 

When you select New Measurement, the Startup Wizard will guide you through:

• Initial Setup
• Calibration
• Measurement 

For this exercise, select New Measurement and then select the Next > button.
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Navigating the Startup Wizard
How to Perform the Initial Setup

The Initial Setup process consists of:

1. Verifying that the software recognizes your PLTS system hardware.

This step uses the left portion of the Hardware Auto-Detection Summary dialog box to 
verify that the software recognizes the correct system hardware. This portion of the dialog 
box displays the model number, GPIB address, and serial number of the hardware. You 
may re-scan to look for hardware changes automatically. You may select another 
recognized PLTS measurement system.

2. Selecting the appropriate level of calibration for the upcoming measurement.

This step uses the right portion of the Hardware Auto-Detection Summary dialog box to 
select the appropriate level of calibration to be performed. You may perform a new 
calibration, reuse existing calibration data, or perform measurements without calibration.

3. Setting up the VNA Calibration and Measurement Settings.

This step uses the Setup TDR dialog box to display the default TDR calibration and 
measurement settings, based on the PLTS hardware recognized by the software. You may 
modify these default TDR calibration and measurement settings as required.
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When you selected New Measurement and then clicked the Next > button described on 
page 5, the Hardware Auto-Detection Summary dialog box is displayed. See Figure 1-3.

Figure 1-3 Hardware Auto-Detection Summary Dialog Box

Verifying the Software Recognizes the PLTS Hardware

On the left portion of the Hardware Auto-Detection Summary dialog box, the VNA’s model 
number, the GPIB address, the serial number, and the firmware revision is displayed. In 
addition, the test set’s model number, the GPIB address, and the serial number are displayed. 
This is the test equipment that the software finds connected to the GPIB bus. 

If this information is incorrect, check your hardware connections and power status, then 
select the Re-Scan button. The software re-checks for the presence of hardware on the GPIB.
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NOTE If you have multiple PLTS systems on the GPIB and you want to select the 
other equipment, click the Select New Device button. The Select 
Measurement System dialog box is displayed. See Figure 1-4. To choose another 
PLTS system, you may select from the available PLTS systems and then click 
the OK button. The software makes the change and returns to the Startup 
Wizard Welcome Screen of Figure 1-2.

Figure 1-4 Select Measurement System Dialog Box

The Cancel button exits without saving a change and returns to the Startup 
Wizard Welcome Screen.

Selecting the Appropriate Level of Calibration

On the right portion of the Hardware Auto-Detection Summary dialog box (Figure 1-3), select 
your calibration strategy:

• Perform a new calibration continues with the Startup Wizard performing a new 
calibration before making a measurement.

• Load existing calibration data allows you to select a previously saved calibration 
(*.cal) file to be used for the new measurement. See Chapter 2, “Performing Error Correc-
tion on the VNA-Based PLTS,” for guidance on calibration intervals, etc.

• None. Collect measurement data uncalibrated allows you skip the calibration, select 
measurement parameters (see Figure 1-6 on page 10), and then proceed directly to the 
measurement screen. This option is not recommended for qualitative data collection.

Select the Perform a new calibration choice for this example exercise and then click the 
Next > button.
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Setting Up the Calibration and Measurement Parameters

After you select Perform a new calibration and Next >, the first of three Calibrate 
Hardware for Measurement dialog boxes is displayed as shown in Figure 1-6. Use 
this Calibrate Hardware for Measurement dialog box to change the parameters for your 
calibration and measurement to meet your measurement requirements. This dialog box 
displays the default measurement parameters which are based on the specifications of your 
PLTS hardware.

1. The basic measurement parameters are displayed in Figure 1-5. View all of the 
parameters by clicking the Advanced button.

The Advanced button shown in Figure 1-5 toggles between Advanced and Basic. When 
in Advanced, the entire dialog box is displayed as shown in Figure 1-6.

Figure 1-5 Measurement Parameter Dialog Box (Basic Parameters)

Since the default parameters are based on the specifications of your PLTS hardware, leave 
the parameters unchanged and click the Next > button for this exercise.
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Figure 1-6 Measurement Parameter Dialog Box 

Modifying these values also modifies other associated values interactively. For example, when 
you change the # of Points entry, the Time Base and the Frequency Start entries change 
appropriately. To modify a parameter, enter the value in associated value box and then click 
the Recalculate Parameters button to update the value each parameter. Refer to Table 1-1 
for a description of each parameter.

You can return to the default values at any time by selecting the Reset Values button.

Table 1-1 Measurement and Calibration Parameter Entry Descriptions

Parameter Description

 Calibrate Hardware for Measurement Dialog Box Basic Parameters

Time Base
Sets the maximum time base (in ns). Time base calculated as  

where Fmin is the start frequency in Hz.

Rise Time Sets the transition time (in ps) of the stimulus signal rising from 10 to 90% 
of the maximum signal amplitude.

# of Points Sets the number of measured points per sweep.

Frequency Start Sets the start frequency of the sweep.

1
2 Fmin×--------------------
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Uncouple Start Frequency and Step Frequency  The Uncouple Start Frequency and 
Step Frequency selection is available in the Calibrate Hardware for Measurement dialog box 
when the Advanced button has been selected. Normally, the Frequency Step setting is locked 
(or coupled) to the Frequency Start setting (see Table 1-1).

However, there are situations that you may want to uncouple the Frequency Step setting 

Frequency Step Sets the step size between points. This value is normally locked to (is the 
same as) the Frequency Start value.

Frequency Stop Sets the stop frequency of the sweep.

 Calibrate Hardware for Measurement Dialog Box Advanced Parameters

Uncouple Start 
Frequency and Step 
Frequency

Allows you to uncouple the start frequency from the step frequency. See 
“Uncouple Start Frequency and Step Frequency” below for additional 
information.

Spatial Resolution Describes how close in time two responses can be distinguished; depends on 
the width of the impulse response, which is inversely related to the 
maximum frequency of the measurement.

Velocity Factor Is the numerical value related to the speed of energy through a DUT based 
on the DUTs dielectric material. Some velocity factor (Vf) examples are: Air 
Vf = 1.000, Surface traces Vf = 0.53146, Buried Traces in εr ~ 4.3: 
Vf = 0.48795

Dielectric Constant (εr) is used to calculate the velocity factor 

IF Bandwidth Allows you to change the IF bandwidth. Narrow IF bandwidths allow you 
to view low-level signals, but require more data samples per point and thus 
slows the measurement time. 

Power Sets the signal level at the source appropriate for measurement of the 
device. You can measure the signal level available at the test port directly 
using a power meter.

Averaging Averages each point of consecutively swept traces until the total number of 
sweeps is equal to the averaging factor, resulting in a fully averaged trace 
with better noise reduction. A high averaging factor gives the best 
signal-to-noise ratio, but slows the measurement time. 

Analyzer Sweep 
Type

Stepped takes data while sweeping through defined frequency points. 

Swept takes data while sweeping linearly and continuously across the 
frequency range.

Table 1-1 Measurement and Calibration Parameter Entry Descriptions

Parameter Description

Vf 1 εr( )⁄=
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Navigating the Startup Wizard
from the Frequency Start setting. For example, uncouple the Frequency Step setting from 
the Frequency Start setting if you want to measure more points for better measurement 
resolution or you may want to measure specific frequency points that would not ordinarily be 
measured. 

When measured data from this uncoupled start frequency/step frequency measurement is 
converted to the Time Domain and Eye Diagram analysis types, conversion rules must be 
applied to ensure the data is displayed correctly.

Conversion Rule 1: If Frequency Start > Frequency Step, then set new Frequency 
Step = Frequency Start and:

Condition 1a.
If Frequency Start and Frequency Step are harmonically related and number of 
points is > 10, resample the points and mark the plot with the Resample icon.

Example 1a:

Condition 1b.
If Frequency Start and Frequency Step are harmonically related and the 
harmonically-related number of points is < 10, use the all of the measured data for 
time domain and mark the plot with the Bad Data icon.

Example 1b:

Condition 1c.
If Frequency Start and Frequency Step are not harmonically related, 
interpolate between measured points for harmonically related points to generate 
time domain data and mark the plot with the Interpolate icon.

Example 1c:

Measured Parameters Parameters for Time Domain

Start Step Stop Start Step Stop

6MHz 2MHz 9000MHz 6MHz 6MHz 9000MHz

100MHz 50MHz 9000MHz 100MHz 100MHz 9000MHz

Measured Parameters Parameters for Time Domain

Start Step Stop Start Step Stop

1000MHz 10MHz 9000MHz 1000MHz 10MHz 9000MHz

Measured Parameters Parameters for Time Domain

Start Step Stop Start Step Stop

6MHz 5MHz 9000MHz 6MHz 6MHz 9000MHz
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Conversion Rule 2: If Frequency Start < Frequency Step, then set Frequency Start = 
Frequency Step, interpolate for step (losing the low end) and mark the 
plot with the Interpolate icon.

Example 2:

Table 1-2 shows the icons that may be displayed on the Time Domain or Eye Diagram plots 
when the previous conversion rules are applied. These icons are displayed in the lower right 
corner of the plots to which they apply. For plots with multiple traces, only the icon of highest 
criticality is displayed. The table below shows the icons in increasing order of criticality.

Measured Parameters Parameters for Time Domain

Start Step Stop Start Step Stop

6MHz 12MHz 8994MHz 12MHz 12MHz 8988MHz

Table 1-2 Time Domain/Eye Diagram Uncoupled Start Frequency/Step Frequency Icons

Icon Icon Name

Resampled Data - This icon indicates that only the harmonically-related 
data points were used to generate time domain data.

Interpolated Data - This icon indicates interpolation is performed to 
calculate the harmonically-related points that were not measured. Any 
measurements that were performed at harmonically-related points are left 
unchanged. The interpolated data is used, along with the measured 
harmonically-related data, to perform the Inverse Fast Fourier Transform 
(IFFT) for the calculated time domain data.

Bad Data − This icon indicates there are less than 10 harmonically-related 
data points in the measured data. In this case, all of the non 
harmonically-related data is used to perform the Inverse Fast Fourier 
Transform (IFFT) to calculate time domain data. This may result in 
inaccurate time domain data. 
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How to Perform a Calibration

After you review and change the calibration and measurement parameters as needed and 
click Next >, the second of three Calibrate Hardware for Measurement dialog boxes is 
displayed as shown in Figure 1-7. This Calibrate Hardware for Measurement dialog box is 
used to select your calibration kit. However, the calibration procedure is described in 
Chapter 2, “Performing Error Correction on the VNA-Based PLTS.” 

To perform the calibration, continue with “Selecting a Calibration Type” on page 29. The 
calibration procedure includes:

• Selecting a calibration type and identifying your calibration kit
• Performing one of the following calibration types: SOLT (either mechanical or electronic), 

TRL, or LRM
• Characterizing any adapters that are used, if you do not already have the characterization 

data file

This procedure guides you through the calibration steps and then, when you have finished, it 
refers you back to “How to Make a Measurement” on page 15.

Figure 1-7 Select Calibration Type Dialog Box
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How to Make a Measurement

1. After saving the calibration data and selecting the Next > button, the Device connection 
scheme window for your calibration type is displayed. See Figure 1-8. This window shows 
you how the DUT must be connected to the PLTS for the type of calibration data that you 
are using. Connect the DUT to the PLTS hardware as shown and click the Next > button.

Figure 1-8 Device Connection Scheme Window
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NOTE SOLT calibration data requires a different connection scheme than either TRL 
or LRM calibration data. Figure 1-9 shows the difference in the DUT 
connection between SOLT calibrations and TRL/LRM calibrations. 

Figure 1-9 Device Connection Differences by Calibration Type

The Port 2 and Port 3 connections vary by calibration type.

2. The Hardware and Calibration Setup Wizard Complete window is displayed. See Figure 
1-10. 

This window is the software location to select the one of ten analysis formats that the 
measurement will be displayed as initially. The analysis formats are:

• Time Domain (Differential)

• Frequency Domain (Balanced)

• Eye Diagram (Differential)

• RLCG (Differential)

• RLCG (W-Element)

• Time Domain (Single-Ended)

• Frequency Domain (Single-Ended)

• Eye Diagram (Single-Ended)

• RLCG (Common)

• RLCG (Self/Mutual)
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For the purpose of this example, the Time Domain (Differential) format icon is selected.

Figure 1-10 Hardware and Calibration Setup Wizard Complete Window

The Modify Measurement Stimulus button opens the Measurement Stimulus dialog 
box. See Figure 1-11. This dialog box allows you to change some of the measurement 
stimulus settings that you set up previously.

Settings that would require a recalibration are not active and may not be changed in this 
dialog box. To change the stimulus settings that are inactive, you must click the < Back 
button until you get back to the window described in “Setting Up the Calibration and 
Measurement Parameters” on page 9.

For the purpose of this example, leave the settings unchanged and click the OK button.

The Reset Values button resets any active values (any values that can be changed 
without requiring a recalibration) to their original default values prior to being changed in 
“Setting Up the Calibration and Measurement Parameters”. 

The Cancel button resets any changes that were made after opening this dialog box.
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NOTE After the measurement has been made, you may verify these changes were 
made by printing a characterization report. See “Characterization Report 
Generator” on page 315 for help.

Figure 1-11 Stimulus Dialog Box

3. Once you exit the Measurement Stimulus dialog box, the Hardware and Calibration Setup 
Wizard Complete window is displayed again (see Figure 1-10), select the Next > button to 
start the measurement.
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4. The software displays the wizard’s Measurement & Post-Processing Status window and 
starts the measurement and the measurement post-processing. See Figure 1-12. The 
software makes each of the measurements. The status of the measurements and the 
post-processing is displayed in the status text area. The status is may also be observed by 
watching the status bar at the right edge of the text area. As the measurements and the 
post-processing proceed, the color of the bar gradually changes to blue.

Once the post-processing is complete, click the Next > button to display the Measurement 
and Calibration Setup Wizard Complete window.

Figure 1-12 Measurement & Post-Processing Status Window
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5. After selecting the Next > button, the Measurement and Calibration Setup Wizard 
Complete window is displayed. See Figure 1-12. Click the Finish button to display the 
measurement results in the main PLTS window.

Figure 1-13 Measurement & Calibration Setup Wizard Complete Window
Chapter 120



Setting Up and Making Measurements using the VNA-Based PLTS
Navigating the Startup Wizard
Analyzing the Measurement Results

Now that you have measured the device under test, its measurement results are displayed the 
main PLTS window as shown in Figure 1-14. This shows the results in the Time Domain 
(Differential) format, the analysis format selected earlier.

Figure 1-14 Displayed Measurement in Time Domain (Differential) Format

Now that the measurement has been made, the main Physical Layer Test System (PLTS) 
window gives you the flexibility to perform analysis on the measured data in a variety of 
ways.

• Frequency Domain. The Frequency Domain analysis may be analyzed in Balanced or 
Single-Ended mode.Refer to Chapter 4, “Analyzing Data in the Frequency Domain,” on 
page 127 for information.

• Time Domain. The Time Domain analysis may be analyzed in Differential or 
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Single-Ended mode. Refer to Chapter 5, “Analyzing Data in the Time Domain,” on 
page 147 for information.

• Eye Diagram. The Eye Diagram analysis may be analyzed in Differential or 
Single-Ended mode. Refer to Chapter 6, “Analyzing Data using Eye Diagrams,” on 
page 185 for information.

• Transmission Line (RLCG). The RLCG analysis may be analyzed in Differential, 
Common, W-Element, and Self/Mutual modes. Refer to Chapter 7, “Analyzing 
Transmission Line Parameters,” on page 205 for information.

However, to ensure the measurement data is not lost, you may want to first save the 
measurement data by selecting Save from the File menu. See “Save” under the “File Menu” 
section in the “Menu Reference” chapter of the PLTS Installation and Reference Guide.
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Performing Error Correction on the VNA-Based PLTS
What Is Measurement Calibration?
What Is Measurement Calibration?
Measurement calibration is an accuracy enhancement procedure that effectively removes the 
systematic errors (repeatable measurement variations) that cause uncertainty in measuring a 
device under test (DUT). During measurement calibration, the physical layer test system 
measures actual, well-defined standards and mathematically compares the results with ideal 
“models” of these standards. Calibration measurements, which characterize the test system, 
are made with all cables and connections in place but without the DUT.

Systematic Errors are related to signal leakage, signal reflections, and frequency response 
of the test system. There are six types of systematic errors.

• Directivity and crosstalk related to signal leakage

• Source and load impedance mismatches related to signals being reflected

• Frequency response error caused by reflection and transmission tracking with the test 
receivers

Other factors that can impact the measurement accuracy of any measurement system are 
drift errors and random errors.

• Drift Errors are due to the instrument or test-system performance changing after a 
calibration has been done. Drift is primarily caused by temperature variation and it can be 
removed by recalibration. The timeframe over which a calibration remains accurate is 
dependent on the rate of drift that the test system undergoes in the test environment. A 
stable ambient temperature usually minimizes the rate of drift significantly. Allowing 
equipment to warm up and stabilize prior to calibration and properly ventilating 
equipment helps reduce drift errors.

• Random Errors are unpredictable since they vary with time in a random fashion. 
Therefore, they cannot be removed by calibration. The main contributors to random error 
are instrument noise such as, source phase noise, sampler noise, and IF noise. The 
accurate source and phase-locked receiver of the network analyzer greatly minimizes these 
random errors. There are also external contributors to random errors such as switching 
power supplies, EMI, etc.
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Why Is Calibration Needed?
Components of the measurement setup such as imperfect connectors, cabling, and even the 
response of the test instruments can introduce errors into measurements. For both 
transmission and reflection measurements, impedance mismatches within the test setup 
cause measurement uncertainties that appear as ripples superimposed on the measured data. 
These errors can distort the signal and make it difficult to determine which reflections are 
from the DUT and which are from other sources. 

Calibration is required for accurate measurements. Even though calibration does take a few 
minutes to complete, it saves time and money compared to costs associated with erroneous 
measurement data. Even mechanical (non-electronic) calibration is reasonably quick once you 
become familiar with the process.

TIP Understanding How Changes Affect Measurements

No two measurements and environmental conditions are exactly the same. The 
best way to understand your conditions is to experiment and see how your test 
equipment behaves over a period of time. A good way of doing this is to measure 
the same device (i.e., a known standard) hourly throughout the day. Save or 
print the measurement results of each measurement. Compare these results to 
gain an understanding of how the ambient environment and drift affect the 
measurements. Watch for trends with regard to the device meeting 
specifications or measuring within guard band limits. 
Chapter 2 25



Performing Error Correction on the VNA-Based PLTS
When Is Calibration Needed?
When Is Calibration Needed?
We recommend that you perform a calibration on your physical layer test system when the 
following conditions occur:

• When connectors are cleaned, repaired, or replaced.

• If test cables have any changes, such as:
— When a test cable is replaced

— When any connection is changed except the connections to the DUT

— When test cables are flexed excessively (kinked or unkinked)

• If the frequency range is changed beyond the limits of the previous calibration

• If the number of measurement points is increased to more than the number of points of the 
previous calibration

• When ambient temperature changes more than ±3 °C

• Any other ambient environmental changes of significance

• If none of the previous conditions apply, calibrate according to the intervals shown below 
due to drift:

— Check the calibration daily at a minimum (twice daily is recommended). Refer to “How 
to Verify a Calibration” on page 27.

— Calibrate weekly (daily calibration recommended).
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How to Verify a Calibration
A good method of checking calibration is to establish a Golden Device, which is a device that 
meets all specifications and is saved for comparison of the measured results in the future. 

Establishing a Golden Device

Follow these steps to establish a golden device:

1. Calibrate the system. 

2. Perform the complete set of measurements on the golden device. 

3. Save and print all of the test results from these initial measurements.

Now you can measure the golden device when you suspect that your system may need to be 
calibrated. Compare the results of these measurements against the results that you saved 
and printed from the initial measurements.
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How to Perform a Calibration
You will first select a calibration kit and then you will perform a calibration (either 
mechanical or electronic, depending on your calibration kit). After you finish the calibration, 
you will be ready to make a measurement.

Use the following procedure to calibrate the Physical Layer Test System. 

1. If you are referring to this chapter from the example measurement in Chapter 1, skip to 
“Selecting a Calibration Type” on page 29.

2. Open the Physical Layer Test System Startup Wizard by doing any of the following:

• Start the Physical Layer Test System software. 
(The startup wizard will open at start up unless the “Do not show this wizard again 
at start up” option has been selected.)

• Select New from the File menu.

• Select Calibration from the Utilities menu. Then select Calibrate.

3. Press the Next > button until you reach the startup wizard’s Calibrate Hardware for 
Measurement dialog box displaying the default parameters, such as the maximum time 
base, minimum rise time, and number of point settings. See Figure 1-6 on page 10.

Use this dialog box to check these calibration parameter settings. These default settings 
are based on the equipment limitations of your Physical Layer Test System.

Selecting the Advanced… button to display all of the calibration parameters in the 
Modify Time and Frequency Parameter dialog box.

You can change any of the time domain or frequency domain parameters, and then by 
selecting the Recalibrate Parameters button, the remaining parameters are 
recalibrated and displayed. Once all of the parameters are set to your satisfaction, select 
OK to return to the Calibrate Hardware for Measurement dialog box.

If you decide you want to reset all changed values to their default settings, select the 
Reset Values button.

4. Once the parameters are set, select the Next > button to display the calibration type 
selection dialog box shown in Figure 2-2.
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Selecting a Calibration Type

The dialog box shown in Figure 2-2 is the window that is used to select the calibration type 
and the calibration kit. It opens in the default SOLT (Short-Open-Load-Thru) calibration 
type, showing the 4-Channel SOLT calibration type along with the SOLT calibration kits that 
have been determined by the auto-detection to be appropriate for the system hardware. Some 
calibration kits listed here may not be displayed.

Figure 2-1 Select Calibration Type Dialog Box

The Select Calibration Type list allows you to choose the calibration type. 4-Channel 
SOLT is the default calibration type. Opening the list displays that the 4-Channel TRL 
(Thru- Reflect-Line) and the 4-Channel LRM (Line-Reflect-Match) calibration types are also 
available. 

NOTE TRL and LRM calibration types are not supported for physical layer test 
systems that use the 8753ES or the 872XES network analyzers.

The usage of the PLTS ports 2 and 3 varies by the calibration type that is chosen. Refer to 
Table 2-1, PLTS Port Configurations for a Balanced Line by Calibration Type, for the 
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configuration of each port measuring a balanced line.

NOTE If you select either 4-Channel TRL or 4-Channel LRM, no calibration kit 
choices are initially available. You will first need to define a calibration kit that 
covers your measurement parameter start and stop frequency range. The 
calibration kit definition procedures are described later in this chapter. 
Continue as directed in the following list.

Select the calibration type from the list and refer to the appropriate section listed below.

• If you selected 4-Channel SOLT calibration, refer to “Performing an SOLT Calibration” 
on page 31.

• If you selected 4-Channel TRL calibration, refer to “Performing a TRL Calibration” on 
page 51.

• If you selected 4-Channel LRM calibration, refer to “Performing an LRM Calibration” on 
page 65.

Table 2-1 PLTS Port Configurations for a Balanced Line by Calibration Type

PLTS
Ports

Calibration Type

SOLT TRL LRM

Port 1 In + In + In +

Port 2 Out + In − In −

Port 3 In − Out + Out +

Port 4 Out − Out − Out −
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Performing an SOLT Calibration

You have selected the 4-Channel SOLT calibration type. You will first select a calibration kit 
and then you will perform a calibration (either mechanical or electronic, depending on your 
calibration kit). After you finish the calibration, you will be ready to make a measurement.

Selecting a SOLT Calibration Kit

The dialog box shown in Figure 2-2 lists the calibration kits that have been pre-defined for use 
with the VNA-based PLTS hardware. 

Additional calibration kits, including user-defined kits, may be added by selecting 
Calibration then Edit Cal Kit from the Utilities menu. See “Defining a SOLT Calibration 
Kit” on page 34 for details.

Figure 2-2 Select Calibration Kit Dialog Box
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NOTE The frequency range of the pre-defined calibration kits are limited to the 
frequency of the characterized thru adapter. The thru adapters have been 
characterized at frequencies used most by customers. Refer to Table 2-2 for the 
defined PLTS frequency boundaries of the default calibration kits.

If you set the frequency requirements beyond the defined PLTS frequency 
boundaries of your calibration kit, the calibration kit is not displayed. You will 
need to either:

• Select as pre-characterized thru file that meets or exceeds the frequency 
requirements to create a new Thru Standards definition of the calibration 
kit. (Refer to “Defining a SOLT Calibration Kit” on page 34.)

• Characterize your own thru adapters to meet or exceed your frequency 
requirements (refer to “Characterizing Adapters” on page 79) and select 
that newly-created thru (adapter) file to create a new Thru Standards 
definition (refer to “Defining a SOLT Calibration Kit” on page 34).

1. Select your calibration kit. Refer to Table 2-2 for the appropriate calibration kit. 

Table 2-2 Calibration Kit Frequency Parameters

Calibration Kit 
Model Number

Nominal Frequency Range of 
the Calibration Kita

a. Refer to the specific calibration kit documentation for actual specifications and 
characteristics of each product.

Defined PLTS Frequency 
Boundaries of the Calibration 

Kit 

Minimum 
Frequency

Maximum 
Frequency

Start 
Frequency

Stop 
Frequency

Mechanical Calibration Kits include:

85033E 0 MHz 9 GHz 6 MHz 9 GHz

85052D 0 MHz 26.5 GHz 10 MHz 20 GHz

85056A 0 MHz 50 GHz 10 MHz 50 GHz

Electronic Calibration Kits include:

N4430Ab

b. Also applies to the ATN-4801 Multiport Calibration Module.

30 kHz 6 GHz 30 kHz 6 GHz

N4430B 30 kHz 9 GHz 30 kHz 9 GHz
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The Nominal Frequency Range columns display the minimum and maximum frequencies 
that the calibration kit will operate. These frequencies are limited by the physical 
calibration kit. They can not be changed. 

The Defined PLTS Frequency Boundaries columns are the frequencies that the calibration 
kit are defined in the PLTS software when you first receive it. These frequencies are 
limited by the PLTS software. They may be changed as explained in the note above.

2. Select the More >> button to display the thru calibration configuration, the nominal 
minimum and maximum frequencies of the kit, and the connector type of the four ports. 
See Figure 2-3.

Figure 2-3 Select Calibration Kit Dialog Box with More Button Selected

3. If the thru calibration configuration is not the configuration that you wish to use, click the 
Change thru configuration and adapter information box and then click the Next > 
button. The Thru Definition Wizard is displayed.
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Figure 2-4 Thru Definition Wizard

Refer to step 10 on page 37 (part of “Defining a SOLT Calibration Kit”) for information 
that will help you complete the Thru Definition Wizard.

After changing the Thru definition, click the Next > button to save the change and return 
to the Calibration Kit selection window of Figure 2-3. Clicking the Cancel > button will 
exit the start up wizard without making any changes to the calibration kit definition.

4. Once the calibration kit is selected, click the Next > button to display the calibration 
window.

• If you selected a mechanical calibration kit, refer to “Performing a Mechanical SOLT 
Calibration” on page 40 for additional information.

• If you selected an electronic calibration kit, refer to “Performing an Electronic 
Calibration” on page 47 for additional information.

Defining a SOLT Calibration Kit

A SOLT calibration kit may be defined if the calibration kits shown in Figure 2-2 do not match 
your measurement needs. You will need to exit the startup wizard to define your calibration 
kit. Use the following procedure. You may also refer to “Edit Cal Kit” under the “Utilities 
Menu”section in the “Menu Reference” chapter of the PLTS Installation and Reference Guide 
for additional details.

1. Exit the startup wizard by clicking the close button in the upper right corner of the wizard: 
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2. From the Utilities menu, select Calibration, Edit CalKit as shown in Figure 2-5.

Figure 2-5 Selecting Edit CalKit

3. In the Select Cal Kit dialog box, select 4-Channel SOLT from the Select Calibration 
Type list, then select the USER_DEF selection and click Edit to start the process. See 
Figure 2-6.

Figure 2-6 Select Cal Kit Dialog Box
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4. The calibration kit definition is performed in the Edit SOLT Calibration Kit dialog box 
shown in Figure 2-7.

Figure 2-7 Blank Edit SOLT Calibration Kit Dialog Box

5. Enter Cal Kit ID and Name into the appropriate entry boxes in the header.

Referring to Figure 2-6, Cal Kit ID is listed in the Cal Kit column and Name is listed in 
the Description column of the calibration kit selection window shown in Figure 2-2.

6. Also enter Connector Type along with the minimum (Min. Freq. MHz) and the 
maximum (Max. Freq. MHz) frequencies in megahertz. 

The software compares the minimum and maximum frequency entries against the 
measurement setup frequencies when determining which calibration kits to make 
available for selection for the calibration as in Figure 2-2.
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7. Complete the Open Coefficients area by entering the coefficient and delay values 
displayed. If you are using a standard from a calibration kit, the coefficient and delay 
values may be found in the calibration kit documentation. The four coefficient values for 
the open are the capacitance in farads (F). Enter the capacitance value followed by the 
exponent. For example, if C0 is equal to 49.433×10−15, the value would be entered as: 
49.433E-15

Enter the Delay in picoseconds. This value may also be found in the calibration kit 
documentation if you are using a standard from a calibration kit.

8. Complete the Short Coefficients area by entering the coefficient and delay values 
displayed. If you are using a standard from a calibration kit, the coefficient and delay 
values may be found in the calibration kit documentation. The four coefficient values for 
the short are the inductance in henries (H). Enter the inductance value followed by the 
exponent. For example, if H0 is equal to −2.0765×10−12, the value would be entered as: 
-2.0765E-12

Enter the Delay in picoseconds. This value may also be found in the calibration kit 
documentation if you are using a standard from a calibration kit.

9. Complete the Load Coefficients area by entering the characteristic impedance (Z0) in 
ohms and Delay in picoseconds. If you are using a standard from a calibration kit, the 
coefficient and delay values may be found in the calibration kit documentation.

10.Complete the Thru Standards area. Figure 2-9 shows the data that is used in this 
example.

First, from the Choose a thru configuration for this Cal Kit: selection, select either 4 
Cross, 4 Box, or 6 Cross. Figure 2-8 shows the paths that will be calibrated using a thru 
for each selection.

Figure 2-8 Thru Configuration Selections
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Next, select either Choose Adapter File in the Characterization Data area or Delay 
(ps) in the Thru Delay area. 

• Choose Adapter File allows you to use a characterized file to eliminate the effects of 
the thru adapter when calibrating. 

If you select Choose Adapter File, select the characterization file for the thru adapter 
from the list of files.

If you don’t have a characterization file for the thru that you will use to calibrate, you 
can create one by selecting the Characterize Adapter selection in the 
Characterization Data area and then select the Create Custom… button. This will 
open the Custom Adapter Characterization Wizard. Refer to “Characterizing 
Adapters” on page 79 for information on the Custom Adapter Characterization 
Wizard.

• Delay (ps) allows you to insert just the delay (in picoseconds) of the thru adapter, 
based on the electronic length of the device. If you select Delay (ps), enter the time 
delay of the thru in the text area. If your thru is part of an Agilent (or Hewlett-Packard) 
calibration kit, this delay value is listed in the Standard Definitions section of the 
calibration kit documentation.

Finally, in the list of Thrus at the bottom of this dialog box, select the box at the left of the 
thru and click the Add button to associate the thru to either the selected adapter file or to 
the entered delay value. The color of the box at the left of the thru changes from red to 
green as the thru path is completed.

Enter a selected adapter file or a delay value for each thru path. All or the thru paths may 
use the same characterization file or delay value or each may have a different 
characterization file or delay value depending on your calibration requirements.

After the Edit SOLT Calibration Kit dialog box is complete, click the OK button to save the 
calibration kit with the new information and return to the Select Cal Kit dialog box. 
Cancel deletes the information entered and returns to the Select Cal Kit dialog box.
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Figure 2-9 Completed Edit SOLT Calibration Kit Dialog Box

11.Once the SOLT calibration kit data has been entered into the dialog box, select OK to save 
the calibration kit data and exit the Edit SOLT Calibration Kit dialog box. 

The Cancel button closes the Edit SOLT Calibration Kit dialog box without saving the 
calibration kit data.

12.Once the SOLT calibration kit data has been saved, select Close to close the Select Cal Kit 
dialog box. See Figure 2-10.

Figure 2-10 Close the Select Cal Kit Dialog Box
Chapter 2 39



Performing Error Correction on the VNA-Based PLTS
How to Perform a Calibration
Return to the startup wizard to complete the SOLT calibration procedure. You can select 
New from the File menu to restart the wizard. If you need help completing the startup 
wizard, return to Chapter 1 on page 3. If you do not need assistance, return to “Selecting a 
SOLT Calibration Kit” on page 31.

Performing a Mechanical SOLT Calibration 

NOTE For maximum accuracy and repeatability, the system (network analyzer and 
test set) should be stabilized at room temperature for a minimum of 24 hours 
before calibration.

The 4-port (channel) Short/Open/Load/Thru (SOLT) calibration type is one of the most 
comprehensive calibrations. This calibration effectively removes the directivity error, 
crosstalk, source match error, load match error, frequency response reflection tracking error, 
and frequency response transmission tracking error from the test setup in a transmission or 
reflection test using these ports. 

It has two unique components: the Thru component and the Short/Open/Load (SOL) 
component. 

• The Thru component consists of connecting a through (Thru) adapter between the ends of 
the test cables connected to the system ports. The Thru adapter is also part of the 
calibration kit.

• The SOL component consists of connecting a short standard, an open standard, and a 
50-ohm load standard to the end of the test cable connected to each system port. Each of 
these standards is part of the calibration kit.

Figure 2-11 is the mechanical calibration interface that steps you through the SOLT 
calibration. It displays calibration configuration information—such as the calibration kit 
selection, the test port connector types, the selected thru adapter, and the thru 
configuration—as well as a graphical representation of the test ports. This graphical 
representation includes a set of icons for each port, corresponding to a short, open, and load 
(see “The Short/Open/Load (SOL) Component” on page 44). In the center of the screen, the 
selected thru configuration is displayed (see “The Thru Component” on page 41).
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Figure 2-11 The SOLT Calibration Interface

Note that all of the icons and the thru configuration paths are displayed in red at the start of 
the calibration. As each calibration standard is connected and measured, the color of its 
corresponding icon will change to blue. Once the measurement is complete, the color of the 
corresponding icon will change from blue to green. This change of color from red to blue to 
green also occurs for the thru configuration.

The Thru Component  In addition to the SOL component of the calibration, a series of 
through (thru) measurements are required. For a 4-port calibration, it can be assumed that 
six thru-path calibrations are required (1-2, 1-3, 1-4, 2-3, 2-4, 3-4). However, some test setups, 
particularly probing setups, may make thru connections for all six paths physically 
impossible.

PLTS provides an alternative, and only requires four thru-paths measurements to perform an 
accurate four-port calibration. These alternatives can be selected in calibration kit definition 
process. See “Defining a SOLT Calibration Kit” on page 34.
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Figure 2-12 “Thru Config” Options

The selection in the Thru Config area of the Calibrate Hardware for Measurement window 
(shown in Figure 2-11 on page 41) dictates the calibration pattern of the thru calibration. 
Figure 2-12 shows the Thru calibration pattern for each Thru Config selection. 

There are minor trade-offs to consider when deciding between a four or six thru-path 
calibration. With a four thru-path calibration, the un-measured thru-paths are accounted for 
as the PLTS software calculates the missing transmission tracking error terms (ETF and 
ETR). Although this calculation has been proven to be extremely accurate, the simulated 
paths have a fractional amount of ripple across the band that would not be present if the full 
six thru-path calibration were performed. This ripple is insignificant in all but extremely 
low-loss DUT specifications (< 0.1 dB for example). 

TIP Comparing Thru Path Calibrations

For the sake of convenience, the four thru-path calibrations are recommended 
in most situations. If you are concerned about the difference, you may choose to 
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perform two calibrations, one four thru-path and one six thru-path, and 
compare the results with your particular DUT specifications in mind.

Note that when a Thru Config calibration path is complete, the path color has changed from 
red (before the measurement) to blue (during the measurement) to green (after the 
measurement is complete).

To Perform the Thru Calibration Component  Use the following steps to perform the 
Thru calibration:

1. Connect the test cables and any adapters that you will use for your measurements to the 
Physical Layer Test System test ports. 

The calibration is made with all cables and connectors in place but without the DUT.

2. With the Calibrate Hardware for Measurement window displayed, select one of the Thru 
path icons on the window.

Figure 2-13 Thru Path Icons

3. Once a Thru path icon is selected, a prompt is displayed telling you which connections 
must be made for the Thru calibration. An example is shown in Figure 2-14.

Figure 2-14 Example Prompt for Thru
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4. Continue to select the Thru icon following the instructions as each prompt is displayed. 
The Thru component of the calibration is complete once the color of all of the Thru paths 
have changed to green.

5. Continue with “The Short/Open/Load (SOL) Component” to complete the calibration.

The Short/Open/Load (SOL) Component  Performing the SOL portion of the calibration 
consists of connecting each of the standards to each of the ports for a reference measurement. 
Any sequence may be used, and multiple connections may be made simultaneously for 
convenience (for example: connect the short to port 1, load to port 2, and open to port 3, then 
continue). The icons change color from red (before the measurement) to blue (during the 
measurement) to green (after the measurement is complete).

Each of the four ports on the window has an associated set of icons as shown: 

Each of the three icons in the set represents a different part of the SOL calibration 
component.

 represents the short standard from the calibration kit

 represents the open standard from the calibration kit

 represents the 50-ohm load standard from the calibration kit

As each standard is connected to each port and characterized during the calibration, the color 
of the associated icon changes from red to blue to green.

To Perform the Short/Open/Load (SOL) Calibration Component  Use the following 
steps to perform the SOL calibration:

1. With the Calibrate Hardware for Measurement window (see Figure 2-11 on page 41) 
displayed, ensure that the Show Prompts check box is checked.

TIP To perform the SOL calibration without using prompts:

Prompts are used to guide you through the steps for this calibration. It is not 
required that this calibration be performed using prompts, such as the one 
shown in Figure 2-15. These prompts may be disabled by clearing the Show 
Prompts checkbox. Until you become familiar with the calibration procedure, 
it is recommended that you use the prompts.
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1. Ensure that the Show Prompts check box is cleared.

2. Select a short, open, or load standard from the calibration kit and connect it 
to one of the test ports. Note: You may save time by connecting more than one 
standard (for example: connect the short to port 1, load to port 2, and open to 
port 3, then continue).

3. Click the corresponding icon to perform the appropriate measurement.

4. The system will perform a reference measurement, and the color of the icon 
will change to green, indicating completion.

5. Repeat for the remaining standards and ports until all of the icons have 
changed to green.

After you have finished the SOL calibration, select the Next > button to the 
save the calibration data. See “To Save the Calibration” on page 46.

2. Click on any one of the icons, at any one of the test ports.

3. A dialog box is displayed confirming the required standard and port. An example is shown 
in Figure 2-15.

Figure 2-15 Example Prompt for Shorts, Opens, and Loads

4. Make the requested connection and click OK.

5. The system will perform a reference measurement, and the color of the icon will change to 
green, indicating completion.

6. Repeat for the remaining standards and ports until all of the icons have changed to green.

7. After you have finished the SOL calibration, select the Next > button to the save the 
calibration data. See “To Save the Calibration” on page 46.
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To Save the Calibration  Once you have completed both components of the SOLT 
calibration, the Save Calibration Data dialog box is displayed as shown in Figure 2-16.

Figure 2-16 Save Calibration Data Dialog Box

1. Enter a file name for the calibration data set.

The calibration data file will be saved in the directory displayed in the Calibration Data 
File Path box. You may change the directory by entering the directory path in the box or 
selecting the Browse… button and navigating through your computer’s directory 
structure to the desired directory. The calibration data is automatically saved with a “.cal” 
file extension.

2. Save the calibration data by selecting the Next > button.

When the calibration data is saved, the calibration is complete.

3. If you started the calibration:

• As part of the example measurement of Chapter 1, return to “How to Make a 
Measurement” on page 15.

• By entering the startup wizard at startup or by selecting New from the File menu, the 
software sends you to the Startup Wizard’s Setup & Calibration Complete! window 
where you can make a measurement.

• By selecting Calibration from the Utilities menu and then selecting Calibrate, the 
software returns to the main software window.
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Performing an Electronic Calibration

You can perform a 4-port electronic calibration (ECal) using the Agilent N4430A 6 GHz 4-Port 
ECal Module1 or the N4430B 9 GHz 4-Port ECal Module.

With a one-time connection, the ECal procedure cycles through all of the impedance states 
and six thru paths required for a full, four-port, vector error-corrected SOLT calibration, and 
can transfer factory-calibration accuracy to the Physical Layer Test System. The software 
controls the electronic calibration. Refer to Figure 2-17 for a typical equipment setup.

Figure 2-17 Typical Equipment Setup for ECal

NOTE For maximum accuracy and repeatability, the system (network analyzer, test 
set, and ECal module) should be stabilized at room temperature for a minimum 
of 24 hours before calibration.

Using standard alignment precautions, the test set may have the ECal module connected and 
disconnected in any power state. After calibration, the ECal module may remain connected or 
may be disconnected from the test set Auxiliary connector with no effect on the calibration.

To perform the ECal with the physical layer test system:

1. Once you select an electronic calibration kit and then click the Next > button as instructed 
on the last step of the “Selecting a SOLT Calibration Kit” procedure on page 34, the 
Electronic Calibration is displayed. See Figure 2-18.

1. The ATN-4801 Multiport Calibration Module may also be used.
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Figure 2-18 Electronic Calibration Dialog Box

2. Connect the test cables and adapters that you will use for your measurements to the 
Physical Layer Test System test ports.

3. Connect the other end of the test cables and adapters to the ECal module so that the 
connections identified in Table 2-3 are made. If adapters are required to make the 
connections from the test cable/adapter setup to the ECal module, use the adapters in the 
ECal module kit.

Table 2-3 ECal Module Connections

ECal Module Connector PLTS Connector Cable Type Specified Torque

CONTROL AUXILIARY DB-15 N/A

PORT 1 PORT 1 Coax 8 in/lb

PORT 2 PORT 2 Coax 8 in/lb

PORT 3 PORT 3 Coax 8 in/lb

PORT 4 PORT 4 Coax 8 in/lb
Chapter 248



Performing Error Correction on the VNA-Based PLTS
How to Perform a Calibration
CAUTION Make sure that test port 2 of the system is connected to Port 2 of the ECal 
module and that test port 3 of the system is connected to Port 3 of the ECal 
module. Connecting to the wrong port will lead to incorrect calibration results. 
Refer to Figure 2-19 for test cable connections to the ECal module.

Figure 2-19 Connecting Test Cables to the ECal Module

4. Select the electronic calibration characterization file for your ECal module from the list in 
the Characterization File area. Refer to Figure 2-18. Verify that the file name matched 
the serial number of your ECal module.

If your characterization file was not located by the software, load the characterization file 
from the floppy disk provided with the ECal module. Load the file from the floppy disk by 
inserting the floppy disk in the PC, selecting the Browse… button, and locating the 
characterization file from the floppy disk directory using the Open dialog box. Each module 
characterization file is unique, so verify that the file name matches the ECal module serial 
number. The characterization file has an “.ecl” extension. The ECal module should be 
loaded into the C:\Program Files\Agilent\PLTS\ecal, where C is the hard drive where 
the PLTS is stored.
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NOTE Select the ECal Info… button to display the following ECal module 
information dialog box for the selected module. 

5. If your system’s test cable setup won’t connect directly to the ECal module, you may use an 
adapter that has already been characterized. To use the adapter, select the adapter’s 
characterization file from the Select Adapter Files list. Refer to “Characterizing 
Adapters” on page 79 for detailed information.

NOTE If you use one or more of the 3.5 mm male to male adapters in the ECal kit, you 
may select one of the 3.5m-m.txs files from the Select Adapter Files list.

• If you are connecting the adapter in the forward orientation (with the adapter’s 
characterized port 2 connected to the ECal module), just select the checkbox labeled A 
(representing Adapter) for the port to which it is being connected.

• If you are connecting the adapter in the reverse orientation (with the adapter’s 
characterized port 1 connected to the ECal module), select the checkbox labeled A 
(representing Adapter) and the checkbox labeled R (representing Reverse) for the port 
to which it is being connected. 

NOTE The Adapter (A) checkbox must be selected before the program accounts for the 
Reverse (R) checkbox being selected.

6. Once the system is connected to the ECal module, select Next > to start the electronic 
calibration. A small window showing the calibration progress is displayed.

Once the calibration is complete, it should be saved. See “To Save the Calibration” on 
page 46.
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Performing a TRL Calibration

You have selected the 4-Channel TRL (THRU - REFLECT - LINE) calibration type. TRL 
calibration is extremely accurate, in some cases more accurate than an SOLT cal. However, 
very few calibration kits contain TRL standards. TRL calibration is most often performed 
when you require a high level of accuracy and do not have calibration standards in the same 
connector type as your DUT. This is usually the case when using test fixtures, or making 
on-wafer measurements with probes. 

The DUT must be physically connected to the PLTS by some kind of transition network or 
fixture. Therefore, in some cases you must fabricate and characterize standards in the same 
media type as your DUT configuration. It is easier to manufacture and characterize three 
TRL standards than the four SOLT standards. A limitation for TRL cal with broad frequency 
coverage is the requirement for multiple LINE standards. For example, a span from 2 GHz to 
26 GHz requires two line standards. Also, for lower frequencies, the LINE standard can be too 
long for practical use.

TRL Calibration Kits

Agilent Technologies offers two cal kits that include the required standards to perform a TRL 
calibration: 85050C (APC 7mm) and 85052C (3.5mm). Both kits include the traditional Short, 
Open, and Load standards. (The Thru standard, not actually supplied, assumes a zero-length 
Thru). In addition, the kits include an airline which is used as the LINE standard. To use the 
airline, the kits include an airline body, center conductor, and insertion/extraction tools.

TRL Calibration Standards

These standards must be defined in your TRL cal kit:

THRU

• The THRU standard can be either a zero-length or non-zero length. However, a 
zero-length THRU is more accurate because it has zero loss and no characteristic 
impedance.

• The THRU standard cannot be the same electrical length as the LINE standard. 

• If the insertion phase and electrical length are well-defined, the THRU standard is 
used to set the reference plane.

REFLECT

• The REFLECT standard can be anything with a high reflection, as long as it is the 
same when connected to all ports. 

• The actual magnitude of the reflection need not be known. 
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• The phase of the reflection standard must be known within 1/4 wavelength. 

LINE

The LINE standard establishes the reference impedance for the measurement after the 
calibration is completed. TRL calibration is limited by the following restrictions of the 
LINE standard:

• Limited to 4 Lines.

• Must be of the same impedance as the THRU standard.

• The electrical length need only be specified within 1/4 wavelength.

• Cannot be the same length as the THRU standard.

• Must be an appropriate electrical length for the frequency range: at each frequency, the 
phase difference between the THRU and the LINE should be greater than 20 degrees 
and less than 160 degrees. This means in practice that a single LINE standard is only 
usable over an 8:1 frequency range (Frequency Span / Start Frequency). Therefore, for 
broad frequency coverage, multiple lines are required.

• At low frequencies, the LINE standard can be too long for practical use. Two 50-ohm 
terminations can be used in place of a long LINE standard at low frequencies.

NOTE TRL calibration is not supported for physical layer test systems that use the 
8753ES or the 8720ES-series network analyzers.

Start with “Selecting a TRL Calibration Kit”.
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Selecting a TRL Calibration Kit

The dialog box shown in Figure 2-20 lists the defined TRL calibration kits that have been 
determined by an auto-detection process to be appropriate for the system hardware and the 
frequency range that was defined in the measurement parameters.

Figure 2-20 Select TRL Calibration Kit Dialog Box

NOTE No TRL calibration kits are defined in the software when you receive it. 

• If you have not defined your TRL calibration kit, select the Cancel button 
and define your TRL calibration kit using the procedure described in 
“Defining a TRL Calibration Kit” on page 54.

• If you have defined a TRL calibration kit but it is not displayed in the dialog 
box:

1. Make sure that you have selected 4-Channel TRL from the Select 
Calibration Type list. See “Selecting a Calibration Type” on page 29.

2. Make sure that the start and stop frequencies that were defined for the 
TRL calibration kit (“Defining a TRL Calibration Kit” on page 54) match 
or exceed the start and stop frequencies (≤ the start frequency and ≥ the 
stop frequency) that were defined in the measurement parameters 
(“Setting Up the Calibration and Measurement Parameters” on page 9).
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1. Select your calibration kit in the Cal Kit column.

2. Select the More >> button to display the thru calibration configuration, the minimum and 
maximum frequencies of the kit, and the connector type of the four ports. See Figure 2-21.

Figure 2-21 Select Calibration Kit Dialog Box with More Button Selected

3. Once the calibration kit is selected, click the Next > button to display the calibration 
window and continue with “Performing a TRL Calibration” on page 57.

Defining a TRL Calibration Kit

The dialog box shown in Figure 2-23 shows only the USER_DEF selection. This indicates 
that a TRL calibration kit must be defined before a TRL calibration may be performed.

1. From the Utilities menu, select your PLTS system name and then select Edit Cal Kits… 
as shown in Figure 2-22.

Figure 2-22 Selecting Edit Cal Kits…
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2. In the Select Cal Kit dialog box, select 4-Channel TRL from the Select Calibration 
Type list, then select the USER_DEF selection and click Edit to start the definition 
process. See Figure 2-23.

Figure 2-23 Select Cal Kit Dialog Box

3. The TRL calibration kit is defined using the Edit TRL Calibration Kit dialog box. See 
Figure 2-24.

Figure 2-24 Blank Edit TRL Calibration Kit Dialog Box
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4. Enter Cal Kit ID, Name, and Connector Type into the appropriate entry boxes in the 
header.

Referring to Figure 2-25, Cal Kit ID is listed in the Cal Kit column and Name is listed in 
the Description column of the calibration kit selection window.

In this example, Cal Kit ID is defined as “85050C”, Name is defined as “Agilent Cal 
Kit Model # 85050C”, and Connector Type is defined as “7mm”. Refer to Figure 2-21.

5. Enter the delay value of the device you are using as the Reflect in the Short Coefficients 
area. Figure 2-25 shows the data that is used in this example.

6. Complete the Edit TRL Calibration Kit dialog box. For the Thru and Line Standards 
area, enter a name for each Line along with each line’s start and stop frequency (in MHz) 
and delay (in ps). Information for up to four lines can be entered into this area. If you are 
using a standard from a calibration kit, the coefficient and delay values may be found in 
the calibration kit documentation. If the delay of a line is entered as 0 ps, the line is 
assumed to be a load (50Ω termination). Also enter the name and delay of the Thru device, 
which is typically 0 ps. Figure 2-25 shows the data that is used in this example.

Figure 2-25 Completed Edit TRL Calibration Kit Dialog Box
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7. Once the TRL calibration kit data has been entered into the dialog box, select the OK 
button to save the calibration kit data and exit the Edit TRL Calibration Kit dialog box. 

The Cancel button closes the Edit TRL Calibration Kit dialog box without saving the 
calibration kit data.

8. Once the TRL calibration kit data has been saved, select Close to close the Select Cal Kit 
dialog box. See Figure 2-26.

Figure 2-26 Close the Select Cal Kit Dialog Box

9. Return to the startup wizard to complete the TRL calibration procedure. You can select 
New from the File menu to restart the wizard. 

• If you need help completing the startup wizard, return to Chapter 1 on page 3. 

• If you do not need assistance, continue with “Selecting a TRL Calibration Kit” on 
page 53.

Performing a TRL Calibration 

NOTE For maximum accuracy and repeatability, the system (network analyzer and 
test set) should be stabilized at room temperature for a minimum of 24 hours 
before calibration.

As indicated by its name, the Thru-Reflection-Line (TRL) calibration consists of three 
portions. First, the reflection portion is performed by connecting a short to each system port. 
The Line portion is performed by connecting each line and a thru between system ports 1 and 
3 and then by connecting the same lines and thru between ports 2 and 4. Finally, the Thru 
portion is performed by connecting the thru between system ports 1 and 4 and then by 
repeating the connection between ports 2 and 3. 
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Figure 2-27 Initial TRL Calibration Display

The TRL calibration is performed in two parts which may be performed in any order. These 
instructions show you how to perform the Reflect portion of the calibration first. The 
Thru-Line portion of the calibration is documented next.

Reflect Portion of TRL Calibration  The following three steps are the Reflect portion of 
the TRL calibration.

1. Select the following icon to start the Reflection portion of the calibration: 

2. As described in the prompt shown in Figure 2-28, connect the reflective device (in this 
case, defined as a short) from your calibration kit to Port 1 and click OK.

Figure 2-28 Displaying the Port 1 Reflection Prompt
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As the portion of the calibration is complete, the Port 1 icon color changes from red to 
green. Actually, as the measurement is being made, the icon is blue, however, the 
measurement process may be so quick that you do not see the icon turn blue before turning 
to green.

3. Repeat steps 1 and 2 for each of the remaining ports.

The order that the ports are calibrated does not matter. 

Once all four of the ports are calibrated using the Reflect device, the color of each reflect 
icon has changed to green. See Figure 2-29.

Figure 2-29 Reflection Portion of Calibration Complete
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Thru-Line Portion of TRL Calibration  The following steps are the Thru-Line portion of 
the TRL calibration.

1. Click the Thru-Line icon that extends from Port 1 to Port 3. When this icon is clicked, the 
color changes from red to blue. See Figure 2-30.

Figure 2-30 Start Thru-Line Calibration Port 1 - Port 3

2. Click the top button on the right side of the display. In this case, the button is called 
Termination because the TRL calibration kit was defined with that label for Line 1 
Name. See Figure 2-25 on page 56. If you enter another name for Line 1, that label is 
used.

When you click the Termination button, the following prompt window is displayed:

Figure 2-31 Prompt for Line 1 (Termination) Calibration

3. Make the connections as described in the prompt window and click OK to start the 
calibration measurement.

Once this measurement is made, the color of the box at the right of the Termination 
button changes from red to green.

4. Repeat steps 2 and 3 for Line 2 (0.5 -- 3.0GHz), Line 3 (3.0 - 9.0GHz), Line 4 (9.0 - 
18.0GHz), and the Thru (ZeroDelay).
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Once these measurements are taken, the calibration between ports 1 and 3 is complete. 
See Figure 2-32. On the display, the color of:

• Each box to the right of the buttons have changed from red to green.
• The line between ports 1 and 3 changes from blue to green indicating that this path is 

complete.

Figure 2-32 Port 1 - Port 3 Line Portion of Calibration Complete

5. Repeat steps 1 through 4 for the Port 2 to Port 4 path.

Figure 2-33 Line Portion of Calibration Complete
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6. Select the Port 1 - Port 4 Thru icon.

Figure 2-34 Thru Icons for Port 1 - Port 4 and Port 2 - Port 3

The icon (both halves) turns blue and the box at the right of the Zero Delay Thru button 
turns red.

7. Click the Zero Delay thru button which displays the prompt window.

All of the line buttons are inactive.

8. After the thru is connected between ports 1 and 4 as indicated on the prompt and click the 
OK button. 

The calibration is performed and the color of the box to the right of the thru button and the 
thru icon are changed to green.

9. Repeat steps 6 through 8 to complete the Thru calibration between Port 2 and Port 3.
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10.Once the Port 2 to Port 3 Thru calibration is made, the TRL calibration measurements are 
complete. The color of all icons has changed to green. Refer to Figure 2-35. 

Figure 2-35 TRL Calibration Complete

11.Click the Next > button.

Continue at “To Save the TRL Calibration” on page 64.
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To Save the TRL Calibration  Once you have completed the TRL calibration, the Save 
Calibration Data dialog box is displayed as shown in Figure 2-36.

Figure 2-36 Save Calibration Data Dialog Box

1. Enter a file name for the calibration data set.

The calibration data file will be saved in the directory displayed in the Calibration Data 
File Path box. You may change the directory by entering the directory path in the box or 
selecting the Browse… button and navigating through your computer’s directory 
structure to the desired directory. The calibration data is saved with a “.cal” file extension.

2. Save the calibration data by selecting the Next > button.

When the calibration data is saved, the calibration is complete. A window is displayed 
showing how to make the connections to measure your DUT following the TRL calibration.

3. If you started the calibration:

• As part of the example measurement of Chapter 1, return to “How to Make a 
Measurement” on page 15.

• By entering the startup wizard at startup or by selecting New from the File menu, the 
software sends you to the Startup Wizard’s Setup & Calibration Complete! window 
where you can make a measurement.

• By selecting the system name from the Utilities menu and then selecting 
Calibrate…, the software returns to the main software window.
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Performing an LRM Calibration

You have selected the 4-Channel LRM (LINE - REFLECT - MATCH) calibration type. LRM 
calibration is convenient in that calibration standards can be fabricated for a specific 
measurement environment, such as a transistor test fixture or microstrip. Microstrip devices 
cannot be connected directly to the coaxial ports of the analyzer. The device under test (DUT) 
must be physically connected to the PLTS by some kind of transition network or fixture. 
Calibration for a fixtured measurement in microstrip presents additional difficulties.

A calibration at the coaxial ports of the PLTS removes the effects of the network analyzer, test 
set, and any cables or adapters before the fixture; however, the effects of the fixture itself are 
not accounted for. An in-fixture calibration is preferable, but high-quality SHORT - OPEN - 
LOAD - THRU (SOLT) standards may not be readily available to allow a calibration of the 
system at the desired measurement plane of the device. In microstrip, a short circuit is 
inductive, an open circuit radiates energy, and a high-quality purely resistive load is difficult 
to produce over a broad frequency range. The 4-Channel LRM calibration is an alternative to 
the traditional SOLT calibration technique that utilizes simpler, more convenient standards 
for device measurements in the microstrip environment.

For coaxial, waveguide and other environments where high-quality impedance standards are 
readily available, the traditional SOLT method provides the most accurate results since all of 
the significant systematic errors are reduced. 

In all measurement environments, you must provide calibration standards for the desired 
calibration to be performed. The advantage of LRM is that only three standards need to be 
characterized as opposed to four standards in the traditional SOLT calibration. Further, the 
requirements for characterizing the L, R, and M standards are less stringent and the 
standards are more easily fabricated.

Unless you have defined an LRM calibration kit previously, you will need to define an LRM 
calibration kit before proceeding. Refer to “Defining an LRM Calibration Kit”. Select Launch 
Startup Wizard from the Tools menu after you complete the definition to return to the 
calibration and measurement process.

The LRM calibration kit contains the following:

• zero length LINE

• “flush” short for the REFLECT standard (0 second offset)

• 50-ohm termination of the MATCH (infinite length line)

NOTE LRM with a zero length line is sometimes referred to as TRM (THRU - 
REFLECT - MATCH).
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NOTE LRM calibration is not supported for physical layer test systems that use the 
8753ES or the 872XES network analyzers.

Start with “Selecting an LRM Calibration Kit”.

Selecting an LRM Calibration Kit

The dialog box shown in Figure 2-37 lists the defined LRM calibration kits that have been 
determined by the auto-detection to be appropriate for the system hardware and the 
frequency range that was defined in the measurement parameters.

Figure 2-37 Select LRM Calibration Kit Dialog Box

NOTE No LRM calibration kits are defined in the software when you receive it. 

• If you have not defined your LRM calibration kit, select the Cancel button 
and define your LRM calibration kit using the procedure described in 
“Defining an LRM Calibration Kit” on page 68.

• If you have defined a LRM calibration kit but it is not displayed in the dialog 
box:
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1. Make sure that you have selected 4-Channel LRM from the Select 
Calibration Type list. See “Selecting a Calibration Type” on page 29.

2. Make sure that the start and stop frequencies that were defined for the 
LRM calibration kit (“Defining an LRM Calibration Kit” on page 68) 
match or exceed the start and stop frequencies that were defined in the 
measurement parameters (“Setting Up the Calibration and 
Measurement Parameters” on page 9).

1. Select your calibration kit in the Cal Kit column.

2. Select the More >> button to display the thru calibration configuration, the minimum and 
maximum frequencies of the kit, and the connector type of the four ports. See Figure 2-38.

Figure 2-38 Select Calibration Kit Dialog Box with More Button Selected

3. Once the calibration kit is selected in the Cal Kit column, click the Next > button to 
display the calibration window and continue with “Performing an LRM Calibration” on 
page 71.
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Defining an LRM Calibration Kit

The dialog box shown in Figure 2-40 shows only the USER_DEF selection. This indicates 
that a LRM calibration kit must be defined before a LRM calibration may be performed.

1. From the Utilities menu, select your PLTS system name and then select Edit Cal Kits… 
as shown in Figure 2-39.

Figure 2-39 Selecting Edit Cal Kits…

2. In the Select Cal Kit dialog box, select 4-Channel LRM from the Select Calibration 
Type list, then select the USER_DEF selection and click Edit to start the definition 
process. See Figure 2-40.

Figure 2-40 Select Cal Kit Dialog Box

3. The LRM calibration kit is defined using the Edit LRM Calibration Kit dialog box. See 
Figure 2-41.
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Figure 2-41 Blank Edit LRM Calibration Kit Dialog Box

4. Enter Cal Kit ID, Name, and Connector Type into the appropriate entry boxes in the 
header. Referring to Figure 2-42, Cal Kit ID is listed in the Cal Kit column and Name is 
listed in the Description column of the calibration kit selection window.

In this example, Cal Kit ID is defined as “LRM”, Name is defined as “GSG - 150 
micron”, and Connector Type is defined as “150 um”. Refer to Figure 2-38.

5. For the Reflect: Enter the delay value (in picoseconds) of the short that you are using in 
the Short Coefficients area. Figure 2-42 shows the data that is used in this example.

6. For the Match: Complete the Load Standards area by entering the characteristic 
impedance (Z0) in ohms and Delay in picoseconds. Also enter a Load Name for the Match 
as well as the start and stop frequencies in MHz of the load.

In this example, Z0 is defined as “500” ohms, Delay is defined as “-0.0034” ps, the Load 
Name is defined as “Termination”, Start Freq. is defined as “0.00” MHz, and Stop 
Freq. is defined as “50001” MHz. Figure 2-38 shows the data that is used in this example.

7. For the Line: In the Enter Cal Thru Characterization Data area, enter a name for the 
Thru along with its delay (in ps). In this example, the Thru Name is defined as “Line” 
and the Delay is defined as “1.0” ps. Figure 2-42 shows the data that is used in this 
example.
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Figure 2-42 Completed Edit LRM Calibration Kit Dialog Box

8. Once the LRM calibration kit data has been entered into the dialog box, select the OK 
button to save the calibration kit data and exit the Edit LRM Calibration Kit dialog box. 

The Cancel button closes the Edit LRM Calibration Kit dialog box without saving the 
calibration kit data.

9. Once the LRM calibration kit data has been saved, select Close to close the Select Cal Kit 
dialog box. See Figure 2-43.

Figure 2-43 Close the Select Cal Kit Dialog Box

10.Return to the startup wizard to complete the LRM calibration procedure. You can select 
New from the File menu to restart the wizard. 

• If you need help completing the startup wizard, return to Chapter 1 on page 3. 
• If you do not need assistance, continue with “Selecting an LRM Calibration Kit” on 

page 66.
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Performing an LRM Calibration 

NOTE For maximum accuracy and repeatability, the system (network analyzer and 
test set) should be stabilized at room temperature for a minimum of 24 hours 
before calibration.

As indicated by its name, the LINE - REFLECT - MATCH (LRM) calibration consists of three 
portions. First, the Reflect portion is performed by connecting a short to each system port. The 
Line portion is performed by connecting a thru between system ports 1 and 3 and then 
between ports 2 and 4. Finally, the Match portion is performed by connecting a load between 
ports 1 and 3, ports 2 and 4, ports 1 and 4, and ports 2 and 3. 

Figure 2-44 Initial LRM Calibration Display

The LRM calibration is performed in two parts. First the Reflect portion of the calibration is 
done. Then the Line-Match portion of the calibration is done.
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Reflect Portion of LRM Calibration  The following three steps are the Reflect portion of 
the LRM calibration.

1. Select the following icon to start the Reflection portion of the calibration:

2. As described in the prompt shown in Figure 2-45, connect the reflective device (in this 
case, defined as a short) from your calibration kit to Port 1 and click OK.

Figure 2-45 Displaying the Port 1 Reflection Prompt

As the portion of the calibration is complete, the Port 1 icon color changes from red to 
green. Actually, as the measurement is being made, the icon is blue, however, the 
measurement is so quick you may not even see the icon turn blue before turning to green.
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3. Repeat steps 1 and 2 for each of the remaining ports.

The order that the ports are calibrated does not matter. 

Once all four of the ports are calibrated using the Reflect device, the color of each reflect 
icon has changed to green. See Figure 2-46.

Figure 2-46 Reflection Portion of Calibration Complete
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Line-Match Portion of LRM Calibration  The following steps are the Line-Match portion 
of the LRM calibration.

1. Click the Line-Match icon that extends from Port 1 to Port 3. When this icon is clicked, the 
color changes from red to blue. See Figure 2-47.

Figure 2-47 Start Thru - Line Calibration Port 1 - Port 3

2. Click the top button on the right side of the display. In this case, the button is called 
Termination because the LRM calibration kit was defined with that label for Load 
Name (this is the name of the match). See Figure 2-42 on page 70. If you would have 
entered another name for the load, that label would be used.

When you click the Termination button, the following prompt window is displayed:

Figure 2-48 Prompt for Load (Termination) Calibration

3. Make the connections as described in the prompt window and click OK to start the 
calibration measurement.

Once this measurement is made, the color of the box at the right of the Termination 
button changes from red to green.

4. Repeat step 2 and 3 for the thru (Line).
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Once these measurements are taken, the calibration between ports 1 and 3 is complete. 
See Figure 2-49. On the display, the color of:

• Each box to the right of the buttons have changed from red to green.
• The line between ports 1 and 3 changes from blue to green indicating that this path is 

complete.

Figure 2-49 Port 1 - Port 3 Line Portion of Calibration Complete

5. Repeat steps 1 through 4 for the Port 2 to Port 4 path.

Figure 2-50 Line Portion of Calibration Complete
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6. Select the Line icon that extends from Port 1 to Port 4.

Figure 2-51 Thru Icons for Port 1 - Port 4 and Port 2 - Port 3

The icon (both halves) turns blue and the box at the right of the Line button turns red.

7. Click the Line button which displays the prompt window. (The Termination button is 
inactive.)

8. After the Line (thru) is connected between ports 1 and 4 as indicated on the prompt and 
click the OK button. 

The calibration is performed and the color of the box to the right of the thru button and the 
thru icon are changed to green.

9. Repeat steps 6 through 8 to complete the Line calibration between Port 2 and Port 3.
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10.Once the Port 2 to Port 3 Line calibration is made, the LRM calibration measurements are 
complete. Refer to Figure 2-52. 

The color of all icons has changed to green.

Figure 2-52 LRM Calibration Complete

11.Click the Next > button.

Continue at “To Save the LRM Calibration” on page 78.
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To Save the LRM Calibration  Once you have completed the LRM calibration, the Save 
Calibration Data dialog box is displayed as shown in Figure 2-53.

Figure 2-53 Save Calibration Data Dialog Box

1. Enter a file name for the calibration data set.

The calibration data file will be saved in the directory displayed in the Calibration Data 
File Path box. You may change the directory by entering the directory path in the box or 
selecting the Browse… button and navigating through your computer’s directory 
structure to the desired directory. The calibration data is saved with a “.cal” file extension.

2. Save the calibration data by selecting the Next > button.

When the calibration data is saved, the calibration is complete. A window is displayed 
showing how to make the connections to measure your DUT following the LRM 
calibration.

3. If you started the calibration:

• As part of the example measurement of Chapter 1, return to “How to Make a 
Measurement” on page 15.

• By entering the startup wizard at startup or by selecting New from the File menu, the 
software sends you to the Startup Wizard’s Setup & Calibration Complete! window 
where you can make a measurement.

• By selecting your PLTS system name from the Utilities menu and then selecting 
Calibrate…, the software returns to the main software window.
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Characterizing Adapters

For non-insertable1 calibrations, the thru adapter to be used must be characterized by itself so 
that its effects can later be removed from the calibration measurement results. 

Several standard thru adapter characterization files have been provided with PLTS (see the 
..\PLTS\adapters directory) and are automatically selected based on the calibration kit to be 
used. These files may be used with very good results, but for the very highest accuracy, it is 
recommended that you characterize your own adapters using the following procedure.

To perform the characterization, first, a short/open/load calibration is performed directly at 
the front panel of the system. Either one or two test ports will be used depending on the 
adapter category selected during the process. Then the adapter is inserted and the 
short/open/load calibration is repeated. The resulting adapter S-parameters are saved in 
Citifile format, which can later be de-embedded from the device measurement. 

For adapters that will be used for broadband measurements, characterize the adapter over 
the entire frequency range of the instrument with as many points as possible. This allows for 
interpolation of adapter data if the frequency points used in a later DUT measurement are 
not exactly the same as the adapter frequency points.

Adapter characterization is performed directly at the instruments front panel (either Port 1 or 
Ports 1 and 4). If an additional adapter is needed between the front panel and the adapter to 
be characterized (for type or gender change), install the additional adapter first (metrology 
grade recommended), and perform all calibrations with it installed.

For purposes of characterization, your adapters must have an orientation. Mark the 
connectors on the adapter as ports 1 and 2, and treat them as such during the 
characterization procedure. Forward orientation has the lower-numbered adapter port 
connected to the test-set port.

Follow these steps to characterize your adapters:

1. Select Characterize Adapter from the Utilities menu to start the Custom Adapter 
Characterization Wizard.

Figure 2-54 Characterize Adapter Selection

1. Non-insertable calibrations are those in which the test port connectors are of the 
same gender (male-to-male or female-to-female).
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2. In the Custom Adapter Characterization Wizard dialog box, select the appropriate adapter 
category and the calibration kit to be used. See Figure 2-55. Press Next > to continue to 
the next window.

The two adapter characterization categories are:

• “In-Series, Same-Sex” uses a single port (Port 1) and applies only to adapters having 
the same type and gender on both ends (3.5 mm male-to-male, for example). Select the 
calibration kit to be used on Port 1 from the pull-down menu.

• “All Others” uses two ports (Ports 1 and 2) and allows the adapter types to be specified 
independently. Select the calibration kits to be used on Port 1 and on Port 2 from the 
pull-down menus.

Figure 2-55 Custom Adapter Characterization Wizard
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3. Set up the stimulus to measure the adapter in the Adapter Characterization wizard’s 
Calibrate Hardware for Measurement window. See Figure 2-56. When you are finished, 
click the Next > button to continue. 

Refer to “Setting Up the Calibration and Measurement Parameters” on page 9 for 
information on this window’s parameters.

Figure 2-56 Measurement Stimulus Parameter Setup Window
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4. Connect one of the standards (Short - Open - Load) to Port 1 on the PLTS and click the icon 
that represents the standard in the Port 1 Ref area. The PLTS will measure the adapter 
and when it has finished, the icon color changes from red to green.

Figure 2-57 Measuring the Standards (Short - Open - Load) on Port 1

Each of the three icons represents a different calibration standard.

 represents the short standard 

 represents the open standard 

 represents the 50-ohm load standard 

5. Repeat step 4 for the two remaining icons. The color of all three icons in the Port 1 Ref 
area have changed from red to green.

6. Connect the adapter that is being characterized to Port 1.

Mark the end that is connected to Port 1. The opposite end will be connected to Port 4 later 
in this procedure.
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7. Repeat step 4 and step 5 connecting to the standards to the adapter. Click the icons in the 
Port 1 FWD area to make the measurements (Figure 2-58). As before, as each standard is 
measured, the color of the icon changes from red to green. When you have finished, the 
color of all three icons in the Port 1 FWD should have changed from red to green.

Figure 2-58 Remeasuring the Standards with the Adapter on Port 1
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8. When the standards have been measured on the adapter at Port 1 and all of the Port 1 
standard icon colors have changed from red to green, repeat step 4 through step 7 on 
Port 4.

As mentioned in step 6, remember to connect opposite end of the adapter to Port 4 (the 
adapter end that you did not connect to Port 1).

Figure 2-59 Measuring the Standards/Adapter on Port 4

9. When you have finished, click the Next > button to continue. 

All 12 standard icon colors have changed from red to green. 
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10.When the characterization is complete, save the adapter file using the dialog box shown in 
Figure 2-60. Enter a file name for the adapter data and click Finish. The file is 
automatically saved as a “.txs” file. The default directory for saving adapter 
characterization information is C:\Program Files\Agilent\PLTS\adapters, where C is the 
hard drive where the PLTS is stored.

Figure 2-60 Save Adapter Characterization File Dialog Box

11.Since the characterization file is in Citifile format, you can import the data and make a 
visual check of the quality of the characterization. Select Import from the File menu and 
then select Citifile. You may open and inspect the adapter characterization file.
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Setting Up, Calibrating, and Making Measurements using the TDR-Based PLTS
This chapter guides you through setting up the initial measurement definitions, performing 
the system calibration, and making a measurement with the TDR-based PLTS hardware. 
PLTS supports the TDR-based PLTS hardware using coaxial test cables. 

You will need four coaxial test cables for the TDR-based PLTS measurements.

• For the Agilent 86100A/B/C, we recommend you use:

— Four 3.5 mm (male-female) cables (such as the Agilent N4419A-B20)
-or-

— Four 3.5 mm (male-male) cables (Agilent part number 8120-4948) with a 3.5 mm 
(female-female) adapter used as a connector saver

• For the Tektronix CSA8000 and TDS8000, we recommend you use:

— Four 3.5 mm (male-male) cables (Agilent part number 8120-4948) 
-or-

— Four 3.5 mm (male-female) cables (such as the Agilent N4419A-B20) with a 3.5 mm 
(male-male) adapter (Agilent part number 1250-1748)

You also need the following calibration standards to perform the TDR calibration. As Table 
3-1 shows, different standards are required depending on the TDR-based PLTS hardware and 
the desired calibration type.

Agilent Probe Model Numbers:

• N1020A 6 GHz Time Domain Reflectometry Probes (Set of 4)
• N1020A-K05 Calibration Substrate for use with N1020A Probes

Table 3-1 Required 3.5mm (SMA) Calibration Standardsa

a. Recommended Agilent Part Numbers: Loads, 3.5mm (f), 1250-2151; 3.5 mm (m) 1810-0118
Shorts, 3.5mm (f), 1250-2152; 3.5mm (m) 1250-2153
Thrus, 3.5mm (f-f), 5061-5311; 

TDR 
System

Calibration For 
Single-Ended Measurements

Calibration for Differential 
Measurements

Module
Calibration

Reference 
Plane Cal 

Only

Normalization 
plus Reference 
Plane Cal

Reference 
Plane Cal 

Only

Normalization 
plus Reference 

Plane Cal

Agilent 
86100A/B/C

1 50Ω Load 1 Thru 1 50Ω Load
1 Short
1 Thru

2 Thrus 2 50W Loads
2 Shorts
2 Thrus

Tektronix 
CSA8000/
TDS8000

2 50Ω Loads 1 Thru Not Applicable 2 Thrus Not Applicable
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CAUTION Avoiding ESD Damage to TDR Plug-In Modules

The input connectors are very sensitive to electrostatic discharge (ESD). When 
you connect a device or cable that is not fully discharged to the input connector, 
you risk damage to the module and expensive instrument repairs. Refer to your 
TDR documentation for detailed information regarding ESD susceptibility.

The Startup Wizard steps you through the following steps to make a measurement. 

1. Initial setup includes:

• System Hardware Verification and Calibration Level Selection
• TDR Calibration and Measurement Parameter Setup
• Calibration and Measurement Parameter Selection

2. Calibration includes:

• Calibration Kit Selection
• Calibration Kit Definition 

(if you need to use other than one of the predefined calibration kits)
• Calibration, which includes:

 Module Calibration (may be required or may be recommended)
 Reference Plane Calibration Only -or- Normalization and Reference Plane 
Calibration

3. Measurement includes:

• Device Under Test Connection
• Initial Analysis Type Selection
• Stimulus and Parameter Verification
• Running a Measurement

After the measurement is made, the main Physical Layer Test System (PLTS) window gives 
you the flexibility to perform analysis on the measured data in a variety of ways.

• Time Domain. The Time Domain analysis may be analyzed in Differential or 
Single-Ended mode.

• Frequency Domain. The Frequency Domain analysis may be analyzed in Balanced or 
Single-Ended mode.

• Eye Diagram. The Eye Diagram analysis may be analyzed in Differential or 
Single-Ended mode.

• Transmission Line (RLCG). The RLCG analysis may be analyzed in Differential, 
Common, W-Element, and Self/Mutual modes.
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Starting the Startup Wizard
The Startup Wizard is displayed when the PLTS application is started. The Startup Wizard 
Welcome screen is displayed in Figure 3-1. It is also displayed anytime a new measurement is 
initiated, such as after selecting New from the File menu, or clicking on the new file icon on 
the toolbar.

Figure 3-1 Startup Wizard Welcome Screen

The Startup Wizard Welcome Screen gives you two choices, New Measurement or Load 
Measurement. The selected choice has a green check mark to the right of the label. New 
Measurement leads you through the process of calibrating and making a measurement. 
Load Measurement loads measurement data from an existing file that you must select. 

When you select New Measurement, the Startup Wizard will guide you through:

• Initial Setup
• Calibration
• Measurement 

For this exercise, select New Measurement and then select the Next > button.
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Performing the Initial Setup
The Initial Setup process includes:

1. Verifying that the software recognizes your PLTS system hardware.

This step uses the left portion of the Hardware Auto-Detection Summary dialog box to 
verify that the software recognizes the correct system hardware. This portion of the dialog 
box displays the model number, GPIB address, and serial number of the hardware. You 
may re-scan to look for hardware changes automatically. You may select another 
recognized PLTS measurement system.

2. Selecting the appropriate level of calibration for the upcoming measurement.

This step uses the right portion of the Hardware Auto-Detection Summary dialog box to 
select the appropriate level of calibration to be performed. You may perform a new 
calibration, reuse existing calibration data, or perform measurements without calibration.

3. Setting up the TDR Calibration and Measurement Settings.

This step uses the Setup TDR dialog box to display the default TDR calibration and 
measurement settings, based on the PLTS hardware recognized by the software. You may 
modify these default TDR calibration and measurement settings as required.

4. Selecting the calibration and measurement parameters.

This step uses the Select Calibration and Measurement Parameters dialog box to allow you 
to select the parameters that will be measured. A calibration will be performed only where 
required for selected parameters.
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The Hardware Auto-Detection Summary dialog box (see Figure 3-2) is displayed when you 
select New Measurement and then click the Next > button described on page 90. 

Figure 3-2 Hardware Auto-Detection Summary Dialog Box

To Verify the Software Recognizes the PLTS Hardware

On the left portion of the Hardware Auto-Detection Summary dialog box, the model number, 
the GPIB address, the serial number, and the firmware revision for the TDR mainframe is 
displayed. In addition, the model numbers and serial numbers for the left side and right side 
modules are also displayed. This is the test equipment that the software finds connected to 
the GPIB bus. 

If this information is incorrect, check your hardware connections and power status, then 
select the Re-Scan button. The software re-checks for the presence of hardware on the GPIB.
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NOTE If you have multiple PLTS systems on the GPIB and you want to select the 
other equipment, click the Select New Device button. The Select 
Measurement System dialog box is displayed. See Figure 3-3. To choose another 
PLTS system, you may select from the available PLTS systems and then click 
the OK button. The software makes the change and returns to the Startup 
Wizard Welcome Screen of Figure 3-1.

Figure 3-3 Select Measurement System Dialog Box

The Cancel button exits without saving a change and returns to the Startup 
Wizard Welcome Screen.

To Select the Appropriate Level of Calibration

On the right portion of the Hardware Auto-Detection Summary dialog box (Figure 3-2), select 
your calibration strategy:

• Perform a new calibration continues with the Startup Wizard performing a new 
calibration before making a measurement.

• Load existing calibration data allows you to select a previously saved calibration 
(*.cal) file to be used for the new measurement. See “To Perform a Module Calibration” on 
page 109 for guidance on calibration intervals, etc.

• None. Collect measurement data uncalibrated allows you skip the calibration, select 
measurement parameters (see Figure 3-4 on page 94), and then proceed directly to the 
measurement screen. This option is not recommended for qualitative data collection.

Select the Perform a new calibration choice for this example exercise and then click the 
Next > button.
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To Set Up the TDR

The Setup TDR wizard screen is displayed. See Figure 3-4. This screen allows you to set the 
TDR parameters for the calibration and measurement. Each of these parameters is described 
in Table 3-2, “TDR Parameter Descriptions.”

Figure 3-4 Setup TDR Dialog Box

This wizard screen is initially displayed with default values for each entry. You may accept or 
modify these values. Modifying some of these values directly may also modify other associated 
values interactively. For example, when changing the Effective Dielectric Constant, the 
Relative Velocity Factor will change appropriately. 

The Reset Values button returns all selections and values to their default value.

When the Setup TDR dialog box values are correct, click the Next > button to continue.
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Table 3-2 TDR Parameter Descriptions

Parameter Description

Maximum Time 
Base

Sets the desired measurement range in nanoseconds.The default setting is 
5 ns. Typically the time base should be set to 2.5−3 times the electrical length 
of the DUT. Note: reflection measurements are “round trip”.

Minimum Rise 
Time

Sets the rise time of normalized measurements in picoseconds. This is a 
function of normalization and is available to only the Agilent 86100-based 
TDR system.

Sampler 
Bandwidth

Sets the Agilent 86100-based TDR system receiver to either a 18.0 GHz 
bandwidth (which gives the highest fidelity and the fastest response time) or 
a 12.4 GHz bandwidth (which gives the best sensitivity by reducing the 
noise). This bandwidth is set at 20 GHz for other TDR systems.

Points/Waveform Sets the number of points for a waveform. Select Automatic or Manual. 
Automatic allows the TDR to select the record length for the input 
waveform. The TDR selects a record length that optimizes the amount of 
acquired data and the display update rate. This is available to only the 
Agilent 86100-based TDR system.
Manual allows you to define a record length from a list of points.
Record Length allows you to select the number of points from a list. 
Depending on the TDR system, the available number of points are: 
− 16, 32, 64, 128, 256, 512, 1024, 2048, or 4096
-or-
− 20, 50, 100, 250, 500, 1000, 2000, or 4000.

Averaging Enable turn the trace averaging on and off. 
Number of Averages sets the number of sweeps to be averaged. Increasing 
the number of averages improves the signal-to-noise ratio at the cost of 
increased measurement time.
Best Throughput allows you to view the waveform as it is acquired. The 
TDR displays any noise and feed through error on the signal. It has a faster 
measurement time. This is available to only the Agilent 86100-based TDR 
system.
Best Flatness turns on the feed through compensation circuit which reduces 
the amount of feed through error. This is useful when the measurement time 
base is in the 1µs range or greater. It has a slower measurement time. This is 
available to only the Agilent 86100-based TDR system.
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Effective 
Dielectric 
Constant

Specifies the dielectric constant for your transmission medium. If the DUT is 
an embedded stripline printed circuit board trace, then the same material is 
on each side of the DUT and the effective dielectric constant is simply the 
value of the dielectric material. This device configuration is known as a 
“homogenous dielectric system”. If the DUT is a microstrip printed circuit 
board trace with one side exposed to air, then the effective dielectric constant 
is a combination of air dielectric (1.0) and the dielectric material. This device 
configuration is known as a “nonhomogenous dielectric system”. If the DUT 
is a complex channel consisting of PCB traces, connectors, vias and/or cables, 
then the effective dielectric constant will also be complex.

Relative Velocity 
Factor

Specifies the relative velocity for your transmission medium. Some velocity 
factor (VF) examples are: Air VF=1.000, Surface traces VF=0.53146, Buried 
Traces in εr~4.3: VF=0.48795

Table 3-2 TDR Parameter Descriptions

Parameter Description
Chapter 396



Setting Up, Calibrating, and Making Measurements using the TDR-Based PLTS
Performing the Initial Setup
To Select the Calibration and Measurement Parameters

The Select Calibration and Measurement Parameters dialog box is displayed. See Figure 3-5. 
The left side of the dialog box lists all 16 of the available single-ended measurements. The 
right side of the dialog box lists all 16 of the available differential measurements.

NOTE If you are using only one TDR module, your available measurements will be 
limited only eight parameters will be available.

For example, if your 54754A TDR module is installed in the left slot, you will 
only be able to measure four single-ended parameters (T11, T12, T21, and T22) 
and four differential parameters (TDD11, TDC11, TCD11, and TCC11).

Figure 3-5 Select Calibration and Measurement Parameters Dialog Box

The default status for each of these measurements is selected. When a measurement is 
selected, it has a check in the check box for the corresponding measurement. However, you 
may not need or desire data for all 32 parameters (16 single-ended and 16 differential 
parameters). As a general rule, the more parameters that you select, the longer the 
calibration and the measurement takes to perform. 

Figure 3-6 provides a tool for estimating calibration times for each selected parameter. 
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Figure 3-6 Approximate Calibration Times for Single-Ended Parameters

Leave all parameters selected for this example exercise and then click the Next > button.
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Performing a Calibration
The PLTS software adds value and capability to both Agilent and Tektronix TDR systems by 
automating the calibration process which saves time, reduces the chance of calibration errors, 
eliminates tedious procedures, and improves the calibration results. The PLTS calibration 
process includes:

1. Selecting a calibration kit and defining the calibration file name.

This step uses the Select Calibration Kit and Filename dialog box to select the calibration 
standards and connectors that are used during the calibration process. The file name that 
the calibration information is saved to is also defined.

2. Defining a calibration kit.

This optional step allows you to define a calibration kit if none of the pre-defined 
calibration kits match your calibration needs.

3. Choosing the calibration type.

This step uses the Calibrate TDR and Modules wizard window to define the type of TDR 
calibration that will be performed, either a “Reference Plane Calibration Only” or a 
“Normalization and Reference Plane Calibration”.

4. Performing the calibration for the TDR modules.

This step uses the Calibrate TDR and Modules wizard window to perform the calibration 
for the modules within your system.

5. Setting the reference plane at the end of the cables.

This step uses the Calibrate TDR and Modules wizard window to perform the standards 
calibrations, either the Reference Plane Calibration Only or the Normalization and 
Reference Plane Calibration.

Once the Next > button in the Select Calibration and Measurement Parameters dialog box is 
selected, the Select Calibration Kit and Filename wizard screen is displayed. See Figure 3-7.

Start the calibration.
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To Select a Calibration Kit and Define the Calibration File Name

The PLTS software has five default TDR calibration kits. It also stores the calibration kit 
information. 

1. Select the calibration kit to use for the TDR calibration from the Select the calibration 
kit to use: list of the Select Calibration Kit and Filename wizard screen.

The PLTS software has several calibration kits already defined for the TDR calibration. All 
of these calibration kits are listed in the Select the calibration kit to use: list. PLTS is 
set to the Default 3.5mm selection.

Figure 3-7 Select Calibration Kit and Filename Wizard Screen

Table 3-3 Pre-Defined TDR Calibration Kits

Name Description

85052D-M 85052D male cal kit
85052D-F 85052D female cal kit
Default SMA TDR cal kit with female SMA thru
Default_3.5mm TDR cal kit with 3.5mm Connector Saver
N1020A-K05 N1020A TDR Probe cal kit
Chapter 3100



Setting Up, Calibrating, and Making Measurements using the TDR-Based PLTS
Performing a Calibration
The Select the calibration kit to use: list area displays each of the defined calibration 
kits and its description. 

When the More >> button is selected, the list area also displays the thru configuration, 
the minimum frequency, the maximum frequency, and the calibration kit connector type as 
shown in Figure 3-8. The button label toggles between More >> and << Less.

Figure 3-8 Calibration Kit List with More >> Selected

If the calibration kits listed in the Select the calibration kit to use: list area do not 
match your calibration kit, you may define a new calibration kit to meet your 
requirements. Refer to “To Define a Calibration Kit” on page 103.

2. In the Specify calibration file to create/modify: text box of the Select Calibration Kit 
and Filename wizard screen, specify the file that you will use to save the calibration data.

The text box displays a default calibration file name based on the current date. It uses the 
string “TDRcal_” followed by the current date. For this example, “TDRcal_21Sep03” is 
displayed. You may enter another file name if you like. This calibration file name is used 
as a base name for saving calibration files on the PC and on the Agilent 86100-based TDR 
(if this TDR is being used).

• Files Stored on the PC

This calibration file name is used as a base name for saving calibration files on the PC 
for the TDR. The calibration will be saved to the calibration directory. If you installed 
PLTS to the default C:/ directory, you may follow this path to the calibration directory: 
C:/Program Files/Agilent/PLTS/calibration

• Files Stored on the 86100-based TDR

This calibration file name is also used as a base name to store additional calibration 
and setup files if you are using an Agilent 86100A/B/C TDR. The files stored on the 
86100-based TDR are dependent on the calibration and measurement parameters that 
you selected in the initial setup procedure. For each parameter calibration, a setup file 
and a calibration file are stored on the 86100 hard drive in the “setups” directory and 
the “TDR normalization” directory, respectively.

If you want to overwrite a previously saved calibration file, you may select the Load… 
button to display the TDR Calibration Files Found dialog box. This dialog box displays 
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each TDR calibration file that has been saved in the Existing Calibration Files list. See 
Figure 3-9.

Figure 3-9 TDR Calibration Files Found Dialog Box

You may review the calibration data that is saved in a calibration file by selecting a file in 
the Existing Calibration Files list. When a file is selected, its calibration information is 
displayed in the Selected Calibration File Information area as shown in Figure 3-10.

Figure 3-10 TDR Calibration Files Found Dialog Box with Calibration 
Information Displayed

Calibration files may be deleted by selecting the calibration kit in the Existing 
Calibration Files list and then selecting the Delete Cal File button. This also deletes 
the corresponding normalization files on the 86100-based TDR.
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NOTE Normalization files are stored on the Agilent 86100 DCA mainframe drive.

Click the OK button to return to the Select Calibration Kit and Filename wizard screen. 

3. After the calibration kit is selected and the calibration file name is defined, click the 
Next > button to continue with the calibration.

For this example, the selected calibration kit is set to the Default 3.5mm selection and 
the default calibration file name.

To Define a Calibration Kit 

If none of the previously defined calibration kits in the Select the calibration kit to use: 
list meets your requirements, you can define your calibration kit. To define a calibration kit:

1. Exit the startup wizard by clicking the close button in the upper right corner of the wizard: 

If you exit the wizard, all previously-defined setup definitions are lost. 

2. From the Utilities menu, select the TDR System Model (in this case, 
86100A|54754A|54754A), the click Edit Cal Kits as shown in Figure 3-11.

Figure 3-11 Selecting Edit Cal Kits
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3. In the Select Cal Kit dialog box, make sure 4-Channel TDR is selected in the Select 
Calibration Type list, then select the USER_DEF selection and click Edit to start the 
process. See Figure 3-12.

Figure 3-12 Select Cal Kit Dialog Box

4. The calibration kit definition is performed in the Edit TDR Calibration Kit dialog box 
shown in Figure 3-13. Enter Cal Kit ID and Name into the appropriate entry boxes in the 
header.

The Cal Kit ID is listed in the Cal Kit column and Name is listed in the Description 
column of the calibration kit selection window shown in Figure 3-7.

Figure 3-13 Blank Edit TDR Calibration Kit Dialog Box
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5. Also enter Connector Type. You may optionally specify the minimum (Min. Freq. MHz) 
and the maximum (Max. Freq. MHz) frequencies in megahertz.

The PLTS software does not currently use the frequency range information. 

6. Enter the delay values for the open and short standards Open Delay and Short Delay 
entry boxes.

Enter the delay values in picoseconds. The value may be found in the calibration kit 
documentation if you are using a standard from a calibration kit.

Typically, if you are using an un-terminated connector or cable as the open, you may enter 
“0” (zero) ps as the value for the open.

Figure 3-14 Completed Edit TDR Calibration Kit Dialog Box

7. Enter the delay value (in picoseconds) of the thru in the Thru Delay entry box. Then, in 
the list of thrus, select the box at the left of the thru and click the Add button to associate 
the thru to the entered delay value. Repeat this until all six thru paths are completed.

The color of the box at the left of the thru changes from red to green as the thru path is 
completed. Figure 3-14 shows the data that is used in this example. Be sure to enter a 
delay value for all six thru paths.

If your thru is part of an Agilent (or Hewlett-Packard) calibration kit, the delay value is 
listed in the Standard Definitions section of the calibration kit documentation.
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The Remove button disassociates the delay value with the thru path allowing you to 
change the delay value for the path.

All of the thru paths may use the same delay value or you may have multiple thru delay 
values if you are using a thru having a different delay. One instance of using more than 
one delay value might be when you are creating a calibration kit definition for probing and 
not all of the thru paths would use the same thru delay value.

8. After the Edit TDR Calibration Kit dialog box is complete, click the OK button to save the 
calibration kit with the new information and return to the Select Cal Kit dialog box shown 
in displaying the newly defined calibration kit in the list. Cancel deletes the information 
entered and returns to the Select Cal Kit dialog box.

9. Then click the Close button to close the Select Calibration Kit dialog box.

Figure 3-15 Select Cal Kit Dialog Box with Newly Defined Cal Kit

Return to the Startup Wizard by selecting New from the File menu to make your 
measurement. Refer back to “Starting the Startup Wizard” on page 90.
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To Choose the Calibration Type

After selecting the calibration kit, verifying the data file, and selecting the Next > button, the 
Calibrate TDR and Modules wizard window is displayed. See Figure 3-16. This wizard 
window is used for the entire calibration.

Figure 3-16 Calibrate TDR and Modules Wizard Screen: Initial Display

To select the calibration type, you will only use the Choose Cal. Type area which is labeled 
“1” in Figure 3-16. This area is shown in Figure 3-17. The Choose Cal. Type area allows you 
to select between the two calibration types listed.

Figure 3-17 Choose Cal. Type Area

The Ref. Plane Calibration Only selection:
• Is available to all compatible TDR systems
• Sets the reference plane at the end of the cables
• Automatically de-skews the cables when differential measurements are selected
• Positions the trace on the display for easy viewing such that the step is one-half of a 

division from the left edge of the display and displays the complete maximum time base 
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value to the right of the step
• Recommends the module calibration

The Normalization & Ref. Plane Calibration selection:
• Is the most complete and accurate TDR calibration
• Has all of the features as the reference plane calibration selection listed above
• Removes cable loss, mismatch, and reflection errors which can be significant

NOTE TDR Normalization
— Is available only with the Agilent 86100-based TDR system using the 

86100’s built-in differential TDR/TDT normalization feature
— Requires the module calibration

Choose the Calibration Type

1. In the Choose Cal. Type area (see Figure 3-17), select either Ref. Plane Calibration 
Only or Normalization & Ref. Plane Calibration.
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To Perform a Module Calibration

The module calibration, also called the vertical channel calibration, calibrates the gains, 
offsets, and timing for each channel. This calibration is valid for all supported TDR systems.

The module calibration is not always a requirement. The Module Cal. area (see Figure 3-18) 
has a text box that indicates the status of the module calibration. It displays: REQUIRED, 
RECOMMENDED, or VALID

Figure 3-18 Module Cal. Area

The module calibration is not required if you selected if you selected Ref. Plane Calibration 
Only in the Choose Cal. Type area. However, it is recommended.

Once a module calibration is performed, it remains valid for ten hours, unless:
• the instrument power has been cycled
• the module has been removed and then reinserted.
• the ambient temperature changes more than 5°C since the last module calibration

There are two icons which represent the two modules, the icon labeled “L” representing the 
left module (channels 1 and 2) and the icon labeled “R” representing the right module 
(channels 3 and 4). The color of the module calibration icon shows the status of the module 
calibration. 

If an icon is:
• Red, the module calibration is required.
• Yellow, the module calibration is recommended.
• Green, the module calibration is valid.

The Resistance Value text box allows you to enter the resistance value of your load. The 
default value is 50 ohms.

Perform the Module Calibration

1. Enter the resistance value of your load in the Resistance Value text box if it varies from 
the current value.

2. Click the left module’s “L” icon to start the module calibration. 
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3. Follow the PLTS software prompts to perform the module calibration for the left module. 
Figure 3-19 shows the first prompt that is displayed.

Figure 3-19 First Module Calibration Prompt

NOTE Follow the PLTS software prompts on your PC rather than following any 
prompts that is displayed on your TDR to ensure your calibration is correct.

The module calibration gives you five prompts. 

NOTE This procedure requires that all cables be removed from the module.

The left module calibration prompts are:

i.  Disconnect everything from the left module
ii. Connect a 50 ohm load to Channel 1 at the reference plane
iii. Connect a 50 ohm load to Channel 2 at the reference plane 

(Note: You may use the load that was on channel 1 or you may use another load.)
iv. Disconnect everything from the left module
v. Done Re-connect test port Cables to Ports 1 and 2

When the module calibration is complete, the left module icon color changes to green.

4. Repeat steps 2 and 3 to perform the module calibration for the right module using the icon 
labeled “R”.

Once the right module calibration is complete, the color of both icons has changed to green. 
Also the text box which displayed either REQUIRED or RECOMMENDED, now has 
changed to VALID.

CAUTION Make sure the module calibration passes. If either of the module calibrations 
fail, you may still be able to complete the calibration and make a measurement. 
However, the accuracy of the measurement will be in doubt. It is recommended 
that you reattempt the module calibration before proceeding and correct the 
equipment problem, if there is one.
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The module calibration procedure is now complete and the module calibration factors are 
stored in the non-volatile memory in the modules. 

To Set the Reference Plane at the End of the Cables

This procedure de-skews, performs a reference plane calibration, performs a normalization (if 
selected) using the Connect Cal. Standards area. 

Both calibration types (Ref. Plane Calibration Only and Normalization & Ref. Plane 
Calibration) require that the standards be connected to perform the calibration. After the 
calibration type is chosen and all required module calibrations are complete, the calibration 
icons are displayed in the Connect Cal. Standards area of the Calibrate TDR and Modules 
wizard screen shown in Figure 3-20.

The calibration first calibrates the reference plane, setting the reference plane at the end of 
the cables. Then the calibration automatically de-skews the cables if differential 
measurements are selected. If the Normalization & Ref. Plane Calibration type is 
selected, then the normalization is performed which removes errors such as, cable loss, 
mismatch, and reflections.

NOTE Automatic De-Skewing

Unmatched cables and differences in the path of the TDR module cause skew in 
differential and common signals. Skew must be removed to provide accurate 
differential measurements. De-skewing is required for TDR and TDT 
measurements. PLTS performs this tedious, error-prone task automatically and 
correctly. PLTS can remove skew of up to 780 ps in the Agilent TDR system and 
of up to 340 ps in the Tektronix TDR systems.

PLTS removes the TDR skew by measuring the amount of skew, and then 
adding 1/2 of the amount to the appropriate channel. PLTS then repeats the 
process, iteratively adjusting the channels until the rest of the skew is removed.

After TDR is de-skewed, Channel 1 is connected to channel 3 while channel 2 is 
connected to channel 4 using thrus. The time difference is measured in the two 
TDT signal paths and de-skewing is applied to the appropriate channel 
correcting the TDT response.

This section guides you through performing the calibrations for both calibration types. Both 
types are divided into two calibrations:

•  Single-Ended, Differential-Mode, and Common-Mode Calibration
•  Thru Path Calibration
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Figure 3-20 Calibrate TDR and Modules Wizard Screen

Figure 3-20 shows the Calibrate TDR and Modules wizard screen when all calibration and 
measurement parameters selected. The Connect Cal Standards area displays several icons. 
All available icons are displayed in this illustration. Both modules are shown with four icons. 
There are three unique icons: 

The icon labeled “1” is the single-ended icon. This icon is displayed twice in each module; once 
for each TDR channel. The icon labeled “2” is the differential-mode icon. It is displayed in each 
module. The icon labeled “3” is the common-mode icon. It is also displayed in each module.

Some of these icons may not be displayed when you are performing a calibration. The icons 
that are displayed depend on the calibration and measurement parameters that are selected 
during the initial setup in “To Select the Calibration and Measurement Parameters” on 
page 97. Table 3-4 shows when each of these icons are displayed and which calibrations are 
required based on the selected parameters. 

Table 3-4 Single-Ended, Differential-Mode, and Common-Mode Calibration Parameters

Icon Definition Selected Parameters that Display Icon

Single-Ended T11, T22, T33, and T44: All single-ended TDR parameters 
(T11: icon on Channel 1, T22: icon on Channel 2, 
T33: icon on Channel 3, T44: icon on Channel 4)
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The color of the icons displayed in the Connect Cal Standards area is red if the calibration 
has not performed. While the calibration is being performed, the icon color is blue. When the 
calibration is complete, the icon color turns to green.

The calibration also requires a calibration between the ends of the TDR channel cables. These 
calibrations are called Thru Path calibrations because a “thru” connector is used to connect 
the ends of the cables. Refer to Table 3-5 for an illustration showing each of the six thru path 
icons representing the each thru path between the four channels.

Some of these thru path icons may not be displayed when you are performing a calibration. As 
with the single-ended, differential-mode, and common-mode icons shown above, the icons that 
are displayed depend on the calibration and measurement parameters that are selected 
during the initial setup in “To Select the Calibration and Measurement Parameters” on 
page 97. Table 3-5 also shows when each of these icons are displayed and which calibrations 
are required based on the selected parameters. 

Differential 
Mode

TDD11, TCD11, TDD22, TCD22: All differential TDR parameters 
having a differential stimulus (TDD11 and TCD11: icon on module 1, 
TDD22, TCD22: icon on module 2.

Common 
Mode

TDC11, TCC11, TDC22, TCC22: All differential TDR parameters 
having a common stimulus (TDC11 and TCC11: icon on module 1, 
TDC22, TCC22: icon on module 2.

Table 3-5 Thru Paths Required by the Parameters Selected

Thru Paths Icons 
Displayed on Wizard

Thru 
Paths

Single-Ended 
Parameters

Differential Parameters

1 − 2 T12 and T21 N/A

1 − 3 T13 and T31 TXX12 or TXX21, where XX is DD, 
DC, CD, or CCa

a. When a differential parameter warrants the thru path calibration on either thru path 1 − 3 
or 2 − 4, the calibration of the other thru path is required and is performed at the same time.

1 − 4 T14 and T41 N/A

2 − 3 T23 and T32 N/A

2 − 4 T24 and T42 TXX12 or TXX21, where XX is DD, 

DC, CD, or CCa

3 − 4 T34 and T43 N/A

Table 3-4 Single-Ended, Differential-Mode, and Common-Mode Calibration Parameters

Icon Definition Selected Parameters that Display Icon
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Perform the Single-Ended, Differential-Mode, and Common-Mode Calibrations

This section guides you through performing the Single-Ended, Differential-Mode, and 
Common-Mode Calibrations for both calibration type selections (Ref. Plane Calibration 
Only and Norm & Ref. Plane Calibration).

Selecting an icon in the Connect Cal Standards area starts the calibration. The order that 
the calibration is performed is completely arbitrary. You may select the icons in any order.

NOTE TDR calibration has an incremental calibration feature. This allows you to 
recalibrate a specific parameter if you suspect there is an error. To recalibrate 
just that suspect calibration parameter, select the icon that represents the 
suspect parameter and follow the prompts.

In this example, the calibration is performed using all of the icons. See Figure 3-20 for an 
illustration. The left module is calibrated first. The right module is calibrated next.

1. Select the single-ended icon  at Channel 1 to display the prompt box that reads: Leave 
open Channel 1 at the reference plane

The prompt box is displayed in Figure 3-21. These prompts are used throughout the TDR 
calibration.

Figure 3-21 Single-ended Calibration Prompt

NOTE Follow the PLTS software prompts on your PC rather than following any 
prompts that is displayed on your TDR to ensure your calibration is correct.
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2. Make sure that nothing is connected to the end of the Channel 1 cable and click the OK 
button to calibrate.

This is the only connection for the Ref. Plane Calibration Only. However, if you are 
performing a Norm & Ref. Plane Calibration, there are two additional calibration 
prompts to follow. These prompts are:

i. Connect a short to Channel 1 at the reference plane
ii. Connect a 50 ohm load to Channel 1 at the reference plane

The calibration is complete when the single-ended icon color changes to green.

3. Repeat steps 1 and 2 for the single-ended icon  at Channel 2.

4. Select the differential-mode icon  of the left module to display the prompt box that 
reads: Leave open Channels 1 and 2 at the reference plane

5. Make sure that nothing is connected to the end of the Channel 1 and Channel 2 cables and 
click the OK button to calibrate.

This is the only connection for the Ref. Plane Calibration Only. However, if you are 
performing a Norm & Ref. Plane Calibration, there are four additional calibration 
prompts to follow. These prompts are:

i. Connect shorts to Channels 1 and 2 at the reference plane
ii. Remove short from Channel 1 at the reference plane
iii. Connect a 50 ohm load to Channel 1 at the reference plan
iv. Replace short on Channel 2 with a 50 ohm load

The calibration is complete when the differential-mode icon color changes to green.

6. Select the common-mode icon  of the left module to display the prompt box that reads: 
Leave open Channels 1 and 2 at the reference plane

7. Make sure that nothing is connected to the end of the Channel 1 and Channel 2 cables and 
click the OK button to calibrate.

This is the only connection for the Ref. Plane Calibration Only. However, if you are 
performing a Norm & Ref. Plane Calibration, there are four additional calibration 
prompts to follow. These prompts are:

i. Connect a short to Channel 1 at the reference plane
ii. Connect a 50 ohm load to Channel 1 at the reference plane
iii. Connect a short to Channel 2 at the reference plane
iv. Connect a 50 ohm load to Channel 2 at the reference plane

The calibration is complete when the common-mode icon color changes to green.
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With all of the left module calibrations complete, the right module is calibrated next.

8. Repeat steps 1 through 7 for Channel 3 and Channel 4 on the right module.

With all of the right module calibrations complete, perform the thru path calibration next.

Perform the Thru Path Calibration

This section guides you through performing the thru path calibrations for both calibration 
type selections (Ref. Plane Calibration Only and Norm & Ref. Plane Calibration).

Selecting an icon in the Connect Cal Standards area starts the calibration. The order that 
the calibration is performed is completely arbitrary. You may select the icons in any order. 
However, for this example, start with step 1.

1. Select the thru path icon between Channel 1 and Channel 2 (see Table 3-5, if necessary) 
and follow the PLTS software prompts to perform the thru path calibration between these 
channels. Figure 3-22 shows the prompt that is displayed.

Figure 3-22 Channel 1 - Channel 2 Thru Path Prompt

NOTE Follow the PLTS software prompts on your PC rather than following any 
prompts that is displayed on your TDR to ensure your calibration is correct.

The calibration is complete when the thru path icon color changes to green.

2. Select the thru path icon between Channel 1 and Channel 3.

Depending on the selected parameters, the prompt box message can vary as shown in 
Figure 3-23 when the thru icon between channels 1 and 3 (or between channels 2 and 4) is 
selected. 
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Figure 3-23 Channel 1 - Channel 3 Thru Path Prompts

3. Using thru connectors, make the cable connections indicated by the prompt and select the 
OK button to calibrate.

The calibration is complete when the thru path icon colors change to green.

4. Repeat step 1 for the remaining uncalibrated thru paths.

You may repeat any portion of this calibration by clicking the icon and following the 
prompt that is displayed.

5. When the calibration is complete and the color of all of the icons have changed to green, 
click the Calibrate TDR and Modules wizard screens Next > button to complete the 
calibration. Continue at “Making a Measurement” on page 118.

NOTE TDR calibration has an incremental calibration feature. This allows you to 
recalibrate a specific parameter if you suspect there is an error. To recalibrate 
just that suspect calibration parameter, select the icon that represents the 
suspect parameter and follow the prompts.

This completes the TDR calibration.

NOTE As mentioned above, TDR calibration has an incremental calibration feature. 
In addition to recalibrating a suspect parameter during a calibration, this 
feature allows you to revisit the calibration wizard and select additional 
parameters to calibrate (Figure 3-5) and continue through the calibration 
(Figure 3-20) and while following the prompts, calibrate just those incremental, 
new parameters. 
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Making a Measurement
The Measurement process includes:

1. Connecting the DUT

This step shows you how to connect your DUT to the PLTS.

2. Selecting the initial displayed format of the measurement

This step guides you through selecting which of the ten analysis formats that the 
upcoming measurement will initially be displayed in. The measurement can be displayed 
in any of the 10 formats at any time.

3. Modifying the measurement stimulus and measured parameters

This optional step allows you to make last minute changes to the measurement stimulus 
dialog box and the measurement parameter dialog box. Only changes that will not require 
a recalibration may be made.

4. Running the measurement

This step guides you through starting the measurement and displaying the data when the 
measurement is complete. It also directs you to save the measurement and points you to 
the chapters that will assist in your data analysis.

To Connect the DUT

1. After saving the calibration data and selecting the Next > button, the Device connection 
scheme for TDR calibrations window is displayed. See Figure 3-24. This wizard window 
shows how to connect your DUT to the TDR system to make the measurement. Connect 
the DUT to the TDR system as shown and then click the Next > button.
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Figure 3-24 Connecting the DUT to the TDR System

To Select the Initial Displayed Format of the Measurement

1. The Hardware and Calibration Setup Wizard Complete window is displayed. See Figure 
3-25. 

This window is the software location to select the one of ten analysis formats that the 
measurement will be displayed as initially. The analysis formats are:

For the purpose of this example, the Time Domain (Differential) format icon is selected.

• Time Domain (Differential)

• Frequency Domain (Balanced)

• Eye Diagram (Differential)

• RLCG (Differential)

• RLCG (W-Element)

• Time Domain (Single-Ended)

• Frequency Domain (Single-Ended)

• Eye Diagram (Single-Ended)

• RLCG (Common)

• RLCG (Self/Mutual)
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Figure 3-25 Hardware and Calibration Setup Wizard Complete

To Modify the Measurement Stimulus and Measured Parameters

1. The Modify Measurement Stimulus button opens the Measurement Stimulus dialog 
box. See Figure 3-26. This dialog box allows you to change some of the measurement 
stimulus settings that you set up previously.

Settings that would require a recalibration are not active and may not be changed in this 
dialog box. To change the stimulus settings that are inactive, you must click the < Back 
button until you get back to the window described in “To Set Up the TDR” on page 94. 

Figure 3-26 Measurement Stimulus Dialog Box

For the purpose of this example, leave the settings unchanged and click the OK button.
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The Reset Values button resets any active values (any values that can be changed 
without requiring a recalibration) to their original default values prior to being changed in 
“To Set Up the TDR”. 

The Cancel button resets any changes that were made after opening this dialog box.

NOTE After the measurement has been made, you may verify these changes were 
made by printing a characterization report. See “Characterization Report 
Generator” on page 315 for help.

2. Once you exit the Measurement Stimulus dialog box, the Select Measurement Parameters 
dialog box is displayed. See Figure 3-27. The left side of the dialog box lists all 16 of the 
TDR single-ended measurements. As with the dialog box described in “To Select the 
Calibration and Measurement Parameters” on page 97, the right side of the dialog box lists 
all 16 of the TDR differential measurements. Only the parameters for which the 
calibration is valid are active. You may select all of the active parameters or you may select 
a subset of these parameters. Selecting a subset of the parameters may save you some 
measurement time.

Figure 3-27 Select Measurement Parameters Dialog Box

To measure parameters that are inactive, you must click the < Back button until you get 
back to the window shown in To Select the Calibration and Measurement Parameters and 
reselect the parameters. However, note that if you change the parameters in this window, 
you may be required to perform additional portions of the calibration. 

For the purpose of this example, leave the parameters unchanged and click the OK button.

3. With the Hardware and Calibration Setup Wizard Complete window is displayed (see 
Figure 3-25), select the Next > button to start the measurement.
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To Run the Measurement

1. The software displays the wizard’s Measurement & Post-Processing Status window and 
starts the measurement and the measurement post-processing. See Figure 3-28. The 
software makes each of the measurements. The status of the measurements and the 
post-processing is displayed in the status text area. The status may also be observed by 
watching the status bar at the right edge of the text area. As the measurements and the 
post-processing proceed, the color of the bar gradually changes to blue.

Once the post-processing is complete, click the Next > button to display the measurement 
results in the main PLTS window.

Figure 3-28 Measurement & Post-Processing Status Window
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Analyzing the Measurement Results

Now that you have measured the device under test, the measurement results are displayed in 
the main PLTS window as shown in Figure 3-29. This shows the results in the Time Domain 
(Differential) format, the analysis format selected earlier.

Figure 3-29 Displayed Measurement in Time Domain (Differential) Format

Now that the measurement has been made, the main Physical Layer Test System (PLTS) 
window gives you the flexibility to perform analysis on the measured data in a variety of 
ways.

• Frequency Domain. The Frequency Domain analysis may be analyzed in Balanced or 
Single-Ended mode.Refer to Chapter 4, “Analyzing Data in the Frequency Domain,” on 
page 127 for information.

• Time Domain. The Time Domain analysis may be analyzed in Differential or 
Single-Ended mode. Refer to Chapter 5, “Analyzing Data in the Time Domain,” on 
page 147 for information.
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• Eye Diagram. The Eye Diagram analysis may be analyzed in Differential or 
Single-Ended mode. Refer to Chapter 6, “Analyzing Data using Eye Diagrams,” on 
page 185 for information.

• Transmission Line (RLCG). The RLCG analysis may be analyzed in Differential, 
Common, W-Element, and Self/Mutual modes. Refer to Chapter 7, “Analyzing 
Transmission Line Parameters,” on page 205 for information.

CAUTION To ensure the measurement data is not lost, you may want to first save the 
measurement data by selecting Save from the File menu. See “Save” under the 
“File Menu” section in the “Menu Reference” chapter of the PLTS Installation 
and Reference Guide.
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Part II provides detailed information about optimizing and analyzing the measured data 
using the physical layer test system.

Chapter 4, “Analyzing Data in the Frequency Domain”

Provides information about analyzing measured data in the frequency domain.

Chapter 5, “Analyzing Data in the Time Domain”

Provides information about analyzing measured data in the time domain.

Chapter 6, “Analyzing Data using Eye Diagrams”

Provides information about analyzing measured data using the eye diagram.

Chapter 7, “Analyzing Transmission Line Parameters”

Provides information about extracting transmission line R, L, C, G parameters 
from the measured data.

Chapter 8, “Importing and Exporting Data”

Provides information about importing data files into PLTS and exporting 
measured data for use with other software packages, such as TDA IConnecta 
MeasureXtractorb, Avanti HSPICE, or Agilent ADS.

a. IConnect is a registered trademark of TDA Systems, Inc.
b. MeasureXtractor is a trademark of TDA Systems, Inc.

Chapter 9, “Removing Unwanted Effects from the Measurement”

Provides information about using measurement enhancement features such as 
gating, port rotation/extension, and de-embedding. 

Chapter 10, “Using Analysis Tools and Utilities”

Provides information about using the PLTS tools, such as markers, trace math, 
overlaying traces, zooming, printing, and report generator and the file converter 
utility.
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Analyzing Data in the Frequency Domain
Physical layer test systems can provide measurement-based frequency domain information in 
two ways: 

• Making frequency domain measurements directly utilizing a vector network analyzer 
(VNA) and an S-parameter test set to sweep the DUT with an RF signal and measuring 
the RF response.

• Making the time domain measurements utilizing a Time Domain Reflectometer (TDR) to 
apply a synthesized step waveform to a DUT and observing the response. Then the 
measured time domain information is converted to the frequency domain using the Fast 
Fourier Transform (FFT).

In a linear network, the Fourier Transform describes the relationship between a time 
domain measurement and its corresponding frequency domain response in detail. 
Therefore, given the measured time domain response of a DUT, it is possible to determine 
its frequency domain response mathematically by performing a Fourier Transform.

There is information to be gained from the frequency domain that other analysis types do not 
provide. Frequency domain information can help you verify and validate your modeling and 
simulation procedures by providing:

• Vector error-corrected data which allows you to de-embed fixtures and signal launches 

• More accurate simulation for frequency dependent effects, such as bandwidth and 
impedance 

• Insight into common analog problems, such as crosstalk, reflections, and loss

• Better information more efficiently when you are analyzing the effects of transmission 
lines, studying power/ground distribution, and investigating EMI effects as a function of 
frequency

• S-parameter data which can be used over the widest range of applications and frequency 
bandwidths
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About S-Parameters
At high frequencies, S-parameters (scattering parameters) are commonly used to describe the 
performance of microwave and RF devices. These parameters can be used to completely 
describe the electrical behavior of the device (or network). For those not familiar with 
S-parameters, they are simply the energy that is reflected off of, or transmitted through, a 
device under test. While S-parameter data is formatted differently than TDR/TDT data, the 
underlying information is the same. 

S-parameters relate to familiar measurements such as reflection coefficient (input/output 
match), and transmission coefficient (gain or loss, and isolation). They are the shared 
language between simulation and measurement and are easily imported into 
electronic-design automation (EDA) tools like HSPICE, ADS, and other simulators.

Conventional single-ended parameters describe the performance of a single-ended device 
when it is stimulated on a single port, and the corresponding responses are observed on all of 
the ports. For a detailed explanation, refer to “Single-Ended (Unbalanced) S-Parameters” on 
page 130. Mixed-mode (or balanced) S-parameters describe the performance of devices with 
balanced ports. For a detailed explanation, refer to “Mixed Mode (Balanced) S-Parameters” on 
page 132.

Common Frequency Measurements with S-Parameters

Reflection Measurements Transmission Measurements

Return Loss Insertion loss

Standing Wave Ratio (SWR) Gain/loss

Reflection coefficient Transmission coefficient

Impedance Electrical delay

Sxx (x = stimulus port and response port) Syz (z = stimulus port, y = response port)
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How to Interpret S-Parameters
A multi-terminal device can be viewed in different ways, depending on how it is meant to be 
operated. For a device that is designed to be a single-ended four-port device, its conventional 
(single-ended) four-port S-parameters can be measured and displayed. In a balanced device, 
two terminals constitute a single balanced port. Each balanced port will support both a 
common-mode and a differential-mode signal. This performance is described using 
mixed-mode (balanced) S-parameters.

Single-Ended (Unbalanced) S-Parameters

Conventional single-ended S-parameters are defined as the ratio of two normalized power 
waves (response/stimulus), defined in terms of the voltages and current at each port of a 
device (see Figure 4-2).

S-parameter notation identifies these quantities using the following convention:

SAB

where:

The first number (represented by A) refers to the test-device port where the signal is 
received. This received signal is referred to as the response.
- and -
The second number (represented by B) refers to the test-device port where the signal is 
sourced. This signal is referred to as the stimulus.

Figure 4-1 S-Parameter Notation
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Figure 4-2 Single-Ended S-Parameter Review

Figure 4-3 shows the naming convention for a single-ended 4-port S-matrix, showing the ratio 
of all possible combinations of response/stimulus.

Figure 4-3 Single-Ended S-Matrix
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Mixed Mode (Balanced) S-Parameters

Mixed-mode S-parameters are used to describe the performance of balanced circuits by 
independently considering each mode of operation. The mixed-mode S-parameter concept is 
similar to conventional S-parameter definitions, except that instead of stimulating a single 
terminal of the DUT, we consider pairs of terminals to be stimulated in either a differential 
(anti-phase) or a common (in-phase) mode. 

For a balanced device, we are not necessarily interested in voltages and current referenced to 
ground. Instead, we can define differential and common mode voltages and currents on each 
balanced port. Likewise, we can also define differential-mode and common-mode impedances.

We can define normalized power waves on the ports of a balanced device having the exact 
same form as the single-ended case. Only the definitions of “voltage” and “current” are 
changed. Both are defined as ratios of normalized power waves.

Figure 4-4 Mixed Mode S-Parameter Basics
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The naming convention for mixed-mode S-parameters includes mode information as well as 
port information. Unlike the single-ended example, though, in the mixed-mode S-matrix, we 
are not only considering the port, but we are also considering the mode of the signal at each 
port. Therefore, the first two subscripts describe the mode of the response and stimulus, 
respectively, and the next two subscripts describe the ports of the response and stimulus.

Again we can take the ratio of all possible combinations of response over stimulus for the 
differential and common mode normalized power waves to calculate the mixed-mode 
S-parameters. The mixed-mode matrix fully describes the linear performance of a balanced 
two-port measurement. Figure 4-5 shows the naming convention for a mixed mode S-matrix, 
showing the ratio of all possible combinations of response/stimulus.

Figure 4-5 Mixed-Mode (Balanced) S-Matrix
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Viewing Data in the Frequency Domain
This section guides you with opening measured data in the frequency domain and viewing the 
data in the way that best suits your requirements. As discussed earlier, there are 16 4-port 
S-parameters for both single-ended and balanced devices. See Figure 4-3 and Figure 4-5. You 
may elect to view any number of these S-parameters.

Opening a Frequency Domain Plot Window

The frequency domain may be viewed in either balanced or single-ended mode. You may open 
the frequency domain plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 4-6

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 4-6

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 4-6

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Frequency Domain choices - see (B) of Figure 4-6

Figure 4-6 Opening the Frequency Domain Plot Window
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NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the Data menu 
when the blank plot window is displayed.

Viewing All 16 S-Parameters

Except when you open the plot window using the Browser, all 16 frequency domain 
parameter plots are displayed. The parameter plots are displayed in the same orientation as 
shown in Figure 4-3 and Figure 4-5. Each plot is labeled with its parameter at the top. See 
Figure 4-7.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all 16 plots by selecting All from the Parameter Bar or from the 
Data menu with New Plot selected.

Figure 4-7 All 16 Balanced Frequency Domain Plots
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Viewing a Single S-Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
16 plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 4-8. 

Figure 4-8 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
Chapter 4136



Analyzing Data in the Frequency Domain
Viewing Data in the Frequency Domain
View Multiple Traces on a Single Plot

This single plot may have just one parameter or if you choose, it could contain up to four 
parameters. For example, you could show how SDD21 compares with SCC21. To do this 
double-click on the SDD21 plot so that is now displaying a single plot similar to Figure 4-8. 
With SDD21 displayed as a single plot, make sure New Trace is selected in the Parameter 
Bar (or the Data menu), then click any parameters you wish to add, SCC21 in this example. 

Figure 4-9 A Single Plot with Multiple Traces

It could contain as many as 4 of the parameters. All trace parameters are labeled at the right 
edge of the plot. The color of the trace labels are the same color as the traces they represent.
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Creating a Custom S-Parameter Plot Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four SDDxx plots. To create a custom window, open the data 
file in any analysis type. Then, in the Browser, select the data type that you want to display 
the plots. In this example, select Frequency Domain (Balanced). A blank plot window is 
displayed. With New Plot selected in the Parameter Bar (or the Data menu), click the 
desired parameters (SCC11, SCC12, SCC21, and SCC22 in this example). As each parameter 
is selected, a new plot is added to the plots window. See Figure 4-10.

Figure 4-10 Custom S-Parameter Plots Window with Four Plots
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Selecting Frequency Domain Display Formats
A data format is the way the physical layer test system presents the measurement 
graphically. Select a data format appropriate to the information you want to learn about the 
device. You may use either the Format Bar or the Format menu to select the format.

Figure 4-11 Format Menu and Format Bar for Frequency Domain

Frequency Domain Format Bar

Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. Typical 
measurements are return loss and gain. This is the default format.

Linear Mag displays positive values only. Typical measurements are 
transmission, reflection coefficients, time domain transfer.

Phase displays phase (no magnitude).

Group Delay displays signal transmission (propagation) time through a device. 
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Smith Chart displays an impedance plane that is mapped onto the polar plane. 
Every point on the Smith Chart represents a complex impedance made up of a real 
resistance (r) and an imaginary reactance (r + jX). The dotted circles represent 
constant resistance. The horizontal line through the middle is purely resistive (no 
reactive component).

• To the far right, the value is zero ohms (short). To the far left, the value is 
infinite ohms (open).

The dotted arcs represent constant reactance.

• The reactance arcs in the upper (positive) half of the circle represent inductive 
reactance (ZL = jωL).

• The reactance arcs in the lower (negative) half of the circle represent capacitive 
reactance (ZC = 1/jωC).

• Typical measurements: Impedance profile

When in this format, the cursor bar allows you to choose the cursor value in either 
Mag + Phase or Inductance style. Refer to “Frequency Domain Polar and Smith 
Chart Markers” on page 296 for additional information.

Polar Chart plots the measurement result in a vector representation. 

The magnitude at any point is determined by its displacement from the center (or 
zero value). Magnitude is scaled linearly, with the value of the outer circle set to a 
ratio value of 1.

The radial lines scale the phase angle from 0 degrees to +180 degrees 
(counterclockwise) or −180 degrees (clockwise).

When in this format, the cursor bar allows you to choose the cursor value in either 
Mag + Phase or Inductance style. Refer to “Frequency Domain Polar and Smith 
Chart Markers” on page 296 for additional information.

Real displays only the real (resistive) portion of the measured complex data. Can 
show both positive and negative values. Typical measurement: time domain

Imaginary displays only the imaginary (reactive) portion of the measured complex 
data. Typical measurements are impedance for designing matching circuits.

Frequency Domain Format Bar
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Table 4-1 Frequency Domain Formats

Log Mag Linear Mag

Phase Group Delay
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Smith Chart Polar Chart

Real Imaginary

Table 4-1 Frequency Domain Formats
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Setting the Scale
The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 4-12 Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 4-13.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 4-13.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 4-13.

Figure 4-13 Entering a Scale Value
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Setting the Scale
The horizontal scale is changed by changing the start and stop frequencies in megahertz 
(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
frequencies used in the measurement. The horizontal scale may not be changed in Smith 
Chart and Polar formats.

The vertical scale units vary depending on the format. 

Format Vertical Scale Units

Log Mag decibels (dB)

Linear Mag mU

Phase degrees

Group Delay nanoseconds (nS)

Smith Chart Not Applicable

Polar Not Applicable

Real mU

Imaginary mU
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Quick Scale Features

PLTS has three features that make scaling changes quickly and easily. The three features are:

• Autoscale

• Reset Scale

• Copy Plot Format used with Paste Plot Format (see “Copying and Pasting Plot 
Formats” on page 320)

Autoscale

Autoscale changes the vertical scale of the active plot to allow the trace to occupy 
approximately 80% of the vertical axis of the display. It places the display such that the 
graticule values are numbers that are easy to work with.

Figure 4-14 Autoscale

To autoscale a plot, select the plot, then right click on the plot to display the quick menu 
displayed in Figure 4-16. Click Autoscale to change the vertical scale of the plot. Figure 4-15 
shows a frequency domain plot that has Autoscale applied to it.
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Figure 4-15 A Plot that has been Autoscaled

Reset Scale

Reset Scale resets the vertical and horizontal scale of the active plot to the default settings. 
This is useful when you are adjusting the scale and the trace is moved off screen and can no 
longer be seen.

To reset the scale of a plot, select the plot, then right click on the plot to display the quick 
menu displayed in Figure 4-16. Click Reset Scale to reset the plot to the default settings.

Figure 4-16 Reset Scale
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Analyzing Data in the Time Domain
Physical layer test systems can provide measurement-based time domain information in two 
ways: 

• Making the time domain measurements directly utilizing a Time Domain Reflectometer 
(TDR) to apply a synthesized step waveform to a DUT and observing the response. 

• Making frequency domain measurements utilizing a vector network analyzer (VNA) and 
an S-parameter test set to sweep the DUT with an RF signal and measuring the RF 
response. Then the measured frequency domain information is converted to the time 
domain using the Inverse Fast Fourier Transform (IFFT).

In a linear network, the Fourier Transform describes the relationship between a frequency 
domain measurement and its corresponding time domain response in detail. Therefore, 
given the measured frequency domain response of a DUT, it is possible to determine its 
time domain response mathematically by performing an inverse Fourier Transform. PLTS 
accomplishes the frequency domain transformation to time domain by utilizing the inverse 
chirp Z Fourier transform1.

The type of information that can be observed in time domain mode is quite different than the 
information that can be observed in frequency domain mode. If the network is thought of in 
terms of its equivalent circuit model, then the frequency domain response describes the 
composite behavior of all of the circuit elements at any given operating frequency. 

By contrast, the time-domain response shows the contribution of each individual circuit 
element. Since there is a direct relationship between time and distance, this mode allows each 
element to be separated spatially. With an understanding of the unique signature 
characteristics of different circuit elements, this view of the DUT can provide considerable 
insight into the device.

The advantages of using the PLTS measurement approach for TDR data are listed below. 
While the traditional TDR measurement technique provides fast measurement speed, the 
measurement technique used by PLTS provides:

• Superior accuracy
• Significantly better dynamic range (important for crosstalk and mode-conversion terms)
• Ability to de-embed fixtures and signal launchers
• Access to both frequency and time domain information (as vector quantities)
• Single setup for forward and reverse transmission and reflection, single-ended, 

differential-, and common-mode, and mode-conversion terms
• No need for DUT to have DC return path
• No large voltage steps applied to DUT

1. The advantage of the chirp z-transform is that it enables calculation of the sample of the 
z-transform equally spaced over an arc or a spiral contour with an arbitrary starting point 
and arbitrary frequency range. In contrast, the frequency range of the discrete Fourier 
Transform is strictly related to the sampling frequency.
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TDR/TDT Mode
The time domain mode shows the contribution of each individual circuit element. Using time 
domain reflectance (TDR), you can measure the location, electrical length, nature of 
discontinuities (resistive, capacitive, inductive), and amount of reflection from discontinuities. 
Time domain transmission (TDT) response parameters typically measured are gain, 
propagation delay, and crosstalk between traces.

The physical layer test system can measure and display any of the single-ended (unbalanced) 
or mixed-mode S-parameters in the time domain and display the response of a device as if it 
were stimulated with either a step or an impulse waveform. For those not familiar with 
S-parameters, they are simply the energy that is reflected off of, or transmitted through, a 
device under test. S-parameters are defined as the ratio of two normalized power waves 
(response/stimulus), defined in terms of the voltages and current at each port of a device. For 
more information, see “How to Interpret S-Parameters” on page 130.

• In TDR/TDT mode, the horizontal axis displays:

— Reflection parameters showing the characteristics of the DUT at a certain time delay 
into the device. 

— Transmission parameters showing the propagation delay through the device.

• The vertical axis displays:

— An impulse response that is a reflection or transmission coefficient on either a linear or 
logarithmic scale. This parameter can be displayed as an absolute number, or relative 
to a minimum or maximum value of the response. 

— A step response on either a linear or a logarithmic scale. Alternatively, a reflection 
parameter can be displayed as impedance versus time rather than as a reflection 
coefficient.

The following table shows the relationship between frequency domain parameters to their 
time domain equivalents.

Table 5-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter

Single-ended N/A TDR S11

Single-ended Reverse TDT S12

Single-ended Reverse TDT S13
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Single-ended Reverse TDT S14

Single-ended Forward TDT S21

Single-ended N/A TDR S22

Single-ended Reverse TDT S23

Single-ended Reverse TDT S24

Single-ended Forward TDT S31

Single-ended Forward TDT S32

Single-ended N/A TDR S33

Single-ended Reverse TDT S34

Single-ended Forward TDT S41

Single-ended Forward TDT S42

Single-ended Forward TDT S43

Single-ended N/A TDR S44

Differential Forward TDR SDD11

Differential Reverse TDT SDD12

Differential Forward TDT SDD21

Differential Reverse TDR SDD22

Common Forward TDR SCC11

Common Reverse TDT SCC12

Common Forward TDT SCC21

Common Reverse TDR SCC22

Differential-to-Common Forward TDR SCD11

Differential-to-Common Reverse TDT SCD12

Table 5-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter
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Analyzing Time-Domain Signatures
The time-domain response of a device, its signature, provides specific circuit detail. The shape 
of the response indicates the element type and configuration (series or shunt). Its value and 
location can be determined from the size of the reflection and its time delay. In general, a 
wider measurement bandwidth will provide finer response resolution. Table 5-2 shows 
various circuit elements and associated time-domain signatures.

Differential-to-Common Forward TDT SCD21

Differential-to-Common Reverse TDR SCD22

Common-to-Differential Forward TDR SDC11

Common-to-Differential Reverse TDT SDC12

Common-to-Differential Forward TDT SDC21

Common-to-Differential Reverse TDR SDC22

Differential-to-Single-ended Reverse TDT SSD12

Differential-to-Single-ended Reverse TDT SSD13

Single-ended-to-Differential Forward TDT SDS21

Single-ended-to-Differential Forward TDT SDS31

Common-to-Single-ended Reverse TDT SSC12

Common-to-Single-ended Reverse TDT SSC13

Single-ended-to-Common Forward TDT SCS21

Single-ended-to-Common Forward TDT SCS31

Table 5-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter
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Table 5-2 Time Domain Signatures

Transmission Line: ZC < Z0

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Transmission Line: ZC > Z0

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Series Inductor

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Shunt Capacitor

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Practical Considerations
In general, better accuracy of the measured frequency domain data will provide for better 
accuracy of the time domain data. Using the step mode rather than the sweep mode provides 
additional frequency stability of the source which can greatly improve the time domain data. 
The following are several other important considerations.

Masking

Time domain responses are most accurate closest to the location of the source. A discontinuity 
in the DUT will reflect some power back to the source, meaning less power is transmitted to 
the rest of the DUT. This loss of power going away from the source is referred to as masking, 
and allows the true impedance of the next discontinuity to be misrepresented.

Figure 5-1 Masking Effects

Masking effects can be seen in Figure 5-1. The plot on the left shows the differential-mode 
input reflection of a device (SDD11). The first large discontinuity is the input connector; the 
second is the output connector. Because these connectors are physically identical, the 
apparent impedance difference between the two can be attributed to masking. The power level 
at the output connector has been decreased (masked) by the input connector. The plot on the 
right, output reflection (SDD22), proves this. Looking backwards into the device, the output 
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connector now exhibits the greater apparent impedance. Were it not for masking, these two 
plots, and the measured impedance of the input and output connectors, would be identical.

The high dynamic range of a VNA-based PLTS system extends the ability of the instrument to 
accurately characterize devices that have several discontinuities or high loss. TDR-based 
PLTS systems may not be as accurate.

Time Domain Windowing

The PLTS software has a feature called Time Domain Windowing that is designed to enhance 
Time Domain measurements. The need for windowing is due to the abrupt transitions in the 
Frequency Domain measurement at the Start and Stop frequencies. This band limiting of the 
frequency domain response causes overshoot and ringing in the Time Domain response. It 
causes the un-Windowed Impulse stimulus to have a sin (kt)/kt shape (k=π/frequency span), 
which has two effects that limit the usefulness of the Time Domain measurement:

• Finite Impulse Width limits the ability to resolve between two closely spaced responses. 
The effects of the finite impulse width cannot be improved with increasing the frequency 
span of the measurement.

• Impulse side lobes limit the dynamic range of the Time Domain measurement by hiding 
low-level response within the side lobes of the higher-level responses. The effects of side 
lobes can be improved by windowing.

Windowing improves the dynamic range of the Time Domain measurement by modifying 
(filtering) the Frequency Domain data prior to conversion to the Time Domain to produce an 
impulse stimulus with lower side lobes. This greatly enhances the effectiveness in viewing 
Time Domain responses that are very different in magnitude. The side lobe reduction is 
achieved, however, as the tradeoff with increased impulse width. The effect of windowing on 
the STEP stimulus is a reduction of overshoot and ringing while the tradeoff is increased rise 
time.

PLTS defines three window selections: Flat Response, Nominal, and Fast Rise Time. Each 
of these selections has an associated Time Domain Window Value. See Figure 5-3. The side 
lobe levels of the Time Domain stimulus depend only on the window that is selected.

PLTS also allows you to define your own window using the Custom selection where you will 
set you own Time Domain Window Value.

The purpose of windowing is to make the Time Domain response more useful in isolating and 
identifying individual responses. The window does not affect the displayed Frequency Domain 
response. The Time Domain function is only applied to time domain data. It does not affect 
frequency domain data. Figure 5-2 shows typical effects of windowing on the Time Domain 
response of the reflection measurement of a short circuit.
Chapter 5 157



Analyzing Data in the Time Domain
Practical Considerations
NOTE The windowing setting also has an effect on the transformation of eye diagrams.

Figure 5-2 Windowing Effect on Time Domain Responses of a Short Circuit

The following formula can be used to determine the equivalent 10 percent to 90 percent 
system rise time for the step function transformation and the eye diagram simulation:

Table 5-3 shows the equivalent rise times for a maximum frequency of 20 GHz for each 
window setting.

 Tr = (1000 / Fmax) × RTEC

Where, Tr = Rise time of the step response form 10% to 90% (in picoseconds)

 1000 = Factor to convert frequency to picoseconds

 Fmax = Maximum stop frequency used in the measurement (in GHz)

 RTEC = Rise time equation coefficient

As an example: System rise time = 27 ps = (1000/ 20 GHz) × 0.54 (see table below)

Table 5-3 Equivalent Rise Times for a Maximum Frequency of a 20 GHz System

Window Selection TD Window 
Valuea

a. The relationship between the TD window value and the rise time equation coefficient is not 
made available.

Maximum 
Frequency

(Fmax)

 Rise Time Equation 
Coefficient 

(RTEC)

Equivalent 
Rise Time 

(Tr)

Flat Response 0.80 20 GHz 0.91 45.5 ps

Nominal 0.50 20 GHz 0.71 35.5 ps

Fast Rise Time 0.20 20 GHz 0.54 27 ps
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By increasing or decreasing the filter value above or below the default, a trade-off can be 
made between rise time and side-lobe level (dynamic range). 

When Time Domain Window… is selected from the Tool menu, the Time Domain Window 
dialog box is displayed allowing a choice of the three Time Domain Window settings. 

Figure 5-3 Time Domain Window Dialog Box

• Flat Response gives the minimum side lobes and this provides the greatest dynamic 
range. The time domain window value is 0.80. The rise time equation coefficient value 
is 0.91.

• Nominal gives reduced side lobes and is normally the most useful. The time domain 
window value is 0.50. The rise time equation coefficient value is 0.71. This is the default 
setting.

• Fast Rise Time is essentially no window and therefore gives the highest side lobes. The 
time domain window value is 0.20. The rise time equation coefficient value is 0.54. 

• Custom allows you to create your own time domain window. Set the time domain window 
value (range 0.000 to 1.000) by selecting the spinner or entering a value in the box.

NOTE When you open measurement data in time domain format, the previously 
selected windowing is used. To change the windowing selection, select Time 
Domain Window… from the Tool menu, which displays the Time Domain 
Window dialog box. Make your windowing selection from the dialog box and 
click OK. The new windowing choice is then applied to the data.
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Response Resolution

The response resolution describes how close in time two responses can be distinguished. This 
depends on the width of the impulse response, which is inversely related to the measurement 
bandwidth. The relationship between the three is approximately R = T = 1.25/BW; where R is 
the response resolution in picoseconds, T is the effective impulse width in picoseconds, and 
BW is the frequency span in GHz.

Range Resolution

As described previously in “Analyzing Time-Domain Signatures” on page 151, the TDR 
signature provides specific circuit detail. Range resolution (TD span/Number of points, or 
Stop-Start/Number of points) will define how accurately the signature of a response can be 
identified. In general, a wider measurement bandwidth will provide finer spatial resolution.

To improve range resolution, zoom in on the section of interest and adjust the start- and 
stop-points to be as narrow as possible without compromising the agreement in the frequency 
domain.

Spatial Resolution

When measuring short electrical devices, matching the spatial resolution to the minimum 
discontinuity distance is critical. 

Impulse Response (IR) is the waveform that results at the output of a device when the input is 
excited by a unit impulse. As the maximum measurement frequency of a VNA increases, the 
pulse-width of the IR gets narrower. The pulse-width of the IR must be narrower than the two 
adjacent discontinuities in order to properly characterize the discontinuities in the time 
domain.

To illustrate this, assume we are measuring a device that has two discontinuities that are 
1 cm apart and the expected response in the time-domain is as pictured in Figure 5-4.

Figure 5-4 Expected Response for Two Discontinuities 1 cm Apart
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If the IR has a spatial resolution is greater than 1 cm and is swept across the DUT as shown 
in Figure 5-5, the response in the time domain is dramatically different than what is 
expected. It looks like the picture on the right side of the illustration because the IR is larger 
than the two adjacent discontinuities, and the power levels from the multiple discontinuities 
are being added together. 

Figure 5-5 Example 1: Displayed Response

Figure 5-6 shows the same device using an IR with a pulse-width that is less than 1 cm. The 
response you see in the time domain is much more like what is expected. It looks like the 
picture on the right side of the illustration. This is because the IR is narrower than the two 
adjacent discontinuities, and the IR is able to capture only the power level of the individual 
discontinuities. 

Figure 5-6 Example 2: Displayed Response

Understanding the spatial resolution requirements of a device is extremely important as 
devices become shorter in length.

An increased number of points can help provide some additional resolution to data, but will 
never make up for using a system with insufficient spatial resolution. Figure 5-7 shows the 
same device but measured with the number of points set at 900 and at 4500. While there is 
some improvement, the improvement is not significantly better.
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Figure 5-7 Sampling Resolution: 900 Points Versus 4500 Points

The idea to remember is that the spatial resolution of the PLTS system must be a narrower 
length than the expected minimum length of any adjacent discontinuities on the device.

Automated Start and Stop Settings In Time Domain

For Measurements Made in the Frequency Domain Only

When a measurement is made in the frequency domain and is converted to the time domain, 
the time domain start and stop frequencies can be ambiguous. This describes the algorithm 
for displaying the start and stop frequencies using the PLTS automated process.

This algorithm is best described using a flow diagram (see Figure 5-8) and a few real life 
examples of this process. 

Example 5-1 Standard Transmission Measurement

Parameter = SDD21 (Transmission) 

Location of the SDD21 Peak Value in Time Domain = 2 ns

At Point 1, 

Tstart = 0 ns

Tstop = 8 ns

The result is:

Tstart = 0 ns

Tstop = 8 ns
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Figure 5-8 Automated Start and Stop Algorithm Flow Diagram
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Also using Figure 5-8, you can follow these examples:

Example 5-2 Standard Reflection Measurement

Parameter = SDD11 (Reflection) 

Location of the SDD21 Peak Value in Time Domain = 2 ns

At Point 1, 

Tstart = −1 ns

Tstop = 4 + 1 = 9 ns

The result is:

Tstart = −1 ns

Tstop = 4 + 1 = 9 ns

Example 5-3 Potential Limitation of the Algorithm

Parameter = SDD11 (Reflection) 

Location of the SDD21 Peak Value in Time Domain = 5 ns

At Point 1, 

Tstart = −2.5 ns

Tstop = 20 + 2.5 = 22.5 ns (greater than maximum time base of 10 ns)

At Point 2, 

Tstart = −2.5 ns

Tstop = 10 − 2.5 = 7.5 ns

The result is:

Tstart = −2.5 ns

Tstop = 7.5 ns

Comments: The results in the start and stop calculations are not suitable to 
resolve the SDD21 with a 5 ns measurement. This is because the stop 
time is 7.5 ns while the device needs 10 ns for the two-way travel of in 
reflection. The system is capable of resolving 10 ns, however, due to 
the current calculation of the -2.5 ns start time, an artificial 
limitation has been imposed. This can be worked around by manually 
changing the start and stop in the gating mode.
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Example 9-4 No Transmission Data

Parameter = SDD11 (Any parameter) 

Location of the SDD21 Peak Value in Time Domain = 0 ns

At Point 1, 

Tstart = 0 ns

Tstop = 0 ns

At Point 3, 

Tstart = −1 ns

Tstop = 1 ns

The result is:

Tstart = −1 ns

Tstop = 1 ns

Comments: Due to the absence of a strong signal in SDD21, the algorithm 
defaults to start of −1.0 ns and stop of 1.0 ns. This can be 
worked around by manually changing the start and stop in the 
gating mode.
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Uncoupled Start Frequency and Step Frequency Setting

The Uncouple Start Frequency and Step Frequency selection is available in the Calibrate 
Hardware for Measurement dialog box for the VNA-based measurement setup when the 
Advanced button has been selected. Normally, the Frequency Step setting is locked (or 
coupled) to the Frequency Start setting.

However, there are situations that you may want to uncouple the Frequency Step setting 
from the Frequency Start setting. For example, uncouple the Frequency Step setting from 
the Frequency Start setting if you want to measure more points for better measurement 
resolution or you may want to measure specific frequency points that would not ordinarily be 
measured. 

When measured data from this uncoupled start frequency/step frequency measurement is 
converted to the Time Domain analysis type, conversion rules that change the data must be 
applied to ensure the data is displayed correctly. See “Uncouple Start Frequency and Step 
Frequency” on page 11 for additional information regarding each of these conversion rules.

When these conversion rules change the measured data to be displayed in the Time Domain 
analysis type, one of three icons is displayed in the lower right corner of the plot to notify you 
of the change. These icons are displayed in Table 5-4.

Table 5-4 Time Domain/Eye Diagram Uncoupled Start Frequency/Step Frequency Icons

Icon Icon Name

Resampled Data - This icon indicates that only the harmonically-related 
data points were used to generate time domain data.

Interpolated Data - This icon indicates interpolation is performed to 
calculate the harmonically-related points that were not measured. Any 
measurements that were performed at harmonically-related points are left 
unchanged. The interpolated data is used, along with the measured 
harmonically-related data, to perform the Inverse Fast Fourier Transform 
(IFFT) for the calculated time domain data.

Bad Data − This icon indicates there are less than 10 harmonically-related 
data points in the measured data. In this case, all of the non 
harmonically-related data is used to perform the Inverse Fast Fourier 
Transform (IFFT) to calculate time domain data. This may result in 
inaccurate time domain data. 
Chapter 5166



Analyzing Data in the Time Domain
Checking the Validity of a Time-Domain Calculation
Checking the Validity of a Time-Domain Calculation
There are a number of practical considerations in examining time domain data, as described 
previously. Therefore, it is very important to have a method of validating the data. This can be 
accomplished by comparing the original frequency domain data to the data after it is inverse 
Fourier transformed into the time domain, and then Fourier transformed back into the 
frequency domain, as shown in Figure 5-9. Ideally, these data should be identical. Changing 
the time domain start- and stop-points, the filter value, and the value of the DC parameter 
may improve the agreement.

Figure 5-9 Time Domain Data Validation Model
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Viewing Data in the Time Domain
This section guides you with opening measured data in the time domain and viewing the data 
in the way that best suits your requirements. There are 16 parameter plots for both 
single-ended and balanced devices. You may elect to view any number of these plots.

Opening a Time Domain Plot Window

The time domain may be viewed in either balanced or single-ended mode. You may open the 
time domain plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 5-10

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 5-10

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 5-10

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Time Domain choices - see (B) of Figure 5-10

NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the Data menu 
when the blank plot window is displayed.

Figure 5-10 Opening the Time Domain Plot Window
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Viewing All 16 Parameters

In all cases, except when you open the plot window using the Browser, all 16 time domain 
parameter plots are displayed. Each of the plots are labeled at the top with their parameter. 
See Figure 5-11.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all 16 plots by selecting All from the Parameter Bar or from the 
Data menu with New Plot selected.

Figure 5-11 All 16 Differential Time Domain Plots 
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Viewing a Single Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
16 plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 5-12. 

Figure 5-12 Opening a Single Plot

Double-click on the single plot to return back to the original view with multiple plots.
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View Multiple Traces on a Single Plot

This single plot may have just one parameter or if you choose, it could contain up to four 
parameters. For example, you could show how TDD21 compares with TCC21. To do this 
double-click on the first plot so that is now displaying a single plot similar to Figure 5-12. For 
this example, TDD21 was double-clicked and is displayed as a single plot. With New Trace 
selected in the Parameter Bar (or the Data menu), click the remaining parameters (TCC21 
in this example). 

Figure 5-13 A Single Plot with Multiple Traces

It could contain as many as 4 of the parameters. All trace parameters are labeled at the right 
edge of the plot. The color of the trace labels are the same color as the traces they represent. 
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Creating a Custom Time Domain Plots Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four TDDxx plots. To create this custom window, open the 
measured data file in any analysis type. Then, in the Browser, select the data type that you 
want to display the plots. In this example, select Time Domain (Balanced). A blank plots 
window is displayed. With New Plot selected in the Parameter Bar (or the Data menu), 
click the desired parameters (TDD11, TDD12, TDD21, and TDD22 in this example). As each 
parameter is selected, the new plot is added to the plots window. See Figure 5-14.

Figure 5-14 Custom Time Domain Plots Window with Four Plots
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Optimizing the Time Domain Time Scale for Viewing
The Time Domain Start and Stop Time dialog box allows you to change and view the start 
times and stop times of time domain plots three ways.

NOTE The feature is used only for frequency domain S-parameter files that are 
calculated to show time domain. If your measurement was taken using a TDR, 
this feature does not apply. 

From the Tools menu, select Time Domain Start and Stop Time… to open the Time 
Domain Start and Stop Time dialog box. 

Figure 5-15 Opening the Time Domain Start and Stop Time Dialog Box
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NOTE While most dialog boxes will not allow you to work between them and the main 
PLTS window, the Time Domain Start and Stop Time dialog box will allow you 
to make changes and then go to the main PLTS window to see the change 
without closing the dialog box.

The Time Domain Start and Stop Time dialog box is displayed with either Auto Optimize 
Off or Auto Optimize On selected. The state depends on the Always optimize the Start 
and Stop Times when calculating the time domain data from frequency domain 
data selection in User Preferences dialog box dictates whether the Auto Optimize feature is 
turned on or off when the calculations are made from frequency domain to time domain. See 
Figure 5-16. Refer to “User Preferences” under the “Options Menu” section in the “Menu 
Reference” chapter of the PLTS Installation and Reference Guide for additional information.

Figure 5-16 User Preferences Dialog Box Determines if Auto Optimize is On

If Auto Optimize Off is selected, the time domain data is not optimized in any parameter for 
viewing and the start time and the stop time is set to show the full time range of the 
measurement. Often, no usable information is displayed over much of the time.

If Auto Optimize On is selected, the time domain data is optimized in all parameters for 
viewing and the start time and stop time are changed to show the time domain time range 
such that there is not a lot of unusable information displayed. 
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Changing the Start Time and Stop Time Manually

When Manual is selected, you can change as many parameters that you like to the start and 
stop time values that you choose. When Manual is selected, all differential and single-ended 
time domain parameters are placed in the list at the left, the Available Parameter List. 
Move the parameters that have a start or stop time that you would like to change to the right 
list at the right, the Selected Parameter List. Move the parameters using the eight Move 
Parameters Buttons located between the two lists. A description of each of these buttons is 
located below.

Figure 5-17 Time Domain Start and Stop Time Dialog Box in Manual Mode

Button 
Label

Description

> Moves the highlighted parameters in the available parameters list to the 
right into the selected parameters list

< Moves the highlighted parameters in the selected parameters list to the left 
into the available parameters list

>> Moves all parameters in the available parameters list to the right into the 
selected parameters list

<< Moves all parameters in the selected parameters list to the left into the 
available parameters list
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For example, to change the start and stop time of the single-ended TDR parameter plots, you 
must move the parameters to the Selected Parameter List. See Figure 5-18.

Figure 5-18 Moving the Single-Ended TDR Parameters

Diff TDR > Moves all differential TDR parameters in the available parameters list to the 
right into the selected parameters list. The different TDR parameters are: 
TCC11, TCC22, TCD11, TCD22, TDC11, TDC22, TDD11, and TDD22.

SE TDR > Moves all single-ended TDR parameters in the available parameters list to 
the right into the selected parameters list. The single-ended TDR parameters 
are: T11, T22, T33, and T44.

Diff TDT > Moves all differential TDT parameters in the available parameters list to the 
right into the selected parameters list. The different TDT parameters are: 
TCC12, TCC21, TCD12, TCD21, TDC12, TDC21, TDD12, and TDD21.

SE TDT > Moves all single-ended TDT parameters in the available parameters list to 
the right into the selected parameters list. The single-ended TDT parameters 
are: T12, T13, T14, T21, T23, T24, T31, T32, T34, T41, T42, and T43.

Button 
Label

Description
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Once the parameters are listed in the Selected Parameter List, change the Start Time and 
the Stop Time using the Start Time and the Stop Time text entry boxes. See Figure 5-19.

Figure 5-19 Changing the Start Time and Stop Time

The times can be changed two ways:

1. By typing in a new value for one or both of the times and then clicking the Apply button.

2. By dragging over the value to change with the mouse, and clicking the spinner to the new 
value. This method changes the value with clicking the Apply button.

NOTE The spinners in the method are unique. They increment or decrement only the 
most significant digit that was highlighted with the mouse. For example, the 
Stop Time in Figure 5-19 is 5.34 ns. If you highlight the entire “5.34” value or 
just the “5”, clicking the up spinner increments the “5”. However, if you 
highlight the “34” or only the “3”, clicking the up spinner increments the “3”.
Chapter 5 177



Analyzing Data in the Time Domain
Selecting Time Domain Display Formats
Selecting Time Domain Display Formats
A data format is the way the physical layer test system presents the measurement 
graphically. Select a data format appropriate to the information you want to learn about the 
device. You may use either the Format Bar or the Format menu to select the format.

Figure 5-20 Format Menu and Format Bar for Time Domain

Time Domain Format Bar

Stimulus - Type of the input to the DUT
Impulse inputs an impulse waveform as the stimulus. 

Step inputs a step waveform as the stimulus. This is the default 
format.

Vertical Format - Units used on the vertical axis
Volts selects volts as the vertical unit of measure. This is the default 

format.
Real displays only the real (resistive) portion of the measured 

complex data. Real can show both positive and negative values. 
This is the default format.

Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. 
Typical measurements are return loss and gain. 

Impedance selects ohms as the vertical unit of measure. This choice is active 
only for reflection plots with a Step stimulus. 
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NOTE When opening measured DUT files in Time Domain to view in the Time format

1. Go into the time domain/distance format and set your velocity factor 
accordingly (Example: Air VF=1.000, Surface traces VF=0.53146, Buried 
traces in a dielectric constant (εr) ~ 4.3: VF=0.48795).

2. Select to view data in time, and then switch to view data in distance.

This triggers the correct computations to take place and you will now be able to 
set markers and measure device lengths and discontinuities accurately.

Horizontal Format - Units used on the horizontal axis
ns selects time units (in nanoseconds) for the horizontal format. 

This is the default format.
cm selects distance units (in centimeters) for the horizontal format.

Time Domain Format Bar
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Setting the Scale
The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 5-21 Time Domain Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 5-22.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 5-22.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 5-22. The scaling calculator icon varies slightly between scaling 
entries meet the requirements of the specific entry.

Figure 5-22 Entering a Scale Value

The horizontal scale is changed by changing the start and stop frequencies in megahertz 
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(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
frequencies used in the measurement. 

The horizontal scale units are either nanoseconds (ns) or centimeters (cm) depending on the 
Format Bar or Format menu selection. 

NOTE When the horizontal units per division is changed, the Delay value is reset to 
zero.

The vertical scale is either volts, units, ohms, or decibels depending on the Format Bar or 
Format menu selection. The vertical scale selections are:

Quick Scale Features

PLTS has three features that make scaling changes quickly and easily. The three features are:

• Autoscale

• Reset Scale

• Copy Plot Format used with Paste Plot Format (see “Copying and Pasting Plot 
Formats” on page 320)

Autoscale

Autoscale changes the vertical scale of the active plot to allow the trace to occupy 
approximately 80% of the vertical axis of the display. It places the display such that the 
graticule values are numbers that are easy to work with.

To autoscale a plot, select the plot, then right click on the plot to display the quick menu. See 
Figure 5-23. Click Autoscale to change the vertical scale of the plot. The figure shows a time 
domain plot that has Autoscale applied to it.

Volts selects volts as the vertical unit of measure.
Real displays only the real (resistive) portion of the measured complex data. Real 

can show both positive and negative values. This is the default format.
Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. Typical 

measurements are return loss and gain. 
Impedance selects ohms as the vertical unit of measure. This choice is active only for 

reflection plots with a Step stimulus.
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Figure 5-23 Autoscale

Reset Scale

Reset Scale resets the vertical and horizontal scale of the active plot to the default settings. 
This is useful when you are adjusting the scale and the trace is moved off screen and can no 
longer be seen.

To reset the scale of a plot, select the plot, then right click on the plot to display the quick 
menu displayed in Figure 5-24. Click Reset Scale to reset the plot to the default settings.

Figure 5-24 Reset Scale
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Gating
Gating provides the ability to remove the effect of a particular circuit element 
mathematically from time-domain plots. The gated section removes a section of the plot that 
you define, replacing it with an ideal transmission line having the same electrical delay as the 
removed section. By observing the original frequency domain response and the transformed 
frequency domain response, the effect of the gating operation on the S-parameter data can be 
seen. For detailed information on gating, refer to “Gating” on page 276.
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Analyzing Data using Eye Diagrams
The physical layer test system software constructs measurement-based eye diagrams (or 
patterns) by convolving the calculated time domain impulse response (generated from 
frequency domain measurement data) with a simulated pattern of bit sequences. Refer to 
Figure 6-1 for a simplified block diagram of the eye diagram creation process.

Figure 6-1 Eye Diagram Process Simplified Block Diagram

With eye diagrams you can see signal quality with one display, you can diagnose problems, 
such as attenuation, noise, jitter, and dispersion that arise or characterize specific parts of the 
system. You can then view the measurement in the Time Domain mode to help isolate the 
source of the problem.

The software allows you to specify a simulated bit pattern (sequence) of between 8 and 32 bits 
that is convolved with the calculated time domain data to generate the eye diagram. You may 
select from three simulated bit patterns types: 1) a pre-defined bit pattern, 2) a bit pattern 
that you have defined, or 3) an arbitrary bit stream (a random-like bit pattern).
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The Eye Diagram
The eye diagram shown in Figure 6-2 identifies key eye diagram definitions. These definitions 
are listed below this illustration. The eye diagram of the TCC21 parameter shown in Figure 
6-2 was created using the BTL.dut file located in the PLTS data folder. An Arbitrary 
Bitstream bit pattern with the following settings was also used: 

Figure 6-2 The Eye Diagram

Rise/Fall Time = 0 ps Data Rate = 2.5 Gb/s
Pattern Length = 32 bits Number of Patterns = 12

1 Zero Level Zero Level is a measure of the mean value of the logical 0 of an 
eye diagram. 

2 One Level One Level is a measure of the mean value of the logical 1 of an 
eye diagram. 
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3 Rise Time Rise time is a measure of the transition time of the data from 
the 10% level to the 90% level on the upward slope of an eye 
diagram. 

4 Fall Time Fall time is a measure of the transition time of the data from 
the 90% level to the 10% level on the downward slope of an eye 
diagram. 

5 Eye Height Eye height is a measure of the vertical opening of an eye 
diagram. An ideal eye opening would be measured from the 
one level to the zero level. However, noise on the eye will cause 
the eye to close. The eye height measurement determines eye 
closure due to noise.

6 Eye Width Eye width is a measure of the horizontal opening of an eye 
diagram. Ideally, the eye width would be measured between 
the crossing points of the eye. However, jitter may appear on 
the waveform and influence the eye opening. 

7 Deterministic 
Jitter

Deterministic jitter is the deviation of a transition from its 
ideal time caused by reflections relative to other transitions.

8 Eye Amplitude Eye amplitude is the difference between the logic 1 level and 
the logic 0 level histogram mean values of an eye diagram. 

9 Bit Rate Bit rate (data rate) is the inverse of bit period (1 / bit period). 
The bit period is a measure of the horizontal opening of an eye 
diagram at the crossing points of the eye. 
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Time Domain Windowing

The PLTS software has a feature called Time Domain Windowing that is designed to enhance 
Time Domain measurements. The need for windowing is due to the abrupt transitions in the 
Frequency Domain measurement at the Start and Stop frequencies. This band limiting of the 
frequency domain response causes overshoot and ringing in the Time Domain response. It 
causes the un-Windowed Impulse stimulus to have a sin (kt)/kt shape (k=π/frequency span), 
which has two effects that limit the usefulness of the Time Domain measurement:

• Finite Impulse Width limits the ability to resolve between two closely spaced responses. 
The effects of the finite impulse width cannot be improved with increasing the frequency 
span of the measurement.

• Impulse side lobes limit the dynamic range of the Time Domain measurement by hiding 
low-level response within the side lobes of the higher-level responses. The effects of side 
lobes can be improved by windowing.

Windowing improves the dynamic range of the Time Domain measurement by modifying 
(filtering) the Frequency Domain data prior to conversion to the Time Domain to produce an 
impulse stimulus with lower side lobes. This greatly enhances the effectiveness in viewing 
Time Domain responses that are very different in magnitude. The side lobe reduction is 
achieved, however, as the tradeoff with increased impulse width. The effect of windowing on 
eye diagrams is a reduction of overshoot and ringing while the tradeoff is increased rise time.

PLTS defines three window selections: Flat Response, Nominal, and Fast Rise Time. Each 
of these selections has an associated Time Domain Window Value. The side lobe levels of the 
Time Domain stimulus depend only on the window that is selected. Figure 6-3 shows the same 
eye diagram that was displayed in Figure 6-2 with each of the three window settings.

PLTS also allows you to define your own window using the Custom selection where you will 
set you own Time Domain Window Value.

The purpose of windowing is to make the Time Domain response more useful in isolating and 
identifying individual responses. The window does not affect the displayed Frequency Domain 
response. The Time Domain function is only applied to time domain data. It does not affect 
frequency domain data.
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Figure 6-3 The Effect of the Time Domain Windowing Selection

The following formula can be used to determine the equivalent 10 percent to 90 percent 
system rise time for the step function transformation and the eye diagram simulation:

 Tr = (1000 / Fmax) × RTEC

Where, Tr = Rise time of the step response form 10% to 90% (in picoseconds)

 1000 = Factor to convert frequency to picoseconds

 Fmax = Maximum stop frequency used in the measurement (in GHz)

 RTEC = Rise time equation coefficient

As an example: System rise time = 27 ps = (1000/ 20 GHz) × 0.54 (see table below)
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Table 6-1 shows the equivalent rise times for a maximum frequency of 20 GHz for each 
window setting.

By increasing or decreasing the filter value above or below the default, a trade-off can be 
made between rise time and side-lobe level (dynamic range). 

When Time Domain Window… is selected from the Tool menu, the Time Domain Window 
dialog box is displayed allowing a choice of the three Time Domain Window settings. 

Figure 6-4 Time Domain Window Dialog Box

• Flat Response gives the minimum side lobes and this provides the greatest dynamic 
range. The time domain window value is 0.80. The rise time equation coefficient value 
is 0.91.

• Nominal gives reduced side lobes and is normally the most useful. The time domain 
window value is 0.50. The rise time equation coefficient value is 0.71. This is the default 
setting.

• Fast Rise Time is essentially no window and therefore gives the highest side lobes. The 

Table 6-1 Equivalent Rise Times for a Maximum Frequency of a 20 GHz System

Window Selection TD Window 
Valuea

a. The relationship between the TD window value and the rise time equation coefficient is not 
made available.

Maximum 
Frequency

(Fmax)

 Rise Time Equation 
Coefficient 

(RTEC)

Equivalent 
Rise Time 

(Tr)

Flat Response 0.80 20 GHz 0.91 45.5 ps

Nominal 0.50 20 GHz 0.71 35.5 ps

Fast Rise Time 0.20 20 GHz 0.54 27 ps
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time domain window value is 0.20. The rise time equation coefficient value is 0.54. 

• Custom allows you to create your own time domain window. Set the time domain window 
value (range 0.000 to 1.000) by selecting the spinner or entering a value in the box.

NOTE When you open measurement data in time domain format, the previously 
selected windowing is used. To change the windowing selection, select Time 
Domain Window… from the Tool menu, which displays the Time Domain 
Window dialog box. Make your windowing selection from the dialog box and 
click OK. The new windowing choice is then applied to the data.
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Uncoupled Start Frequency and Step Frequency Setting

The Uncouple Start Frequency and Step Frequency selection is available in the Calibrate 
Hardware for Measurement dialog box for the VNA-based measurement setup when the 
Advanced button has been selected. Normally, the Frequency Step setting is locked (or 
coupled) to the Frequency Start setting.

However, there are situations that you may want to uncouple the Frequency Step setting 
from the Frequency Start setting. For example, uncouple the Frequency Step setting from 
the Frequency Start setting if you want to measure more points for better measurement 
resolution or you may want to measure specific frequency points that would not ordinarily be 
measured. 

When measured data from this uncoupled start frequency/step frequency measurement is 
converted to the Eye Diagram analysis type, conversion rules that change the data must be 
applied to ensure the data is displayed correctly. See “Uncouple Start Frequency and Step 
Frequency” on page 11 for additional information regarding each of these conversion rules.

When these conversion rules change the measured data to be displayed in the Eye Diagram 
analysis type, one of three icons is displayed in the lower right corner of the plot to notify you 
of the change. These icons are displayed in Table 6-2.

Table 6-2 Time Domain/Eye Diagram Uncoupled Start Frequency/Step Frequency Icons

Icon Icon Name

Resampled Data - This icon indicates that only the harmonically-related 
data points were used to generate time domain data.

Interpolated Data - This icon indicates interpolation is performed to 
calculate the harmonically-related points that were not measured. Any 
measurements that were performed at harmonically-related points are left 
unchanged. The interpolated data is used, along with the measured 
harmonically-related data, to perform the Inverse Fast Fourier Transform 
(IFFT) for the calculated time domain data.

Bad Data − This icon indicates there are less than 10 harmonically-related 
data points in the measured data. In this case, all of the non 
harmonically-related data is used to perform the Inverse Fast Fourier 
Transform (IFFT) to calculate time domain data. This may result in 
inaccurate time domain data. 
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Designing a Bit Pattern for Eye Diagrams
The Bit Pattern feature in the Tools menu allows you to design a digital bit pattern and to 
apply a bit pattern that has been saved to eye diagram plots. Only the industry standard 
K 28.5 bit pattern has been created and included in the software. However, the PLTS software 
allows you to create bit patterns, from 8 to 32 bits very easily.

Figure 6-5 Tools Menu with Bit Pattern Expanded

1. Select Bit Pattern then Design… from the Tools menu to open the Digital Pattern 
Generator dialog box shown in Figure 6-6.

Figure 6-6 Digital Pattern Generator
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2. Click on the “0” key as shown in Figure 6-7.

Figure 6-7 Selecting the “0” Piano Key

3. Select the remaining even-numbered piano keys so that you have a series of alternating 
bits as shown in Figure 6-8.

Figure 6-8 Digital Pattern Generator with a 32-Bit Pattern

Note the alternating bits going high (turning on) and the alternating 1’s and 0’s in the 
Numeric Representation area.

1. Selecting the “0” key (piano key) in the Bit Representation area:

A. Causes Bit 0 to go high (turn on)

B. Generates a “1” in the first digit of the binary numeric representation
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4. Enter values in the Rise/Fall Time and the Data Rate boxes. Rise/Fall Time is entered 
in picoseconds (ps) and Data Rate is entered in Gigabits per second (Gb/s). See Figure 6-9 
and Figure 6-10.

Figure 6-9 Rise/Fall Time and Data Rate

5. Check the value in the Pattern Length (bits) box. The default value is 32. The allowable 
range is between 8 and 32 bits. You may change this if your pattern contains fewer bits. If 
this value is changed to a value less than 32, any remaining bits are ignored. For example 
if you enter 10 as the pattern length value, then bits 0 through 9 are used and bits 10 
through 31 are ignored.

6. Enter a name for the digital pattern in the Save Pattern box. In this example, 
Alternating Bits is entered. Click the OK button to save the pattern to be used later. 
See Figure 6-10.

Figure 6-10 Save the Digital Pattern
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Viewing Data using Eye Diagrams
This section guides you with opening measured data in the eye diagram plot mode and 
viewing the data in the way that best suits your requirements. There are 8 output plots for 
balanced mode and 12 output plots for single-ended mode. Only transmission paths are 
displayed; no reflection paths are displayed.

Opening a Eye Diagram Plot Window

The eye diagram may be viewed in either balanced or single-ended mode. You may open the 
eye diagram plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 6-11

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 6-11

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 6-11

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Eye Diagram choices - see (B) of Figure 6-11

Figure 6-11 Opening the Eye Diagram Plot Window
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NOTE When using the Browser method to open a window, first select the bit pattern 
to use with the data (described in the rest of this section), then select the 
parameters that you want to view from the Parameter Bar or the Data menu 
once the blank plot window is displayed.

The Choose a Digital Pattern for Eye Generation dialog box is then displayed (see Figure 6-12). 
You may select a digital pattern to apply from the list of digital patterns. The software is 
shipped with the PRBS (the Pseudo-Random Bit Sequence) selection, the K 28.5 selection (an 
industry standard), and the Arbitrary Bitstream selection (a random-like bit stream). Any 
bit patterns that you have created and saved using the process described in Designing a Bit 
Pattern for Eye Diagrams beginning on page  194 are also displayed in the Choose a Digital 
Pattern for Eye Generation dialog box. 

Figure 6-12 Choose a Digital Pattern Dialog Box

NOTE If the bit pattern has already been selected for the data, the Choose a Digital 
Pattern for Eye Generation dialog box is not displayed and the data will is 
displayed using that bit pattern information. To change the bit pattern, select 
Bit Pattern then Apply… from the Tools menu to display the dialog box 
shown in Figure 6-12. Then, select the desired bit pattern from the list on the 
left, enter the desired information (Rise/Fall Time, Data Rate, Pattern Length, 
and Number of Patterns) as described below, and click OK. Then, delete the 
current plot window and reopen a new plot window using the same data. The 
new bit pattern is then applied.

After clicking a digital pattern in the Choose a Digital Pattern for Eye Generation dialog box 
list, review the digital pattern parameter entries on the right side of the dialog box and enter 
the desired parameter values.
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• Rise/Fall Time (pS) is the time that it takes a signal to transition from a low to a high 
(10% to 90%) condition (or the time that it takes a signal to transition from a high to a low 
(90% to 10%) condition).

• Data Rate (Gb/S) is the speed that data is transferred over a circuit or a communications 
line. 

• Pattern Length (bits) is the number of bits in the digital pattern used to create the eye 
diagram. This value is the limiting factor in creating unique digital patterns. The value of 
the Pattern Length may be changed for PRBS and ABS. Other defined bit patterns have 
the Pattern Length defined as part of the pattern and may not be changed except by 
changing the bit pattern definition. Refer to Table 6-3 for the pattern lengths allowed for 
PRBS and ABS. 

Then, click OK to view the eye diagram in the plot window. Cancel closes the dialog box 
without making any changes.

IMPORTANT Arbitrary Bitstream

Though Arbitrary Bitstream (ABS) is a random-like bit stream used to 
generate eye diagrams, it is different than the Pseudo-Random Binary 
Sequence (PRBS) standard. The ABS pattern was defined to provide a large 
random pattern of bits that would quickly converge the eye diagram to show 
worst case tolerances. 

ABS develops a random sequence of bits for the virtual pattern generator using 
the Pattern Length entry. Pattern Length is entered to define the number of 
bits within a specific pattern.

Table 6-3 PRBS and ABS Pattern Length Selections and Number of Bits

PRBS Pattern Length Selections ABS Pattern Length Selections

Selection  Number of Bits Selection  Number of Bits

2^5-1  (31 bits) - - - -

2^7-1  (127 bits) 2^7  (128 − 2 = 126 bits)

2^9-1  (511 bits) 2^9  (512 − 2 = 510 bits)

2^10-1  (1023 bits) 2^10  (1024 − 2 = 1022 bits)

2^11-1  (2047 bits) 2^11  (2048 − 2 = 2046 bits)

2^13-1  (8191 bits) 2^13  (8192 − 2 = 8190 bits)

2^15-1  (32767 bits) 2^15  (32768 − 2 = 32766 bits)
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If the Pattern Length = 2^7 bits, there are 128 unique patterns available if you 
count in binary from 0 to 127.

0000000
0000001
0000010
.
.
.
1111101
1111110
1111111

ABS then removes patterns 0000000 and 1111111 as invalid patterns so that 
you now have a total of 2Pattern Length − 2 = 27 − 2 = 126 unique patterns to 
choose from. Then ABS uses a random number generator to choose the first 
pattern to put into the virtual pattern generator and continues to pick new 
random patterns up to the number of patterns that you have defined within the 
interface (maximum is 126).

Using both of these values, a random number generator selects unique bit 
patterns until the appropriate number of patterns are identified. Each of these 
unique bit patterns are then used to create the eye diagram, one bit pattern at 
a time. 

As the eye diagram is created, the Eye Status box is displayed. This box shows 
the status of the eye diagrams as they are being generated. When a parameter 
is complete, it is grayed. When all parameters are complete, this box is removed 
and the plots are complete. You can cancel a parameter by selecting the Cancel 
button for that plot. Selecting all Cancel buttons that have not been grayed 
ends the generation of the eye diagram
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Viewing All Parameters

In all cases, except when you open the plot window using the Browser, all eye diagram 
parameter plots are displayed. There are four parameter plots for differential measurements 
and 12 parameter plots for single-ended measurements. Each of the plots are labeled. The bit 
map information used to create the eye diagram is displayed above the plot as shown in the 
inset of Figure 6-13.

As noted above, when you open the plot window from the Browser, an empty plot window is 
displayed. View all plots by selecting All from the Parameter Bar or from the Data menu.

Figure 6-13 Balanced Eye Diagram Plots with Informational Label
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Viewing a Single Eye Diagram

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
plots (or with multiple plots if you have a custom plot window displayed), double-click on the 
plot that you would like to view. See Figure 6-14. 

Figure 6-14 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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Creating a Custom Eye Diagram Plots Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the two TDDxx plots. To create this custom window, open the 
measured data file in any analysis type. Then, in the Browser, select the data type that you 
want to display the plots. In this example, select Eye Diagram (Differential). A blank plots 
window is displayed. From the Parameter Bar (or the Data menu), click the desired 
parameters (TDD12 and TDD21 in this example). As each parameter is selected, a new plot is 
added to the plots window. See Figure 6-15.

Figure 6-15 Custom Eye Diagram Plots Window with Two Plots
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Analyzing Transmission Line Parameters
There are four modes in which RLCG parameters may be displayed in PLTS: 

• Differential
• Common
• W-Element
• Self/Mutual

PLTS exports RLCG data in the W-Element mode for use by HSPICE or Advanced Design 
System (ADS - an integrated design software and test instrumentation solution from Agilent 
Technologies). The W-Element mode uses the 4-port S-parameters of the symmetrical, coupled 
transmission line to compute the R (resistance), L (inductance), C (capacitance), and G 
(conductance) parameters. Each is displayed in a 2-by-2 matrix. There is an R-value for each 
line and coupling values for R. The same is true for L, C, and G. These parameters can then be 
used in HSPICE or ADS as a model of the measured transmission line.

There are two modes, Differential and Common, of the RLCG parameters that treat the 
coupled line as a 2-port device instead of a 4-port device. These modes simply use the four 
pure differential-mode parameters or four pure common-mode parameters as a 2-port 
S-parameter device. This is saying we have a line driven differentially (or in common) and 
what are the RLCG parameters, impedance, and propagation constant for this line. In this 
case, the RLCG parameters are a single value, not a 2-by-2 array. There is no self or coupling 
since it is treated as a single line. Neither of these modes is directly usable in HSPICE or ADS 
but these modes can give insight to an experienced user.

The fourth mode is the Self/Mutual mode. It is a slight deviation from the W-Element mode. 
The only difference in this mode is the way that the coupling between parameters is defined. 
The conversion is described in “CPTL RLCG Extraction Procedure” on page 214.

An important issue that is not clearly understood is that the measurements must be for only 
the line to be modeled. Connectors and single-ended launches to connect to the actual coupled 
line must be removed using de-embedding or calibration standards in the medial. The 
simplest way to measure coupled lines is by probing the lines. When the lines are probed, no 
connectors or launches need be removed. 

NOTE When extracting the RLCG parameters for a symmetrical coupled line, the 
measurement must include only the coupled transmission line. It should not 
include any connectors, or single-ended launches in the measurement. If any of 
these are included, the parameters will not accurately model the transmission 
line. Refer to “Considerations When Extracting RLCG Parameters” on page 222 
for more information. Note that Figure 7-11 shows the connector and launches 
that need to be removed.
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Transmission lines are distributed devices. However, SPICE type simulators work with 
lumped elements, not distributed elements. To approximate the distributed behavior of a 
transmission line, RLCG type models are commonly used. The single transmission line shown 
in Figure 7-1 can be modeled by a network consisting of a series resistance and inductance 
with parallel capacitance and conductance.

Figure 7-1 RLCG Model for Single Transmission Line

The different terms included in the model describe the following physical phenomena:

R − Resistive loss of the conductor (transmission line trace). Determined by the 
conductance of the metal, width, height, and length of the conductor.

L − Inductive part of the circuit resulting from the layout of the conductors. Determined 
by the dimensions of the conductor, permeability of the metal, and layout.

C − Capacitive part of the circuit resulting from the layout of the conductors. Determined 
by the permittivity and thickness of the board material and the area of the conductor.

G − Shunt loss of the dielectric. Determined by the layout of the conductors, permittivity, 
loss tangent and thickness of the board material.
Chapter 7 207



Analyzing Transmission Line Parameters
Transmission Line Parameters
RLCG modes are frequency-based models. See Figure 7-2.

Figure 7-2 Copper Loss (R) and Dielectric Loss (G)

Equation Set 1 describes the most adopted frequency dependencies of RLCG parameters.

NOTE These parameters are called fitted parameters.

The values for RLCG are typically specified in per unit length, where the unit of length is in 
meters. Therefore for a given length of line the value for each of the parameters is easily 
determined. To best approximate the distributed behavior of the transmission line multiple 
sections of RLCG circuits are used. The value of the parameters, R for example, is determined 
by dividing the R value for the given length of line by the number of sections. Since R (and) L 
values add in series and C and G values add in parallel, a multi-section model for simulation 
can easily be constructed. For example:

If the value of R for a given line is 2.4 ohms per meter,
and the length of line needed is 100 cm,
then the total resistance needed for the 100 cm line is 0.24 ohms
If 12 sections are used to model the line, then each R is 0.02 ohms.

The same calculation can be made for each of the parameters.

Equation 
Set 1

R RDC RSKIN f+=

L constant=

G GDC GAC f⋅+=

C constant=
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Extracting Fitted RLCG Parameters from S-Parameters
Telegrapher’s equations are used to solve for the RLCG values. The Telegrapher’s equations 
described in “Coupled-Transmission Line Models” on page 211 for the 2-coupled line model. 
Telegrapher’s equations deal with the voltage and current as shown in Figure 7-1. However, 
PLTS measures S-parameters, which are ratios of power reflected from and transmitted thru 
to the incident power. For a single transmission line, the impedance (Z) and propagation 
constant (γ) can be derived from the measured 2-port S-parameters of the line. Equation Set 2 
defines the S-parameters in terms of Z, Z0 (characteristic impedance of the measurement 
system), γ, and l (the length of the line).

where

Ds = 2 × Z × Z0 cosh γl + (Z2 + Z0
2) sinh γl

Using Equation Set 2 and transforming to [ABCD} parameter, we can solve for γ and Z as 
functions of S-parameters as shown in Equation Set 3 and Equation Set 4:

where

Equation 
Set 2

Equation 
Set 3

Equation 
Set 4
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Once γ and Z are known, from the standard transmission line relationships, values for R, L, C, 
and G can be determined as shown in Equation Set 5 through Equation Set 10 below:

Then,

In the case of a pair of coupled transmission lines, each RLCG parameter is actually a 2-by-2 
matrix. For symmetrical uniform coupled transmission lines, the matrices are real and 
symmetrical. The latter is described in more detail in “Coupled-Transmission Line Models” on 
page 211.

Equation 
Set 5

Equation 
Set 6

Equation 
Set 7

Equation 
Set 8

Equation 
Set 9

Equation 
Set 10

γ R jωL+( ) G jωC+( ) α jB+= =

Z
R jωL+( )
G jωC+( )--------------------------=

R Re γZ{ }=

L Im γZ{ } ω⁄=

G Re γ Z⁄{ }=

C Im γ Z⁄{ } ω⁄=
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Coupled-Transmission Line Models
Start with an ideal lossless symmetrical coupled-transmission line (CPTL):

Figure 7-3 Lossless Coupled Line Model

The Telegraphers set of equations are described in Equation Set 11 and Equation Set 12:

Equation 
Set 11

Equation 
Set 12

∂V1

∂x
---------– L

∂I1

∂t
------- Lm

∂I2

∂t
-------+=

∂V2

∂x
---------– Lm

∂I1

∂t
------- L

∂I2

∂t
-------+=

∂I1

∂x
-------– C

∂V1

∂t
--------- Cm

∂ V1 V2–( )
∂t

--------------------------+=

∂I2

∂x
-------– Cm

∂ V2 V– 1( )
∂t

-------------------------- C
∂V2

∂t
---------+=
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These equations represent the closest form to the physical behavior of CPTL, since they 
describe each line by its own self parameters (L and C) and the different mutual couplings 
(Lm and Cm). Obviously, these equations can be extended for the lossy case, where the 
conductor and dielectric losses would be taken into account.

NOTE These parameters are called self-parameters.

By rearranging Equation Set 11 and Equation Set 12, a second set of parameters can be 
defined as shown in Equation Set 13 and Equation Set 14:

In the general case, RLCG parameters are grouped in 2-by-2 real matrices, each term being 
frequency-dependent. In the case of symmetrical coupled-lines, these matrices are 
symmetrical. See Equation Set 15.

NOTE These parameters are called spice-parameters.

Most Spice-type simulators use this type of model description with different variations in the 
implementation. This aspect is described in more details in Chapter 8, “Importing and 
Exporting Data.”.

Equation 
Set 13

Equation 
Set 14

Equation 
Set 15
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The third model representation is called the Differential-Common Modes Equivalent Model. 
This model was created because the RLCG extraction algorithm deals only with Single-Ended 
Transmission Lines (SETL). See “Extracting Fitted RLCG Parameters from S-Parameters” on 
page 209. Therefore, each quadrant from the mixed-mode S-parameters, in particular the 
Diff-Diff and Com-Com, are treated as two separate SETL, with predefined normalized 
impedance.

The new set of RLCG parameters extracted for the differential and common modes can be 
represented in a frequency-dependent matrix format, as shown in Equation Set 16.

NOTE These parameters are called Diff/Com parameters.

Equation 
Set 16
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CPTL RLCG Extraction Procedure
PLTS starts by extracting the RLCG parameters for both the Diff-Diff mode and the 
Com-Com mode. In the case of a symmetrical CPTL, mode-conversion should be negligible. 
Then we offer the following options to visualize. See Figure 7-4.

Figure 7-4 RLCG Extraction Block Diagram

This section describes the formulas for the different transformations.

Equation Set 17 and Equation Set 18 relate the Odd and Even modes to the Differential and 
Common modes of propagation:

Equation 
Set 17

Equation 
Set 18
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Using the propagation constant and the characteristic impedance for the Odd/Even modes, 
the Spice parameters are derived in Equation Set 19 and Equation Set 20.

Finally, Self parameters can be derived as shown in Equation Set 21 and Equation Set 22.

Equation 
Set 19

Equation 
Set 20

Equation 
Set 21

Equation 
Set 22
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RLCG Output Plots
Figure 7-5 illustrates the difference between the extracted parameters and the fitted curve.

Figure 7-5 Extracted and Fitted Parameters

This plot format can be applied to Diff/Com, Spice or Self parameters. 
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RLCG Output Plots
Figure 7-6 illustrates the propagation constant and Figure 7-7 illustrates the characteristic 
impedance in real-imaginary format. Since these two parameters are complex numbers, you 
have the choice of plotting these parameters in other formats, like Magnitude/Phase, and 
dB/Phase versus linear or log of the frequency.

Figure 7-6 Propagation Constant versus Frequency

Figure 7-7 Impedance versus Frequency
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The export data section is intended to link PLTS to the main Electronic Design Automation 
(EDA) software tools used by R&D engineers in the Signal Integrity field. These EDA 
simulators are:

• Agilent Advanced Design System (ADS)

• Avanti HSPICE

For ADS, there are two main export formats defined. The first format exports fitted 
parameters in an ASCII file to be used with the ML2CTL_C model found in the Multilayer TL 
Library. The syntax is described in the following example:

BEGIN DSCR(RLGC)

! C[i][j]/eps0 l[i][j]/mu0 Rdc[i][j] Rhf[i][j]/sqrt(f_GHz) 
G[i][j]/omega*eps0
% C(real) L(real) Rdc(real) Rhf(real) G(real)
8.911534 0.326182 1.345030 13.7199 0.133030
-1.013052 0.067352 -0.000279 0.838288 -0.005866
8.911534 0.326182 1.345030 13.7199 0.133030

END

NOTE The ADS format has the capacitance values divided by ε0, the inductance 
values divided by µ0, and the high frequency resistance (Rs) divided by the 
square root of frequency (in GHz).

To use this file in ADS, insert the ML2CTL_C component (found in the Tlines-Multilayer 
Pallet) and have the “RLCG_File” parameter point to the exported file. You will also need to 
set the “ReuseRLCG” parameter to “yes” and set the “Length” parameter to the length of the 
line you wish to simulate. Figure 7-8 is an ADS schematic using the RLCG parameters to 
simulate the S-parameters of the modeled line.
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Figure 7-8 ADS Schematic Using the ML2CTL_C Component
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The second format exports extracted parameters versus frequency in an ASCII file. Two files 
are created, one with the self parameters (i.e. R11, C11, etc.) and one with the mutual 
parameters (i.e. R12, C12, etc.). The file format is shown in Figure 7-9 and Figure 7-10.

Figure 7-9 Exported Extracted Parameter File Format for Self Parameters

Figure 7-10 Exported Extracted Parameter File Format for Mutual 
Parameters
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For Avanti HSPICE, the following format exports fitted parameters in an ASCII file to be 
used with the W-element TL model. The syntax is described in the following example:

* RLCG parameters for a 2-conductor lossy
* frequency-dependent line

* N (number of signal conductors)
*****************************************
2

* Lo
4.098919e-007
8.463660e-008  4.098919e-007

* Co
7.890361e-011
-8.969661e-012  7.890361e-011

* Ro
1.34503
-0.000278525  1.34503

* Go
9.842513e-012
-5.905520e-012  9.842513e-012

* Rs
0.000419683
2.65087e-005  0.000419683

* Gd
7.399602e-012
-3.256807e-013  7.399602e-012 

To use this file in HSPICE, use the W-element and have the “RLCGfile” parameter point to 
the file exported from PLTS. A simple netlist using the W-element and the exported 
parameters to do an S-parameter simulation of the modeled line is shown in the following 
example:

Single Ended TDR simulation of TL
.OPTIONS LIST NODE POST
.OP
.tran 0.01ns 5ns
.NET V(OUT) VIN ROUT=50 RIN=50
* .PLOT AC S11(DB) S22(DB) S21(DB)
VIN 3 0 DC=0 AC=1 pulse(0v 0.4v 0ns 100ps)
W1 In 1 0 OUT 2 0 N=2 L=0.127 RLGCfile=probednew.rlgc
R1 1 0 50
R2 2 0 50
R3 3 IN 50
R4 OUT 0 50
.END
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Considerations When Extracting RLCG Parameters
When extracting the RLCG parameters for a symmetrical coupled line, the measurement 
must include only the coupled transmission line. It should not include any connectors, or 
single-ended launches in the measurement. If any of these are included, the parameters will 
not accurately model the transmission line. Figure 7-11 shows the connector and launches 
that need to be removed.

Figure 7-11 Typical Device with Connectors to be Tested

The effects to the left of the dotted line need to be removed. These can be removed one of two 
ways. The first is to characterize the launch structure (to the left of the dotted line) and then 
de-embed it from the measurement. This is not easily done. The other way is to create 
calibration standards on the board that include the connector and launch and use them to 
calibrate with. However, the parasitics of the standards need to be characterized and entered 
into the calibration kit definition.

The easiest way to characterize the transmission line is to do a probed measurement. By 
performing a probe calibration there are no connectors or launches to remove. Figure 7-12 
shows a typical probed measurement.
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Figure 7-12 Typical Probed Measurement of a Transmission Line
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The Parameters for Each RLCG Mode
The data (parameters) available for each of the four RLCG modes varies due to the model 
assumptions. The individual parameter selections are based on the specific RLCG data 
analysis type. The following lists each data analysis type and its associated parameters. 

RLCG (Differential): Rd, Ld, Cd, Gd, Zor, Zoi, Ad, Bd

RLCG (Common): Rc, Lc, Cc, Gc, Zor, Zoi, Ac, Bc

RLCG (W-Element): R11, L11, C11, G11, R12, L12, C12, G12

RLCG (Self/Mutual): Rs, Ls, Cs, Gs, Rm, Lm, Cm, Gm

where, A represents the Attenuation Constant (α) B represents the Phase Constant (β)

C represents Capacitance G represents Conductance

L represents Inductance R represents Resistance

Z represents Impedance
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This section guides you with opening measured data and viewing the data using transmission 
line (RLCG) parameter extraction. There are eight transmission line parameters for each 
transmission line mode. You may elect to view any number of these parameters.

Opening a Transmission Line Plot Window

The transmission line parameters may be viewed in any of four modes (differential, common, 
W-Element, and self/mutual). 

You may open the transmission line plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 7-13

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 7-13

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 7-13

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the RLCG choices - see (B) of Figure 7-13

NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the RLCG 
menu once the blank plot window is displayed after the T-Line parameters are 
defined in the next step.
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Figure 7-13 Opening the Transmission Line Plot Window

The T-Line Characteristics dialog box (Figure 7-14) is then displayed. Enter the length of the 
transmission line (in meters) and the highest measured frequency (in megahertz) and then 
click OK. 

Figure 7-14 T-Line Characteristics Dialog Box

Length (M) can be used to scale extracted values in units/meter.

Highest Extracted Frequency (MHz) defaults to the stop frequency value. However, this 
can be set at a lower frequency to better fit your parameters.

The highest extracted frequency is 90% of the maximum measured frequency. For example, 
the Highest Extracted Frequency (MHz) is 45 GHz for a 50 GHz measurement. In the 
case shown in Figure 7-14, the Highest Extracted Frequency (MHz) is 8100 MHz for the 
9 GHz measurement. This allows for some guard band of the data, extra bandwidth for use in 
time to frequency conversions, and to allow some extra frequency range to get good data and 
allow for time domain roll off.
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The individual parameter selections are based on the specific RLCG data analysis type. The 
following lists each data analysis type and its associated parameters. 

RLCG (Differential): Rd, Ld, Cd, Gd, Zor, Zoi, Ad, Bd

RLCG (Common): Rc, Lc, Cc, Gc, Zor, Zoi, Ac, Bc

RLCG (W-Element): R11, L11, C11, G11, R12, L12, C12, G12

RLCG (Self/Mutual): Rs, Ls, Cs, Gs, Rm, Lm, Cm, Gm

where, A represents the Attenuation Constant (α) B represents the Phase Constant (β)

C represents Capacitance G represents Conductance

L represents Inductance R represents Resistance

Z represents Impedance
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Viewing All Parameters

In all cases, except when you open the plot window using the Browser, all eight of the RLCG 
parameter plots are displayed. Each of the plots is labeled. See Figure 7-15.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all eight plots by selecting All from the Parameter Bar or from 
the RLCG menu with New Plot selected.

Figure 7-15 All 8 RLCG Plots
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Viewing a Single RLCG Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
eight plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 7-16. 

Figure 7-16 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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Creating a Custom RLCG Plot Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four RLCG plots of RLCG (Differential). To create this 
custom window, open the measured data file in any analysis type. Then, in the Browser, 
select the data type that you want to display the plots. In this example, select RLCG 
(Differential). A blank plots window is displayed. With New Plot selected in the 
Parameter Bar (or the RLCG menu), click the desired parameters (R, L, C, and G in this 
example). As each parameter is selected, a new plot is added to the plots window. See Figure 
7-17.

Figure 7-17 Custom Plots Window with Four Plots
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Viewing Fitted and Smoothed RLCG W-Element Traces

When data is viewed in RLCG (W-Element), two traces are displayed in each of the eight 
plots. The two default traces in each plot are the Extracted data (represented by the blue 
trace) and Fitted data (represented by the red trace). 

However, both traces may not be readily apparent in every plot initially. Both R (R11 and R12) 
and both G (G11 and G12) plots may appear to have only the red Fitted traces. The R plots can 
easily be resolved by autoscaling both of plots (see “Autoscale” on page 238). For the sloping 
linear G plots, the red Fitted trace is lying exactly on top of the blue Extracted trace. See 
Figure 7-18.

Figure 7-18 RLCG (W-Element) Display

In W-Element, viewing the Extracted data with the Fitted data is the default status. However, 
you have the option of viewing the Extracted data with Smoothed data as well. Figure 7-19 
shows W-element plots for R11 and L11 extracted data traces. In addition to the Extracted 
data traces, the upper two plots also show the default Fitted data traces. In the lower two 
plots, the Extracted data traces are shown with Smoothed data traces. 
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Figure 7-19 Comparison of Fitted Data and Smoothed Data for R11 and L11

Extracted Data

Extracted data is the data that has been derived (or extracted) from the measured frequency 
domain values. The blue extracted data trace is always displayed in the W-element. This data 
can also be exported using the RLCG export feature. See “RLCG” on page 256.
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Fitted Data

Fitted data is used to show the general trend of the extracted data using a minimal set of 
data. The trend is defined by the W-Element model definitions in HSPICE. It is the 
traditional lossy transmission model common in most simulators. The fitted data set is 
computed from the extracted data and used to define each of the traces. Fitted data is 
displayed with a red trace.

• Resistance (R): R has two values for each trace R0 and RS. R varies as the square root of 
frequency, so R at a given frequency point can be calculated with the formula: 

 where R0 is the R value at 0 Hertz and RS is the parameter for the 
frequency variation. 

• Inductance (L): Each L has one value, which is the average of the extracted data values 
for L and is constant versus frequency. 

• Capacitance (C): Like L, each C has one value, which is the average of the extracted data 
values for C and is constant versus frequency. 

• Conductance (G): G has two values for each trace G0 and GD, G is linear as a function of 
frequency, so G at a given frequency point can be calculated with the formula: 

 where G0 is the G value at 0 Hertz and GD is the slope value. 

From these values, each of the fitted traces are calculated and displayed. These values can 
also be exported using the RLCG export feature. See “RLCG” on page 256.

Smoothed Data

Smoothed data is extracted data that has had a smoothing mask applied making the result 
display the general trends of the extracted data. As additional points are added to the 
smoothing mask, more of the extended data’s peaks and dips are rounded off (or smoothed). 
Smoothing uses a running average approach at each data point to smooth the data. For 
example, if the integer “5” is entered as the smoothing value, at data point N, PLTS averages 
the five values ( N−2, N−1, N, N+1, N+2) for data point N. This averaging is used for every 
data point. Smoothed data is displayed as a red trace. This data can also be exported using the 
RLCG export feature. See “RLCG” on page 256.

R R0 RS frequency×+=

G G0 GD frequency×+=
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To View the W-Element Data with the Smoothed Data Option

1. From the Tools menu, select W-Element Display Configuration.

Figure 7-20

2. With the W-Element Display Configuration dialog box displayed, select Smoothed in 
the Additional W-Element Trace area to view the smoothed data.

Figure 7-21 W-Element Display Configuration Dialog Box

3. In the Number of Points in Smoothing Mask area, enter the number of points for the 
smoothing mask for the desired parameter. Continue entering the smoothing values for all 
desired parameters.

In this example, the value 501 was entered as the value in the R11 box.

The number of point values must be odd integers.
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Figure 7-22 Enter the Number of Masking Points and Apply the Change

4. Choose the Apply button to apply to changes.

This dialog box remains displayed so that changes to the point values may be optimized or 
you may return to viewing the Fitted traces. The Close button closes the dialog box.
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TIP As additional points are added to the smoothing mask, more of the extended 
data’s peaks and dips are rounded off (or smoothed). A change in the number of 
points at the lower end has a more dramatic smoothing effect than a similar 
change at the higher end. As an example, the change from 51 to 201 points has 
a greater effect to the trace than from 201 to 1001 points.

Figure 7-23The Effect of the Number of Points in the Smoothing Mask 

Refine the number of points so the smoothing traces are displayed to meet 
your requirements.
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Setting the Scale
The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 7-24 Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 7-25.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 7-25.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 7-25. The scaling calculator icon varies slightly between scaling 
entries meet the requirements of the specific entry.

Figure 7-25 Entering a Scale Value

The horizontal scale is changed by changing the start and stop frequencies in megahertz 
(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
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frequencies used in the measurement. 

The vertical scale units are changed using the same method as used for the horizontal units. 
The units vary to be appropriate for each plot. For example, when the plot is inductance, the 
units are in Henrys while when a resistive plots is displayed, the units are ohms. 

Quick Scale Features

PLTS has three features that make scaling changes quickly and easily. The three features are:

• Autoscale

• Reset Scale

• Copy Plot Format used with Paste Plot Format (see “Copying and Pasting Plot 
Formats” on page 320)

Autoscale

Autoscale changes the vertical scale of the active plot to allow the trace to occupy 
approximately 80% of the vertical axis of the display. It places the display such that the 
graticule values are numbers that are easy to work with.

Figure 7-26 Autoscale

To autoscale a plot, select the plot, then right click on the plot to display the quick menu 
displayed in Figure 7-26. Click Autoscale to change the vertical scale of the plot. Figure 7-27 
shows an RLCG W-Element Resistance plot that has Autoscale applied to it.
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Figure 7-27 A Plot that has been Autoscaled

Reset Scale

Reset Scale resets the vertical and horizontal scale of the active plot to the default settings. 
This is useful when you are adjusting the scale and the trace is moved off screen and can no 
longer be seen.

To reset the scale of a plot, select the plot, then right click on the plot to display the quick 
menu displayed in Figure 7-28. Click Reset Scale to reset the plot to the default settings.

Figure 7-28 Reset Scale
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Exporting Transmission Line Data
The PLTS can export the transmission line data to the main Electronic Design Automation 
(EDA) software tools used by R&D engineers in the field of signal integrity. These EDA 
simulators are:

• HSPICE
• Advanced Design System (ADS)

Refer to “Export Data Formats” on page 218 for detailed information on the file formats for 
exported data.

Refer to “RLCG” on page 256 for detailed information on exporting RLCG data from PLTS.
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Importing and Exporting Data
In addition to making measurements and reviewing the data files within the software, PLTS 
has both import and export capabilities. While PLTS makes quick and accurate 
measurements and provides an excellent platform to view measured data, you will want to 
import data from other sources that you can view and compare. You will also want to export 
data for use with modeling and simulation tools. PLTS can be used with a variety of modeling 
and simulation tools and can import and export in multiple formats. Figure 8-1 shows how the 
data file import and data file export capabilities blend with the whole PLTS software product.

Figure 8-1 PLTS Data File Import and Export Block Diagram

PLTS exports data files in the following formats:

• Plot to Clipboard

• Plot to Image File
— Windows Bitmap (.bmp)
— JPEG Bitmap (.jpg)
— Targa Bitmap (.tga)

• Frequency Domain
— Real/Imaginary {comma delimited (.csv) or tab delimited (.txt)}
— Log Mag {comma delimited (.csv) or tab delimited (.txt)}
— Linear {comma delimited (.csv) or tab delimited (.txt)}
— Phase {comma delimited (.csv) or tab delimited (.txt)}

• CITIfile (.cit)
• Touchstone

— Magnitude, angle (.s4p)
— dB, angle (.s4p)
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— Real, Imaginary (.s4p)
• Time Domain (one or all parameters) {comma delimited (.csv) or tab delimited (.txt)}
• TDA MeasureXtractor
• RLCG

— HSPICE

❏ W-Element 
❏ W-Element Tabular

— Advanced Design System (ADS)
❏ ML2CTL Model
❏ MDIF
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Importing Data Files
Select Import from the File menu to import a single-ended measurement data file. Then 
select either CITIFile to import a file in CITIfile format or Touchstone (S4P) to import a file 
in Touchstone format. Then select from one of the port selections (either Port Configuration 
= 1 & 3 -> 2 & 4 or Port Configuration = 1 & 2 -> 3 & 4) based on the calibration type used 
with the original measurement. Only 4-port data may be imported.

CAUTION PLTS will not import files with Power Sweep data. Attempting to import files 
with Power Sweep data could cause PLTS to close without notice.

NOTE A CITIfile can include balanced data information, however, only CITIfiles that 
include 4-port single-ended data may be imported.

Figure 8-2 File Menu with Import Expanded
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Figure 8-3 Balanced Transform Port Configuration Diagram

CITIFile

CITIFile imports data previously saved in CITIfile (*.cit) format. Files imported in this 
fashion can be used for comparison with other data sets using trace memory and math 
functions. Refer to Figure 8-3 and choose from one of the following port selections. This format 
is described in “CITIfile” on page 259.

Port Configuration = 1 & 3 -> 2 & 4 is used to import single-ended measurement data 
taken with a VNA-based system calibrated using the SOLT calibration.

Port Configuration = 1 & 2 -> 3 & 4 is used to import single-ended measurement data 
taken with a VNA-based system calibrated using a TRL or LRM calibration or for all TDR 
measurements.

Touchstone

Touchstone imports data previously saved in Touchstone (*.S4P) format. Refer to Figure 8-3 
and choose from one of the following port selections. This format is described in “S4P 
(Touchstone)” on page 264.

Port Configuration = 1 & 3 -> 2 & 4 is used to import single-ended measurement data 
taken with a VNA-based system calibrated using the SOLT calibration.

Port Configuration = 1 & 2 -> 3 & 4 is used to import single-ended measurement data 
taken with a VNA-based system calibrated using a TRL or LRM calibration or for all TDR 
measurements.
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Exporting Data Files
Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, Frequency Domain, 
CITIFile, Touchstone, Time Domain, TDA MeasureXtractor, and RLCG.

Figure 8-4 File Menu with Export Expanded

Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, Frequency Domain, 
CITIFile, Touchstone, Time Domain, TDA MeasureXtractor, and RLCG.
Chapter 8246



Importing and Exporting Data
Exporting Data Files
Figure 8-5 Exported Data: Active Plot Data Only

Plot(s) to Clipboard

Plot(s) to Clipboard exports the active plot window image to the Windows clipboard. It does 
not copy or export data.

From the File menu, select Export, then Plot(s) to Clipboard to export the active plot 
window image to Windows clipboard. The contents of the clipboard can then be pasted into 
other Windows programs.

This feature is the same as the Copy icon on the Toolbar.
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Plot(s) to Image File

Plot(s) to Image File exports the contents of the active plot window to an image file. 

The Select Bitmap Size dialog box is displayed giving you the choice of bitmap sizes. Choose 
from 640 x 460, 800 x 600, 1024 x 768, or 1280 x 1024 pixels. See Figure 8-6.

Figure 8-6 Select Bitmap Size Dialog Box

When you export the image file using the Save As dialog box, you may choose from Windows 
Bitmap (BMP), JPEG Bitmap (JPG), or Targa Bitmap (TGA) formats from the Save as type: 
list. Select Save to export the image file. See Figure 8-7.

Figure 8-7 Select Format when Saving the Image File

This feature is the same as the Export Bitmap icon (the camera icon) in the Toolbar.
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Frequency Domain

Frequency Domain exports the data of a single S-parameter (either single-ended or 
balanced) or the data of all 32 single-ended and balanced parameters using one of four 
frequency domain formats: Real/Imaginary, Log Magnitude, Linear Magnitude, or Phase. 

1. From the File menu, select Export, Frequency Domain to display the Frequency 
Domain Export dialog box.

Figure 8-8 Frequency Domain Export Dialog Box

2. In the Select the frequency domain parameter list, select any one of the 16 
single-ended parameters or any one of the 16 balanced parameters to export. You can also 
export all 32 of the parameters by selecting All at the bottom of the list.

3. In the Select the format area, select one of the four formats to save the data as: 
Real/Imaginary, Log Magnitude, Linear Magnitude, or Phase

4. Select the OK button to open the Save As dialog box.

Figure 8-9 Save As Dialog Box
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5. In the Save As dialog box, select the directory that you want to save the data in.

6. In the File name: text box, enter a file name for the data to be saved.

7. In the Save as type: list, select the file format of the data to be saved.

You may select either CSV (comma-separated variable with .csv extension) or Text (tab 
delimited with .txt extension).

8. Click the Save button to save the data.

When a single parameter is selected, the parameters data is saved to the file that you 
named with the extension that you selected. When all parameters are selected, each 
parameter is saved to a separate file; thus 32 files are created. Each file is saved with the 
name you entered. However, each file name has a parameter labeled appended to the 
name. For example, you entered device4 as the file name, the S11 parameter file is 
named: device4_S11

CITIFile

CITIFile exports the current frequency domain data in CITIfile format (*.cit). This format is 
described in “CITIfile” on page 259.

1. From the File menu, select Export, CITIFile to display the Save As dialog box. Enter a 
file name in the File name: area and click the Save button. See Figure 8-10.

Figure 8-10 CITIFile Save As Dialog Box

2. The CITIFile: Choose data to be exported dialog box is displayed. Select Single-Ended 
Frequency and/or Balanced Frequency and then click the OK button to export the 
data. See Figure 8-11.
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Figure 8-11 CITIFile: Choose data to be exported Dialog Box

Touchstone

Touchstone exports the current data in the S4P format which also has the following data 
format choices in which the data may be saved: 

• Magnitude, angle 

• dB, angle (power, angle)

• Real, imaginary

 This format is described in “S4P (Touchstone)” on page 264.

Figure 8-12 File Menu with Export and Touchstone Expanded
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Time Domain

Time Domain exports the data of a single time domain parameter (either single-ended or 
differential) or the data of all 32 single-ended and differential parameters using either the 
Step or Impulse response type.

1. From the File menu, select Export, Time Domain to display the Export Time Domain 
dialog box.

Figure 8-13 Export Time Domain Dialog Box

2. In the Select the time domain parameter list, select any one of the 16 single-ended 
parameters or any one of the 16 differential parameters to export. You can also export all 
32 of the parameters by selecting All at the bottom of the list.

3. In the Select response type area, select either: Step or Impulse

4. Select the OK button to open the Save As dialog box.

Figure 8-14 Save As Dialog Box

5.  In the Save As dialog box, select the directory that you want to save the data in.
Chapter 8252



Importing and Exporting Data
Exporting Data Files
6. In the File name: text box, enter a file name for the data to be saved.

7. In the Save as type: list, select the file format of the data to be saved.

You may select either CSV (comma-separated variable with .csv extension) or Text (tab 
delimited with .txt extension).

8. Click the Save button to save the data.

When a single parameter is selected, the parameters data is saved to the file that you 
named with the extension that you selected. When all parameters are selected, each 
parameter is saved to a separate file; thus 32 files are created. Each file is saved with the 
name you entered. However, each file name has a parameter labeled appended to the 
name. For example, you entered device4 as the file name, the T11 parameter file is 
named: device4_T11 
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TDA Systems MeasureXtractor

TDA MeasureXtractor directly export 4-port S-parameters in Touchstone format for import 
into TDA Systems’ MeasureXtractor. This is a powerful capability that allows you to describe 
the exact frequency dependent behavior of your passive device using an S-parameter block 
inside of MeasureXtractor. MeasureXtractor also allows you to create a SPICE compatible 
model for further circuit simulation. 

Access the PLTS → TDA MeasureXtractor export feature by selecting Export then TDA 
MeasureXtractor from the File menu.

File Format and Port Conventions

The format of the 4-port S-parameter Touchstone file is magnitude (in dB) and phase (in 
degrees) information at each frequency point. Port designations in the resultant Touchstone 
file are as they appear in the DUT file.

• If you are only using a single S-parameter defined data block in your MeasureXtractor 
schematic, your results are specific to what you attach to each of the ports.

• If you are using cascaded S-parameter data blocks in your schematic they must have ports 
1 and 3 as the input ports and ports 2 and 4 as the output ports (see Figure 8-15). Since 
TDR measurements typically have ports 1 and 2 as the input ports and 3 and 4 as outputs, 
a port swap between port 2 and port 3 will need to be performed. You can also read TDR 
waveforms directly into TDA MeasureXtractor for data driven models.

Figure 8-15 Requirement when S-Parameter Blocks are Cascaded

Recommendations for a Good MeasureXtractor-compatible File

• For TDR-based measurements set the number of points to 2000 or above and make all 16 
single-ended measurements (differential measurements are not required). A complete 
4-port measurement set is required to export directly to MeasureXtractor. Alternately, you 
can export selected S-parameters directly from PLTS into a Touchstone file from the File 
menu by selecting Export, Touchstone, and Magnitude, angle.

• When using a VNA, perform your measurements with a 20 MHz start frequency and a 
20 GHz stop frequency. Since Start and Step frequency settings are coupled, this will 
ensure several things including getting about 1000 points of data (so as to avoid 
undersampling) and an adequate extrapolation down to dc. Not following these 
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precautions can lead to difficulty with successfully extracting a circuit in MeasureXtractor.

• Maintain good fixturing, calibration practices, and a low IF bandwidth when using a VNA 
to ensure good reciprocity and prevent your passive device from turning active at any 
frequency point. The MeasureXtractor software requires good reciprocity (e.g. S12 = S21, 
S34 = S43 to better than about 2%) for its algorithms to function and utilizes an input 
checker that will reject files with poor reciprocity. You can visually check for reciprocity or 
perform math functions within PLTS before exporting to MeasureXtractor as an early 
indicator.

• Use only short-to-medium length devices. Using devices that are less than 20 wavelengths, 
or no more than 100 rise times long, will keep extraction time and simulation time of the 
resultant S-parameter block in MeasureXtractor reasonable.

• Obtain dc response information on your device if possible. This will enhance the accuracy 
of the model created inside of MeasureXtractor.

Recommendations for Using the Exported File in MeasureXtractor

In TDA Systems’ software:

• Change the Max Frequency field under Tools > Options > Waveform Viewer to match 
the maximum frequency of your Touchstone file.

• Follow the guidelines listed in the TDA Systems’ documentation for rise time, truncating, 
and dc values.

• To avoid difficulties in performing the extraction, make sure your device takes up a 
significant portion of the total time domain window (> 33%). If your device only takes up 
10% or less of the time domain window, you can eliminate the lowest frequency data points 
to shorten the time span by directly editing the Touchstone file.
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RLCG

RLCG data may be exported from PLTS to be used by other applications. PLTS exports RLCG 
data in the W-Element mode only. PLTS provides a variety of formats in which you may export 
data. Refer to “RLCG Data Formats” on page 268 for details on each of the formats.

To export RLCG W-Element data:

1. From the File menu, select Export, RLCG… to display the Export RLCG Data dialog box.

Figure 8-16 Dialog Box

2. From the Select File Type: list, select either the HSPICE or ADS choice to match the 
modeling application with which you will use the exported data.

 The Export RLCG Data dialog box exports the current data in one of two RLCG formats: 

• HSPICE selection exports the RLCG data in a format compatible with HSPICE (a 
Simulation Program with Integrated Circuit Emphasis) software. Refer to “Exporting 
Transmission Line Data” on page 240.

• ADS selection exports the RLCG data in a format compatible with the Agilent 
Advanced Design System (ADS) software format.
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3. From the Format of Data to Export list, select the format in which you want to export 
the RLCG data.

• If you selected HSPICE in step 2, you may select either: 

— W-Element which will allow export of 4 Port Fitted data

— W-Element Tabular which will allow export of 4 Port Extracted or 4 Port 
Smoothed data

• If you selected ADS in step 2, you may select either: 

— ML2CTL Model which will allow export of 4 Port Fitted data

— MDIF which will allow export of 4 Port Extracted or 4 Port Smoothed data

4. If you selected either W-Element Tabular or MDIF in step 3, select the data to export 
from the Select Data to Export list. 

You may select to export either 4 Port Extracted or 4 Port Smoothed data. 

The W-Element Tabular and MDIF selections also allow you to limit the data range that 
is exported. See “Advanced W-Element Export Features” on page 258 before continuing to 
step 5.

If you selected either W-Element or ML2CTL Model in step 3, 4 Port Fitted data is the 
only data type that may be exported. Continue with step 5.

5. In the File name box, enter a file name to export the W-Element data. The file extension 
is applied automatically and varies by selected format. The Browse… button may be used 
to locate a specific file.

6. Click the OK button to export the W-Element data to the specified file. 

The Cancel button closes the dialog box without exporting W-Element data. 
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Advanced W-Element Export Features

The W-Element Tabular and MDIF selections allow you to change the data units that are 
exported. These selections also allow you to define a subset of the data to export.

Independent Units:  In the Independent Units area, you may select to export the 
W-Element data in either MHz units or GHz units.

Limit Data Range to Output:  In the Limit Data Range to Output area, you have the 
option of exporting a subset (or a reduced set) of the data. You may define the subset in a 
variety of ways. 

• All is the default setting. This setting will export all of the W-Element data as defined 
above.

• Subset will export a subset of the W-Element data. The Start, Points, Spacing, Stop, 
and Step entries are used to define the subset.

— Start is the start frequency of the W-Element data. The initial entry is the lowest 
frequency of the data. This value may be increased to a higher start frequency.

— Stop is the stop frequency of the W-Element data. The initial entry is the highest 
frequency of the data. This value may be decreased to a lower start frequency.

— Points is the number of data points measured from the start frequency to the stop 
frequency. This value is set to the actual number of points in the W-Element data. This 
value may be increased or decreased.

— Step is the frequency between each data point when Linear is selected as the Spacing 
value. This value may be changed to increase or decrease the frequency stepped 
between the data points.

— Spacing allows you to change from exporting W-Element data in the Linear mode 
(default). This allows you to specify the number of points to export data in logarithmic 
(Log) mode or the points per decade (Dec) or octave (Oct).

— Interpolate informs you that changes have been made to the settings that require the 
data to be interpolated.Unchecking this box when Linear is selected as the Spacing 
value reverts the data output to the data points actually measured, within the 
frequency range specified.

— Reset button returns the settings to the original values of the W-Element data.
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File Formats 
This section describes the S4P (Touchstone) and the CITIfile file formats. The Touchstone file 
format begins on page 264.

CITIfile

CITIfile is a standardized data format, used for exchanging data between different computers 
and instruments. CITIfile is an abbreviation for “Common Instrumentation Transfer and 
Interchange file”. 

This standard has been a group effort between instrument designers and designers of 
computer-aided design programs. As much as possible, CITIfile meets current needs for data 
transfer, and it was designed to be expandable so it can meet future needs.

CITIfile defines how the data inside an ASCII package is formatted. Since it is not tied to any 
particular disk or transfer format, it can be used with any operating system (BASIC, DOS, 
UNIX, etc.), with any disk format (LIF, DOS, HFS, etc.), or with any transfer mechanism 
(disk, LAN, GPIB, etc.). 

By careful implementation of the standard, instruments and software packages using CITIfile 
are able to load and work with data created on another instrument or computer. It is possible, 
for example, for a network analyzer to directly load and display data measured on a scalar 
analyzer, or for a software package running on a computer to read data measured on the 
network analyzer. 

NOTE For many data processing applications, the S4P file may provide a more 
convenient format.

Data Formats

There are two main types of data formats: binary and ASCII. CITIfile uses the ASCII text 
format. While this format does take up more bytes of space than a binary format, ASCII data 
is a transportable, standard type of format which is supported by all operating systems. In 
addition, the ASCII format is accepted by most text editors. This allows files to be created, 
examined, and edited easily, making CITIfile easier to test and debug.

File and Operating System Formats

CITIfile was designed to be independent of the data storage mechanism, and therefore may be 
implemented for any file system. However transfer between file systems may sometimes be 
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necessary. Any commercially available software that has the ability to transfer ASCII files 
between systems may be used to transfer CITIfile data.

Definition of CITIfile Terms

This section will define the following terms: package, header, data array, keyword

Package  A typical package is divided into two parts: The first part, the header, is made up of 
keywords and setup information. The second part, the data, usually consists of one or more 
arrays of data. Example 1 shows the basic structure of a CITIfile package:

Example 1, A CITIfile Package

The “header” part  CITIFILE A.01.00
NAME MEMORY
VAR FREQ MAG 3
DATA S RI

The “data” part  BEGIN
-3.54545E-2, -1.38601E-3
0.23491E-3, -1.39883QE-3
2.00382E-3, -1.40022E-3
END

When stored in a disk file there may be more than one CITIfile package.

The CITIfile Header  The header section contains information about the data that will 
follow. It may also include information about the setup of the instrument that measured the 
data. For example, the header may include information such as:

• CITIfile version number
• Network analyzer model number
• Firmware revision currently installed in the analyzer
• Type of Data
• Data Format
• Measurement parameters
• Start and stop frequencies
• Number of sample points

The CITIfile header shown in Example 1 has just the bare minimum of information 
necessary; no instrument setup information was included.

An Array of Data  An array is numeric data that is arranged with one data element per line. 
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In the Smith chart and polar formats, the data is in real and imaginary pairs. In all other 
formats, the data is still in pairs, but the second term of the pair is 0E0. All information is 
true formatted data in the same format as on the analyzer display (dB, SWR, etc.).

A CITIfile package may contain more than one array of data. Arrays of data start after the 
BEGIN keyword, and the END keyword will follow the last data element in an array. A 
CITIfile package does not necessarily need to include data arrays; for instance, CITIfile could 
be used to store the current state of an instrument. In that case the keywords VAR, DATA, 
BEGIN, and END would not be required.

CITIfile Keywords  

Table 8-1 CITIfile Keywords

Keyword Explanation and Examples

CITIFILE CITIFILE A.01.01 identifies the file as a CITIfile, and indicates the 
revision level of the file. The CITIfile keyword and revision code must 
precede any other keywords. The CITIfile keyword at the beginning of the 
package assures the device reading the file that the data that follows is in 
the CITIfile format. The revision number allows for future extensions of the 
CITIfile standard. The revision code shown here following the CITIfile 
keyword indicates that the machine writing this file is using the A.01.01 
version of CITIfile as defined here. Any future extensions of CITIfile will 
increment the revision code. 

NAME NAME CAL_SET allows the current CITIfile “package” to be named. The 
name of the package should be a single word with no embedded spaces. A 
list of standard package names follows: 

Label Definition.

RAW_DATA Uncorrected data.

DATA Data that has been error corrected.When only a single data array exists, it 
should be named DATA.

FORMATTED Corrected and formatted data.

MEMORY Data trace stored for comparison purposes.

CAL_SET Coefficients used for error correction.

CAL_KIT Description of the standards used.

DELAY_TABLE Delay coefficients for calibration.
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VAR VAR FREQ MAG 201 defines the name of the independent variable 
(FREQ), the format of values in a VAR_LIST_BEGIN table (MAG, if used), 
and the number of data points (201).Typical names for the independent 
variable are FREQ (in Hz), TIME (in seconds), and POWER (in dBm). For 
the VAR_LIST_BEGIN table, only the “MAG” format is supported at this 
point. # #NA POWER1 1.0E1 allows variables specific to a particular type 
of device to be defined. The pound sign (#) tells the device reading the file 
that the following variable is for a particular device. The “NA” shown here 
indicates that the information is for a Network Analyzer. This convention 
allows new devices to be defined without fear of conflict with keywords for 
previously defined devices. The device identifier (i.e. NA) may be any 
number of characters. 

SEG_LIST_BEGIN SEG_LIST_BEGIN indicates that a list of segments for the independent 
variable follow. Format for the segments is: [segment type] [start] [stop] 
[number of points]. The current implementation only supports a single 
segment. If there is more than one segment, the VAR_LIST_BEGIN 
construct is used. CITIfile revision A.01.00 supports only the SEG (linear 
segment) segment type. 

SEG_LIST_END SEG_LIST_END defines the end of a list of independent variable segments. 

VAR_LIST_BEGIN VAR_LIST_BEGIN indicates that a list of the values for the independent 
variable (declared in the VAR statement) follow. Only the MAG format is 
supported in revision A.01.00. 

VAR_LIST_END VAR_LIST_END defines the end of a list of values for the independent 
variable. 

DATA DATA S[1,1] RI defines the name of an array of data that will be read later 
in the current CITIfile package, and the format that the data will be in. 
Multiple arrays of data are supported by using standard array indexing. 
Versions A.01.00 and A.01.01 of CITIfile only support the RI (real and 
imaginary) format, and a maximum of two array indexes. Commonly used 
array names include the following: “S” for “S parameter” Example: S[2,1] 
“E” for “Error term” Example: E[1] “USER” for “User parameter” Example: 
USER[1] “VOLTAGE” Example: VOLTAGE[1] “VOLTAGE_RATIO” for a 
ratio of Example: VOLTAGE_RATIO[1,0] two voltages (A/R). 

Table 8-1 CITIfile Keywords

Keyword Explanation and Examples
Chapter 8262



Importing and Exporting Data
File Formats
• The COMMENT statement is not absolutely required, but is highly recommended to aid 
readability. 

• The year should always be the full four digits (“1999” is correct, but “99” is not). This is to 
avoid problems with the year 2000, when the shortened version of the year will be “00.”

• The hour value should be in 24-hour “military” time. 

• When writing a CITIfile and the fractional seconds value is zero, then the “seconds” value 
may be printed either with or without a decimal point: either “47.0” or “47” would be 
acceptable. When reading a CITIfile, the seconds value should always be read as if it were 
a floating point number. 

CONSTANT CONSTANT [name] [value] allows for the recording of values which don’t 
change when the independent variable changes. 

CONSTANTs are part of the main CITIfile definition. Users must not 
define their own CONSTANTs. Use the #KEYWORD device specification to 
create your own KEYWORD instead. The #NA device specification is an 
example of this. No constants were defined for revision A.01.00 of CITIfile. 
CITIfile revision A.01.01 defined the following constant:

CONSTANT TIME [year] [month] [day] [hour] [min] [secs] 
Example: 
CONSTANT TIME 1999 02 26 17 33 53.25

Table 8-1 CITIfile Keywords

Keyword Explanation and Examples
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S4P (Touchstone)

These files contain S-parameters that describe frequency-dependent linear networks for 
4-port components. The S4P data file format is also known as Touchstone format. 

An .s4p file can be used to model the behavior of a linear device using S-parameters. The file 
contains the S-parameters, the component with a link to the file is placed within the 
schematic.

This section describes:

• An overview of the S4P file
• The basic S4P format
• The basic S4P format applied to S-parameters, plus example 

S4P data files are ASCII text files in which data appears line by line, one line per data point, 
in increasing order of frequency. Each line of data consists of a frequency value and one or 
more pairs of values for the magnitude and phase of each S-Parameter at that frequency. 
Values are separated by one or more spaces, tabs or commands. Comments are preceded by an 
exclamation mark (!). Comments can appear on separate lines, or after the data on any line or 
lines. Extra spaces are ignored. PLTS uses the following format for 4-port touchstone file 
identification: filename.s4p

Basic S4P File Format

The following example shows the general format for component data files. It consists of:

• An option line
• Data lines
• Comments 

The Option Line

The option line, specifying the frequency units and the normalizing impedance, precedes the 
data lines.

where, 

# = The delimiter that tells the program you are specifying these parameters

frequency units  = The units desired (GHz, MHz, KHz, or Hz)

option line − # <frequency unit> <parameter> <format> <R n> 
<data line> 
…
<data line> 
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parameter = The parameter desired (“S” for S4P components)

format = The format desired (DB for dB-angle, MA for magnitude-angle, and RI for 
real-imaginary)

R n = The reference resistance in ohms, where n is a positive number of ohms of 
the real impedance to which the parameters are normalized)

In summary, the option line should read: # [HZ/KHZ/MHZ/GHZ] [S] [MA/DB/RI] [R n]

Where square brackets [...] indicate optional information; .../.../.../ indicates that you select one 
of the choices; and, n is replaced by a positive number. 

The default option line for component data files is: 

# GHZ S MA R 50 

An example of an Option Line for a file with Frequency in GHz, S-parameters in 
real-imaginary format, normalized to 100 ohms: 

# GHz S RI R 100 

Data Line

Data lines contain the data of interest. For 4-port data files, the network parameters appear 
in the file in a matrix form, each row starting on a separate line. A maximum of four network 
parameters (with 2 real numbers for each) appear on any line. The remaining network 
parameters are continued on as many additional lines as are needed. 

Data Line Formats  When you type the data below the option line, the columns need not 
line up precisely like those shown. The syntax for data is as follows:

4-Port Components  Magnitude-Angle format: 

Freq Mag Ang Mag Ang Mag Ang Mag Ang

f S11 S11 S12 S12 S13 S13 S14 S14

S21 S21 S22 S22 S23 S23 S24 S24

S31 S31 S32 S32 S33 S33 S34 S34

S41 S41 S42 S42 S43 S43 S44 S44

where f = Frequency,
Mag = Magnitude of S-parameter, and 
Ang = Angle of S-parameter
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Comments

You can document your data files by preceding a comment with the exclamation mark (!) on 
any line. A comment can be the only entry on a line or can follow the data on any line. 

S4P Format Examples

Here are formatting reference examples for S-parameter files.

S4P files can have MA, RI, or DB formats. The following examples show the format of each 
format style.

The MA file format is:

The RI file format is:

 # frequency_unit S MA R impedance ! 1st row

freq magS11 angS11 magS12 angS12 magS13 angS13 magS14 angS14

magS21 angS21 magS22 angS22 magS23 angS23 magS24 angS24

magS31 angS31 magS32 angS32 magS33 angS33 magS34 angS34

magS41 angS41 magS42 angS42 mag43 angS43 magS44 angS44

where freq = Frequency,
mag = Magnitude of S-parameter, and 
ang = Angle of S-parameter

 # frequency_unit S RI R impedance ! 1st row

freq realS11 imagS11 realS12 imagS12 realS13 imagS13 realS14 imagS14

realS21 imagS21 realS22 imagS22 realS23 imagS23 realS24 imagS24

realS31 imagS31 realS32 imagS32 realS33 imagS33 realS34 imagS34

realS41 imagS41 realS42 imagS42 real43 imagS43 realS44 imagS44

where freq = Frequency,
real = Real portion of S-parameter value, and 
imag = Imaginary portion of S-parameter value
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The DB file format is:

4-Port S4P (Touchstone) File Example

The following example shows an S4P file in Magnitude format with the frequencies displayed 
in GHz, and having a 50-ohm reference resistance. This examples shows actual data at three 
frequency points.

 # frequency_unit S DB R impedance ! 1st row

freq dBS11 angS11 dBS12 angS12 dBS13 angS13 dBS14 angS14

dBS21 angS21 dBS22 angS22 dBS23 angS23 dBS24 angS24

dBS31 angS31 dBS32 angS32 dBS33 angS33 dBS34 angS34

dBS41 angS41 dBS42 angS42 db43 angS43 dBS44 angS44

where freq = Frequency,
dB = dB value of S-parameter, and 
Ang = Angle of S-parameter

 #  GHZ S MA R 50

5.00000 0.60262 161.240 0.40611 -42.2029 0.42918 -66.5876 0.53640 -79.3473

0.40611 -42.2029 0.60262 161.240 0.53640 -79.3473 0.42918 -66.5876

0.42918 -66.5876 0.53640 -79.3473 0.60262 161.240 0.40611 -42.2029

0.53640 -79.3473 0.42918 -66.5876 0.40611 -42.2029 0.60262 161.240

6.00000 0.57701 150.379 0.40942 -44.3428 0.41011 -81.2449 0.57554 -95.7731

0.40942 -44.3428 0.57701 150.379 0.57554 -95.7731 0.41011 -81.2449

0.41011 -81.2449 0.57554 -95.7731 0.57701 150.379 0.40942 -44.3428

0.57554 -95.7731 0.41011 -81.2449 0.40942 -44.3428 0.57701 150.379

7.00000 0.50641 136.693 0.45378 -46.4151 0.37845 -99.0918 0.62802 -114.196

0.45378 -46.4151 0.50641 136.693 0.62802 -114.196 0.37845 -99.0918

0.37845 -99.0918 0.62802 -114.196 0.50641 136.693 0.45378 -46.4151

0.62802 -114.196 0.37845 -99.0918 0.45378 -46.4151 0.50641 136.693
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RLCG Data Formats
When RLCG data is opened in the W-Element, it may be exported for use in other modeling 
applications, such as HSPICE or Agilent ADS. You may choose to export either extracted, 
fitted, or smoothed data. This section provides some information on the exported files. Refer to 
“RLCG” on page 256 for the export procedure.

• Fitted data may be export using the HSPICE W-Element or the ADS ML2CTL Model 
format. Exporting data in these formats creates a file that is very small in size (under 1 kB 
for all fitted traces.) See “HSPICE W-Element/ADS ML2CTL Model Formats” below for 
more information on this format.

• Extracted data or smoothed data may be exported using the HSPICE W-Element Tabular 
or the ADS MDIF format. Exporting data in these formats creates files that are large in 
size (over 250 kB for all extracted or smoothed traces with a likelihood for much larger 
files.) These files save the R, L, C, and G data at each frequency point which means when 
there are more frequency points in the data, larger files are created. See “HSPICE 
W-Element Tabular/ADS MDIF Formats” on page 270 for more information on this format.

However, PLTS has the ability to export a subset of this large extracted or smoothed data 
set. You may define a subset of this extracted or smoothed data to export. Exporting a 
subset, depending on the subset that you define, can result in significantly smaller files 
sizes. See “Subset” on page 272 for more information on the subset format.

HSPICE W-Element/ADS ML2CTL Model Formats

W-Element/ML2CTL Model use just a few values to describe the RLCG W-Element plots. Only 
Fitted data may be exported using the W-Element/ML2CTL Model selections (see “Fitted 
Data” on page 233).

For example, a complete set of exported values for the HSPICE W-Element Fitted format 
includes the following parameters:

R011, R012, R022, Rs11, Rs12, Rs22, L11, L12, L22, C11, C12, C22, G011, G012, G022, GD11, 
GD12, and GD22 

As shown above, each R, L, C, and G has three values; one for each of the differential lines (i.e. 
L11 and L22) and one for the coupling between the lines (i.e. L12).

This data is imported into HSPICE or ADS where the modeling software uses these values in 
fixed equations of a given form to reconstruct (or “fit” the data as closely as possible to) the 
original extracted data plots. These values are used to reconstruct the original extracted R, L, 
C, and G plots based on a set of rules for each trace. 8-17 shows a file after it was exported 
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from PLTS using the HSPICE W-Element Fitted format.

Figure 8-17 HSPICE W-Element Fitted Format

8-18 shows a file after it was exported from PLTS using the ADS ML2CTL Model Fitted 
format. It uses a similar set of data as the HSPICE W-Element Fitted format above.

Figure 8-18 ADS ML2CTL Model Fitted Format
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HSPICE W-Element Tabular/ADS MDIF Formats

W-Element Tabular/MDIF export all of the values in a tabular for. For each frequency point 
the R, L, C, and G values are saved. Extracted and Smoothed data may be exported using the 
W-Element Tabular/MDIF selections (see “Extracted Data” on page 232 and “Smoothed Data” 
on page 233).

Instead of trying to fit the data to resemble the extracted data, W-Element Tabular/MDIF 
allows the exported data to resemble the actual extracted traces. 

• In W-Element Tabular format, if you have 1000 frequency points, you will have 3000 
values for R (1000 for R11, 1000 for R12, and 1000 for R22), 3000 values for L, 3000 values 
for C, and 3000 values for G. In this format, R21/L21/C21/G21 values are defined as 
symmetrical to R12/L12/C12/G12 and are assigned the same values.

• In MDIF format, if you have 1000 frequency points, you will have two files (one for 
R11/L11/C11/G11 and one for R12/L12/C12/G12). Each file has 1000 values for R, 1000 
values for L, 1000 values for C, and 1000 values for G. In this format, R22/L22/C22/G22 
values are defined as symmetrical to R11/L11/C11/G11 and are assigned the same values. 
Likewise, R21/L21/C21/G21 values are defined as symmetrical to R12/L12/C12/G12 and 
are assigned the same values.

Unlike Fitted data where each value is computed for each frequency from the parameters, the 
data values for Extracted and Smoothed data have an associated frequency.
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8-19 shows a file after it was exported from PLTS using the HSPICE W-Element Tabular 
Extracted format. Smoothed data would be in the same format.

Figure 8-19 HSPICE W-Element Tabular Extracted Format
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8-20 shows a file after it was exported from PLTS using the ADS MDIF Extracted format. 
Smoothed data would be in the same format. This file is just one of two files that are created 
with this export type. In addition to the “11” file, a similar file for the “12” data is also created.

Figure 8-20 ADS MDIF Extracted Format

Subset

PLTS has the ability to export a subset of a extracted or smoothed data set using the HSPICE 
W-Element Tabular or the ADS MDIF formats. This feature is not available using the 
HSPICE W-Element or the ADS ML2CTL Model formats. Exporting a subset is described in 
“Advanced W-Element Export Features” on page 258. Depending on the subset that you 
define, exporting a subset of the data can result in significantly smaller files sizes. 

This feature allows you to change the start, stop, and step frequencies and the number of 
points. It also allows you to export a user-defined number of points per the entire logarithmic 
scale, by decade, or by octave. The formats for the subsets are the same as described for the 
W-Element Tabular or the MDIF formats.
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Removing Unwanted Effects from the Measurement
All digital interconnect components or channels require an interface to the Coax connections 
of the PLTS. These interfaces − called fixtures or probes − typically introduce loss and 
discontinuities that mask the true performance of your component or channel. You must be 
aware of fixture and probing effects and account for them in your measurement setup.

There are multiple approaches to removing fixture and probing effects. Calibration to the 
reference plane is one way to remove effects. Another is to use post-processing techniques 
such as Gating, Port Rotation/Extension and De-Embedding. These techniques are described 
below. All of these techniques are applied to fully corrected (calibrated) measurement data. 
They do not directly effect the calibration. However, you can combine good calibration 
techniques with one or more of these post-processing fixture removal techniques to obtain the 
best measurement accuracy.

CAUTION If you have not yet saved your measured data, save it before removing any of 
these unwanted effects by selecting Save from the File menu. 

Figure 9-1 Ease Versus Accuracy of Removing Unwanted Effects

• Gating provides the ability to remove the effect of a particular circuit element 
mathematically from time-domain plots. The gated section removes a section of the plot 
that you define, replacing it with an ideal transmission line having the same electrical 
delay as the removed section. By observing the original frequency domain response and 
the transformed frequency domain response, the effect of the gating operation on the 
S-parameter data can be seen.
Chapter 9274



Removing Unwanted Effects from the Measurement
• Port Rotation/Extension (part of the Reference Plane Adjustment) mathematically 
extends the measurement plane to the DUT, but assumes the fixture looks like a perfect 
transmission line: a flat magnitude response, a linear phase response, and a constant 
impedance. Port rotation/extension is done after a coaxial calibration has been performed 
at the end of the test cables. If the fixture is very well designed, this technique may be 
sufficient.

• De-embedding (part of the Reference Plane Adjustment) affords a very accurate 
technique that removes the effect of added loss, phase shift, and mismatch due to adding 
adapters, probes, and fixtures to your DUT. It combines the errors determined from a 
coaxial calibration with the errors in the fixture to obtain a single error coefficient array 
that corrects for everything up to the measurement plane of the DUT. De-embedding uses 
an accurate linear model of the fixture, or measured S-parameter data of the fixture. This 
modeled or measured data is then mathematically removed from the DUT measurement 
data in post-processing.
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Gating
The controls for gating the time domain response provide the ability to remove the effect of a 
particular circuit element mathematically. You define the start- and stop-points of the gate. 
The 'Ideal' gate that you create replaces the gated section with an ideal transmission line 
having the same electrical delay as the section that it replaced. 

Up to 10 gates can be added. The gates are numbered sequentially from the left edge of the 
plot to the right edge. For example, the first gate (Gate 1) was added. Then a second gate is 
added to the left of the Gate 1. The gates are then renumbered such that the gate on the left 
(the second gate that was added) becomes Gate 1, and the original gate is changed to Gate 2. 
Either deleting or moving a gate can cause the gates to be renumbered.

By observing the original frequency domain response and the transformed frequency domain 
response, the effect of the gating operation on the S-parameter data can be seen. 

To Add a Gate

1. Click Gating from the Utilities menu. Then click either Gating (Single-Ended) or 
Gating (Balanced) depending on whether your Time Domain plot is single-ended or 
differential.

Figure 9-2 Utilities Menu with Gating Expanded

The Gating Bar (shown in Figure 9-3) and an empty plot window are displayed when 
gating is selected from the Utilities menu.

Figure 9-3 Gating Bar
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2. From the Parameter Bar (or from the Data menu), select the parameter that will have 
gates added to it. 

When you select the parameter, two plots are displayed in the plots window. The left plot is 
the parameter you selected displayed in Time Domain mode. The right plot is that same 
parameter displayed in Frequency Domain Mode. See Figure 9-4. When adding a gate to 
the time domain trace, you will also be able to see how adding the gate affects the 
parameter in the Frequency Domain by watching the right plot.

Figure 9-4 Gating Display: Time Domain Plot and Frequency Domain Plot

3. Click the Start button. 
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4. While watching the gate start marker, a solid blue vertical line on your time domain plot, 
move the slide control to the right to set the start position of the gate. As the slide control 
is positioned, the time (or distance) of the start gating marker is displayed in the Start 
box. See Figure 9-5.

Figure 9-5 Setting the Gating Start Position

5. Click Stop button.
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6. While watching the gate stop marker, a dashed blue vertical line on your time domain plot, 
move the slide control to the right to set the stop position of the gate. See Figure 9-6.

Figure 9-6 Setting the Gating Stop Position

7. Click the Add button to add the gate. 

When Add is selected:

• A gate identifier is added to the Gate box to identify the number of the gate that was 
just added. See Figure 9-7.

• In the Time Domain plot, a straight blue line is added between the start and stop 
points to reflect that the measured data is being replaced mathematically with an ideal 
transmission line.

• In the Frequency Domain plot, the red trace shows how the original S-parameter looks. 
The black trace shows how the S-parameter looks when the effects of the gate are taken 
into account.
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Figure 9-7 The Effects of Adding a Gate

8. Repeat Steps 3 through 7 to add additional gates.

The maximum number of gates that can be added is 10.

To Move a Gate

A gate can be moved by selecting the gate from the Gate list and clicking the Move button, 
and moving the slide control left or right to the desired location. Then select the Apply button 
to have the move take affect. The range between the start and stop values of the gate remains 
the same, just the start and stop values are changed. 

To Delete a Gate

Selecting a gate from the Gate list and clicking the Delete button will delete the gate. The 
gate numbers are moved down in number when a gate is deleted. For example, when Gate 4 is 
deleted, Gate 5 becomes Gate 4, and Gate 6 becomes Gate 5, and so on. 
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Reference Plane Adjustment
Adapters, fixtures, or probes that are used to measure your DUT introduce errors such as 
additional loss, phase shift (skew), and mismatch (impedance discontinuities). Once you have 
made your measurements, you often need to remove the effects of these devices. 

The Reference Plane Adjustment dialog box (Figure 9-8) allows you to manipulate the 
measured data in a variety of ways to remove these effects from the data. The manipulation of 
the measurement data is done mathematically and may be saved for future use. From the 
Reference Plane Adjustment dialog box, you can apply the following adjustments to the 
each of the four ports individually:

2-port De-embedding or 4-port De-embedding

Adapters, test fixtures, or other non-DUT structures introduce unwanted effects and error 
into measurement results. These unwanted effects typically include additional loss, phase 
shift, mismatch, discontinuities, and time delay. De-embedding is the process of 
mathematically removing previously characterized performance of the non-DUT structure 
from the measurement in post-processing.

NOTE De-embedding is a powerful utility, but requires advanced S-parameter 
characterization of the non-DUT structure through measurement or modeling. 
While measuring the structure can provide the most accurate characterization, 
it may be difficult or impossible to perform the measurement due to 
connectivity issues. In these cases, S-parameter models may offer the best 
alternative.

Port Rotation (Extension)

Port rotation allows you to move the calibrated reference plane from the end of the test 
cable toward the DUT in an attempt to eliminate the effects of phase shift introduced by 
the addition of adapters, fixtures, and probes. Port rotation does not correct for additional 
loss and mismatch introduced by these items.

Port Reference Impedance

By default, all four ports are set to 50 ohms impedance. This adjustment mathematically 
transforms the measured data to show the performance of the DUT would change in a 
non-50 ohm measurement system. 
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Figure 9-8 Reference Plane Adjustment Dialog Box

The Reference Plane Adjustment dialog box is associated with the active plot window. It 
remains displayed so you can continue to make changes until you select the Close button or 
minimize it.
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To Use Port Reference Adjustment

There a three main steps in using the port reference adjustment.

1. Choose the adjustment method and set the associated options.

2. Assign the adjustment method to each applicable port.

3. Apply the adjustments to the active file.

To Choose the Adjustment Method and its Options

The first step in using the port reference adjustment is choosing the adjustment method and 
it’s options. 

There are four adjustments: 2-port de-embedding, 4-port de-embedding, port 
rotation/extension, and port reference impedance. Each adjustment has its own options that 
are displayed when the adjustment is select from the list.

1. Choose an adjustment method from the Choose Adjustment Method area. You have the 
following four adjustment methods to choose from. 

• 2-port De-embedding (may not be used with 4-port De-embedding)

• 4-port De-embedding (may not be used with 2-port De-embedding)

• Port Rotation/Extension

• Port Reference Impedance

Figure 9-9 Reference Plane Adjustment Dialog Box Choose Adjustment 
Method Area

2. Choose the options specific to the adjustment method from the right side of the Choose 
Adjustment Method area.

• For 2-port De-embedding, select a 2-port de-embed file. See Figure 9-10.

When 2-port De-embedding is selected, a list is displayed showing the .txs files (files 
created by the PLTS adapter characterization tool) and the .s2p files in the Adapters 
folder where PLTS was installed. The default location is: C:/Program 
Files/Agilent/PLTS/Adapters
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Figure 9-10 2-Port De-embedding Adjustment Method Options

The browse button (...) allows you to locate and use .txs and .s2p files stored elsewhere 
on your computer.

• For 4-port De-embedding, select a 4-port de-embed file. See Figure 9-11.

When 4-port De-embedding is selected, a list is displayed showing the .s4p files, .cit 
files, and the .dut files in the deembedding folder where PLTS was installed. The 
default location is: C:/Program Files/Agilent/PLTS/deembedding

Figure 9-11 4-Port De-embedding Adjustment Method Options

The browse button (...) allows you to locate and use .s4p, .cit, and .dut files stored 
elsewhere on your computer.

• For Port Rotation/Extension, specify the rotation length in mm. See Figure 9-12.

When Port Rotation/Extension is selected, a Specify Rotation box is displayed. 
This box allows you to enter the rotation in millimeters (mm). The equivalent time in 
picoseconds (ps) is also displayed. You may enter real numbers between -50000.0 mm 
and 50000.0 mm by 0.1 mm increments using the spinners. The spinners increase or 
decrease the rotation value of the selected units. However, you can enter values to 11 
places to the right of the decimal using the keyboard.

Figure 9-12 Port Rotation/Extension Adjustment Method Options
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• For Port Reference Impedance, specify the impedance in ohms. See Figure 9-13.

When Port Reference Impedance is selected, a Specify port reference 
impedance box is displayed. This box allows you to enter the impedance in ohms. You 
may enter real numbers between 0.0 ohms and 1000.0 ohms by 0.1 ohm increments 
using the spinners. The spinners increase or decrease the impedance value of the 
selected units. However, you can enter values to 11 places to the right of the decimal 
using the keyboard.

Figure 9-13 Port Reference Impedance Adjustment Method Options

To Assign the Chosen Adjustment Method to the Ports

3. With an adjustment method chosen and the options selected or specified, click the port’s 
assignment button ( ) to assign the adjustment.

When either 2-port or 4-port de-embedding is assigned to a port, a label is displayed in the 
port’s adjustment list. It is labeled with “1.” followed by the de-embedding file name you 
chose in step 2 on page 283. For 4-port de-embedding, when the adjustment is assigned to 
(or removed from) one of the input ports, it will be assigned to (or removed from) both input 
ports. The output ports are handled the same way.

When Port Rotation/Extension is assigned to a port, a label is displayed in the port’s 
adjustment list. It is labeled with “2. x.x mm rotation” where x.x is the rotation that 
was set in step 2 on page 283. Each port may be assigned the same or unique values.

When Port Reference Impedance is assigned to a port, a label is displayed in the port’s 
adjustment list. It is labeled with “3. xx.x Ohm impedance” where xx.x is the impedance 
that was set in step 2 on page 283. Each port may be assigned the same or unique values.
Chapter 9 285



Removing Unwanted Effects from the Measurement
Reference Plane Adjustment
Figure 9-14 Reference Plane Adjustment Dialog Box Assign Method Area

You may remove an adjustment method from a port by selecting the adjustment method 
name in the port’s adjustment list box and then clicking the removal button ( ). 

Clicking the Clear button removes all of the adjustment methods from all ports. It also 
clears the reverse orientation check box settings. However, the Clear button will not 
remove any adjustments that are currently applied to the active .dut file.

CAUTION Port 2 and Port 3 change their position in the Assign Method area depending 
on the calibration type of associated plot window. 

Make sure you assign the adjustment to the appropriate port.

4. Repeat step 3 until the adjustment method is assigned all of the appropriate ports.
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5. If the adjustment method is either 2-port or 4-port de-embedding, you may also select the 
Reverse de-embed orientation on selection for the appropriate ports.

• 2-port de-embedding allows you to select any or all of four ports.
• 4-port de-embedding allows you to select:

— One or both Port 1-3 or Port 2-4 for an SOLT calibration
— One or both Port 1-2 or Port 3-4 for a TRL or LRM calibration or for a TDR 

measurement

6. If you wish to add more adjustments to the ports, repeat steps 1 through 5.

To Apply the Reference Plane Adjustments

7. Click the Apply button to apply the adjustments to the active data window. The data 
displayed on the views will then be updated. 

NOTE Before clicking Apply, make sure the .dut file that you want the adjustments 
applied to is the active plot window.

When the De-embedding indicator on status bar is highlighted, it means that the current 
data has been modified with the de-embedding information shown in the ports listed with 
de-embedding. When the Port Rotation indicator on status bar is highlighted, it means 
that the current data has been modified because at least one port has been rotated. 

The state of the adjustments are maintained in the .dut file which means that when the 
.dut file is loaded again (after saving the adjusted .dut), the appropriate status bar 
indicators on the status bar will be highlighted, and the dialog box will open with the list 
boxes and reverse orientation check boxes initialized appropriately.

After the adjustments are applied, the Apply button is disabled, and the Remove button 
is enabled. The list box entries are not cleared.
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8. Click the Remove button to remove the current adjustments from the active plot window. 

NOTE Before clicking Remove, make sure the .dut file that you want the adjustments 
removed from is the active plot window.

This resets the active plot window to display the original corrected measurement data. The 
port adjustment list boxes are not cleared. If the De-embedding or Port Rotation status bar 
indicators were highlighted, they are now dimmed.

Figure 9-15 De-Embedding and Port Rotation Indicators

9. Click the Close button to close the Reference Plane Adjustment dialog box.
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Using Analysis Tools and Utilities
This chapter describes several tools that are very useful in performing your analysis. This 
chapter includes:

• Markers

• Click and Drag Zooming

• Math

• Data Sharing

• Characterization Report Generator

• Copying and Pasting Plot Formats

• Renaming Plots

• Printing

• File Converter
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PLTS uses two different types of markers. The marker type used is dependent on the analysis 
type. For time domain, frequency domain, and RLCG analysis, refer to Time-Domain, 
Frequency-Domain, and RLCG Markers. For eye diagram analysis, refer to “Eye Diagram 
Markers” on page 299. 

Time-Domain, Frequency-Domain, and RLCG Markers

Time domain, frequency domain, and RLCG analysis use markers that are displayed 
vertically on a plot. As the vertical marker intersects a trace on the plot, the values of the 
horizontal and vertical position at the intersection are displayed. Up to two markers may be 
used on each plot.

To use the markers:

1. With a plot displayed, click the Marker 1 button.

Figure 10-1 Single Marker for Time Domain, Frequency Domain, and RLCG
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2. Click and drag the Marker 1 Slide Control to the right.

As the Slide Control is moved to the right, a solid black vertical line (the marker) is 
displayed with an M1 label at the top of the line.

TIP Once the vertical marker line is displayed, you may adjust the marker by 
clicking and dragging the marker line itself instead of the Slide Control.

3. Release the Slide Control at the desired position of the plot.

The values of the X and Y position for the point that the marker intersects the trace are 
displayed near the upper right corner of the plot.

TIP Moving the Marker One Measurement Point at a Time

A marker may be moved one measurement point at a time by pressing the 
keyboards arrows (← & →) if the marker button (Marker 1 or Marker 2) is 
selected. Each keyboard press changes the X and Y values.

4. To display the second marker, click the Marker 2 button.

Figure 10-2 Time-domain, Frequency-domain, and RLCG Dual Markers
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5. Click and drag the Marker 2 Slide Control to the right, releasing it at the desired 
position of the plot.

As the Slide Control is moved, the marker is displayed. Marker 2 is a dashed black 
vertical line with the label M2 at the top.

The X and Y values for markers are displayed near the upper right corner of the plot. When 
both markers are used, the difference (delta) between the markers is also displayed.

Markers may be used with multiple plots but are unique within individual plots. You may 
have up to two markers in each plot. The marker information is displayed at the upper right 
corner of each plot.

Figure 10-3 Markers with Multiple Plots
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Markers may be used with multiple traces. You may use either one or two markers in a plot 
that displays as many as four traces. The marker information for each trace is displayed along 
the right edge of the plot.

Figure 10-4 Markers with Multiple Traces

Quick Markers

Markers may be accessed quickly. Click the right mouse button over the plot to display the 
shortcut menu shown in Figure 10-5. Both Marker 1 and Marker 2 have four choices 
available: On, Set At…, Find Min, and Find Max.

Figure 10-5 Marker Menu Opened with a Right Button Mouse Click
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On  Turns the associated marker on or off. When the marker is turned on, a check mark is 
shown on the shortcut menu to the left side of the On selection. The marker is displayed with 
a label at the top of the plot.

• Marker 1 is a solid black line with the M1 label at the top of the plot.
• Marker 2 is a dashed black line with the M2 label at the top of the plot.

Adjust the marker by clicking and dragging the marker line to the left or to the right.

Set At…  Places the associated marker at a specified time (with a time domain plot) or at a 
specified frequency (with a frequency domain or RLCG plot). The Set Marker dialog box allows 
you to enter the time or frequency to set the marker. See Figure 10-6.

Figure 10-6 Set Marker Dialog Boxes

Find Min  Places the marker at the minimum measured value. If multiple traces are 
displayed, this selection finds the minimum measured value of all of the traces.

Find Max  Places the marker at the maximum measured value. If multiple traces are 
displayed, this selection finds the maximum measured value of all of the traces.
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Frequency Domain Polar and Smith Chart Markers

Polar or Smith Chart formats display markers that are displayed differently than other 
frequency domain formats. When a marker is used in a Polar or Smith Chart format, it is 
essentially a point that follows the displayed trace around the chart. Up to two markers may 
be used on each plot.

To use the markers:

1. With the plot displayed on the Polar or Smith Chart, select the display style, either Mag + 
Phase or Inductance, on the Marker Bar. See Figure 10-7.

Mag + Phase displays the magnitude and the phase at the marker frequency. 
Inductance displays the magnitude and inductance at the marker frequency.

Figure 10-7 Single Marker for Frequency Domain Polar and Smith Charts
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2. Click the Marker 1 button.

3. Click and drag the Marker 1 Slide Control to the right.

As the Slide Control is moved to the right, a marker is moved along the trace. 

4. Release the Slide Control at the desired position of the plot.

The marker values are displayed near the upper right corner of the plot.

5. Click the Marker 2 button to display the second marker. See Figure 10-8.

Figure 10-8 Polar and Smith Chart Dual Markers
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6. Click and drag the Marker 2 Slide Control to the right, releasing it at the desired plot 
position.

The Marker 2 values are displayed near the upper right corner of the plot. 

When two markers are used, the frequency difference (delta) between the markers is also 
displayed. See Figure 10-8.

Markers may be used with multiple plots. You may use one or two markers in a plot. The 
marker information is displayed at the upper right corner of each plot. See Figure 10-9.

Figure 10-9 Markers with Multiple Polar and Smith Chart Plots
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Eye Diagram Markers

Eye diagrams may use up to two markers. They are labeled Marker 1 and Marker 2. Each of 
these markers have two components, a horizontal (X) position and a vertical (Y) position 
marker. 

The horizontal position markers are displayed as vertical lines that extend from the top to the 
bottom of the eye diagram. See Figure 10-10.

The vertical position markers are displayed as horizontal lines that extend from the left side 
to the right side of the eye diagram. See Figure 10-11.

To use the markers:

Horizontal (X) Markers

1. With a plot displayed, click the Marker 1 button.

Figure 10-10 Eye Diagram Markers: Horizontal (X) Position

2. Click and drag the Marker 1 X Slide Control to the right.

As the X Slide Control is moved, the marker, a solid black vertical line is displayed.
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3. Release the X Slide Control at the desired position of the plot.

The marker’s horizontal (X) position is displayed near the upper right corner of the plot.

4. Click the Marker 2 button and repeat steps 2 and 3 to display the second marker, a 
dashed black vertical line.

The difference (delta) between the two markers is displayed near the upper right corner of 
the plot. See Figure 10-10.

Vertical (Y) Markers

5. To display the Marker 1 vertical (Y) marker, a solid black horizontal line, click the Marker 
1 button and drag the Marker 1 Y Slide Control, releasing the slide control when the 
marker is at the desired position on the plot. See Figure 10-11.

As the Y Slide Control is moved, the marker, a solid black horizontal line is displayed.

Figure 10-11 Eye Diagram Markers: Vertical (Y) Position

6. Repeat step 5 for Marker 2. Marker 2 is a dashed horizontal line.

With two markers displayed, the difference (delta) between the two markers is displayed.
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Quick Markers

By clicking the right mouse button with the cursor over the eye diagram plot, you can access 
the marker choices: Marker 1 and Marker 2. See Figure 10-12. These selections turn both 
the horizontal and vertical markers on or off. The values displayed are computed from the 
screen coordinates of the plot.

Figure 10-12 Eye Diagram Marker Menu Opened with a Right Button Mouse 
Click

Marker 1 This selection turns both the horizontal and vertical markers of Marker 1 on 
or off. When the marker is turned on, a check mark is displayed to the left of 
Marker 1.

Marker 2 This selection turns both the horizontal and vertical markers of Marker 2 on 
or off. When the marker is turned on, a check mark is displayed to the left of 
Marker 2.
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Click and Drag Zoom

NOTE The zoom feature is not available for Eye Diagrams, Polar or Smith Chart plots.

To zoom in on an area of the active plot:

1. Click within the plot and drag the mouse, creating a rectangle as the mouse is moved. See 
Figure 10-13.

Figure 10-13 Defining Zoom Area

The rectangle is created by dashed lines from the point of the mouse click to the point that 
the mouse was dragged. 
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2. Release the mouse button once the rectangle encloses the plot area of interest.

Figure 10-14 New Plot after Zoom

The rectangular area of the plot that you have defined is now displayed, replacing the 
original plot. The displayed plot now has new X-axis start and stop frequencies and new 
Y-axis scale.

3. If the new plot does not center the traces in the Y-axis, clicking the right mouse button 
with the cursor over the plot and selecting Autoscale sets the Y-axis scale so that the data 
is better displayed. 

Figure 10-15 Autoscale Selection
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4. To return the plot to the original horizontal and vertical settings, click the right mouse 
button with the cursor over the plot and select Reset Scale.

Figure 10-16 Reset Scale Selection
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Math may be performed on traces that are displayed within a plot. For example, you may 
divide the data of one trace by the data of a second trace to derive the vectorial difference. 

Math may be performed on a trace using two methods. You may create a formula and apply 
the formula to a displayed trace (see “Creating a Math Formula” on page 305) or you may 
perform a quick math function on a displayed trace (see “Using Quick Math” on page 311). 

Creating a Math Formula

Math formulas may be created, saved, and applied to opened traces at a later time. Formulas 
are created using the Create Formulas dialog box. Figure 10-17 shows the Create Formulas 
dialog box that is used to create and save math formulas. This dialog box is divided into 
several areas.

Figure 10-17 Create Formulas Dialog Box

DUT Files Identifies the desired Data area selection to apply the math operation. It 
allows you to select the file of the data used in the math operation from a list 
of open files. Data from multiple (up to three) files may be used in a formula.

Domain Identifies the desired Data area selection to apply the math operation. It 
allows you to select between Frequency Domain and Time Domain. When in 
frequency domain, you must select between single-ended and balanced data. 
When in time domain, you must select between single-ended and 
differential data.
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Formula Displays the math formula that you are creating.

Data Used to build the formula. It allows you to select parameters based on the 
selections in the Domain area.

Key Pad Used to build the formula. It allows you to enter numeric entries and 
operators.

Functions Used to build the formula. It allows you to enter math symbols and 
delimiters as well as some frequency domain formats.

Formula Name Allows you to enter a name to save the formula and recall it for future use.

To create a math formula:

1. Select Math, Design… from the Tools menu to open the Create Formulas dialog box as 
shown in Figure 10-18.

Figure 10-18 Opening the Create Formulas Dialog Box

2. In the DUT File list, select the file that the first Data area parameter belongs.

Figure 10-19 DUT File Selection List
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3. In the Domain area, select the domain and the mode of the first Data area parameter.

The Domain area allows you to select between Frequency Domain (Freq) and Time 
Domain (Time).

• In frequency domain, select between single-ended (SE) data and balanced (Bal) data.

• In time domain, select between single-ended (SE) data and differential (Diff) data.

Each Domain area combination displays a different set of Data area parameters. Refer to 
Figure 10-20 for the Data area selections for each of the four available combinations.

Figure 10-20 Data Area Parameters for Each Domain Area Combination

4. Start building your formula using the appropriate Data area parameters shown in Figure 
10-20 and the Key Pad and Functions area buttons shown in Figure 10-21.

Figure 10-21 Key Pad and Functions Areas

The Key Pad area buttons are just the ten numerals(0 through 9) and several basic math 
symbols/operators: decimal (.), equals (=), add (+), subtract (-), multiply (*), and divide (/).
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The Functions area buttons are:

5. As you make selections from the Data, the Key Pad, and the Functions areas, these are 
displayed in the Formula area. 

For example, to divide TDD21 by π, select these buttons: TDD21, /, PI 
and the Formula area box would display: 

Use the < BkSp button to back step the cursor one position at a time. 
Use the Clear button to remove the entire entry from the Formula area box.

6. Repeat steps 2 through 5 until your formula is complete.

Table 10-1 Functions Area Buttons

Sqrt ( Use the square root of the 
following term.

Delta ( Use the difference (∆) of the 
following terms.

Real ( Use the real portion of the 
following complex term. This 
choice is not available when 
Time is selected in the Domain 
area.

Imag ( Use the imaginary portion of the 
following complex term. This 
choice is not available when 
Time is selected in the Domain 
area.

Abs ( Use the absolute value of the 
following term. This choice is 
not available when Time is 
selected in the Domain area.

Conj ( Use the standard conjugate 
function for complex numbers. 
This choice is not available 
when Time is selected in the 
Domain area.

Arg ( Use the standard argument 
function for complex numbers. 
This choice is not available 
when Time is selected in the 
Domain area.

( and ) The “open parenthesis” and the 
“closed parenthesis” delimiters

PI pi (π) - the constant of 3.14159… _Z1 
through 
_Z4

The impedance vectors for Port 
1, Port 2, Port 3, and Port 4. 
These choices are not available 
when Time is selected in the 
Domain area.
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7. Once your formula is complete, enter a name for the formula in the Formula Name box 
and click the Save button. See Figure 10-22.

If you want to save the formula with the same name as a previously saved formula, select 
the formula name from the drop down list and click the Save button to delete the 
previously saved formula and save the new formula.

Figure 10-22 Save the Formula

8. When you have finished saving your math formula, click Close to close the Create 
Formulas dialog box. Continue to Applying a Math Formula to use the formula with 
opened data files.
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Applying a Math Formula

Once math formulas have been created and saved, they may be applied to opened data files. 

To apply a math formula:

1. Select Math, Apply… from the Tools menu to open the Choose Variable Traces to Display 
dialog box as shown in Figure 10-23.

Figure 10-23 Opening the Apply Formulas Dialog Box

2. With the Choose Variable Traces to Display dialog box opened, select a formula from the 
list of formulas. See Figure 10-24.

Figure 10-24 Choose Variable Traces to Display Dialog Box

Note that (TD) was appended to the right of the formula name. This informs you that this 
is a time domain formula. Had this been a frequency domain formula, (FD) would have 
been appended to the formula name. 

3. Click the Apply button. The resultant trace is added to the active plot.

4. Click the Remove button to remove the trace. 

5. If you want to delete a formula from the list of formulas, select the formula and click the 
Delete button.

6. Click Exit to return to the main PLTS window.
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Using Quick Math

You can use Quick Math to perform simple math operations on two traces in the same plot. As 
quick math is performed, the resultant trace is displayed on the plot. A plot allows up to four 
measurement and/or math traces. 

To perform a quick math function:

1. With two (or three) data traces displayed on the active plot, click the right mouse button 
with the cursor over the plot. Then click Quick Math and Operand 1. Click the label 
identifying the first trace of the math operation. Refer to Figure 10-25.

Figure 10-25 Four Steps for Quick Math

2. Click the right mouse button with the cursor over the plot. Then click Quick Math and 
Operator. Click the desired math operation.

3. Click the right mouse button with the cursor over the plot. Then click Quick Math and 
Operand 2. Click the label identifying the second trace of the math function.
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4. Click the right mouse button with the cursor over the plot. Then click Quick Math and 
Result (=) to display the result of the math operation.

A new trace is displayed showing the results of the math operation. The trace label is 
displayed along the right side of the plot.

Figure 10-26 Two Traces with Quick Math Result Displayed (SDD21/SCC21)

5. Remove all Quick Math result traces by clicking the right mouse button with the cursor 
over the plot, then click Quick Math and Remove Math.
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Data Sharing
Data sharing allows you to place a maximum of four traces from different files with different 
measurement setup parameters on a single plot. This is very helpful when comparing a 
parameter from the current measurement with the same parameter from a previous 
measurement that you made.

The data sharing feature is only available for Time Domain and Frequency Domain 
parameters. You may only use data sharing between parameters of the same type. For 
example, if you have a “Differential Time Domain” parameter, you may only share with other 
parameters in the “Differential Time Domain” format.

The measurement parameters of the shared files do not need be the same. For example, in 
Frequency domain, you can compare SDD11 from one file with SCD11 from another file.

To use the data sharing feature, with the two files opened:

1. Double-click the plot to select the parameter that you are interested in comparing against 
a parameter of another file. 

2. From Utilities menu, select Data Sharing to open the data sharing bar.

Figure 10-27 Opening the Data Sharing Bar
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3. From the DUT File list shown in Figure 10-28, select the data file that you want to share 
with the plot used in step 1.

Figure 10-28 Data Sharing Bar

4. From the Parameter list, select the parameter to share with the original plot in step 1.

5. Click the Show button to display the selected parameter with the original plot in step 1.

As files are shared with the original plot, a label noting the parameter of the original plot 
is displayed to the right of the plot. The parameters of shared files are also have labels 
displayed to the right of the plot, however, these parameter labels have the shared file 
appended to the label. 

6. Repeat steps 3 through 5 to add another trace to the plot.

7. To remove a trace from the plot, select the DUT file containing the parameter from the 
DUT File list, select the parameter from the Parameter list, then click the Remove 
button.

8. Repeat step 7 to remove another trace from the plot.
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Characterization Report Generator
The Characterization Report is a standard report that can be generated to show:

• Device, Test Equipment, Measurement, and Calibration information

• In the time domain, plots and information for:

— Differential Impedance (TDD11)
— Common Mode Impedance (TCC11)
— Eye Diagram

• In the frequency domain, plots and information for:

— Differential Loss (SDD21)
— Differential Match (SDD11)
— Common to Differential (SCD21)

To generate the characterization report:

1. Select Characterization Report… from the File menu to open the Characterization 
Report dialog box. See Figure 10-29.

Figure 10-29 Open Characterization Report
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The blank Characterization Report dialog box is then displayed as shown in Figure 10-30.

Figure 10-30 Blank Characterization Report Dialog Box

2. Complete the Characterization Report dialog box entries. The dialog box has three areas: 
Measurement Information, Eye Diagram Information, and Data Source. Each area 
is described below. When the Characterization Report dialog box is complete, select the 
Generate Report button to continue.

Figure 10-31 Completed Characterization Report Dialog Box
Chapter 10316



Using Analysis Tools and Utilities
Characterization Report Generator
• The Measurement Information area allows you to input the following information: 
Device Name (a descriptive name for the DUT), Cable Information (any information 
about the cables used during the test), Probe Information (information about any 
probes used during the test), and Calibration Kit Serial Number (affixed to the 
calibration kit box).

• The Eye Diagram Information area allows you input the Data Rate (Gb/s), Rise 
Time (ps), and the Bit Pattern. This information is used to generate the eye diagram 
for the characterization report.

• The Data Source area allows you select the source of the data used to create your 
characterization report. Use Loaded DUT allows you to select any data file that is 
currently opened by selecting the file from the list. Use Saved DUT allows you to 
select any data file that is saved by clicking the Browse… button to locate and select 
the file.

3. In the Export dialog box (see Figure 10-32), select the format in which to save the 
characterization report from the list. Then click the OK button.

Figure 10-32 Select the Report Format in the Export Dialog Box

4. In the Export Options dialog box (see Figure 10-33), select the page range choice. All saves 
all of the characterization report pages. Page Range allows you to enter the range of 
pages to save. Then click the OK button. 

Figure 10-33 Select the Page Range in the Export Options Dialog Box
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5. In the Choose export file dialog box (see Figure 10-34), choose the directory to save the 
characterization report. You may also change the file name or format from the inputs that 
were previously entered. Then click the Save button to save the characterization report.

Figure 10-34 Choose Export File Dialog Box

CAUTION If you want to save to a file that is already open, close it before you attempt to 
save it.

6. Go to the directory to which you saved your characterization report and open the file to 
review. This is a four-page report as shown in Figure 10-35.

The following information is available on the Device Characterization Report:

Page 1 Device Name and Report Time Stamp
Test Equipment Configuration
Calibration Information
Calibration Setup and Measurement Setup Information

Page 2 Differential Impedance (TDD11) Plot and Information
Common Mode Impedance (TCC11) Plot and Information
Chapter 10318



Using Analysis Tools and Utilities
Characterization Report Generator
Figure 10-35 Device Characterization Report 

Page 3 Eye Diagram Plot and Information
Differential Loss (SDD21) Plot and Information

Page 4 Differential Match (SDD11) Plot and Information
Common to Differential (SCD21) Plot and Information
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Copying and Pasting Plot Formats
You can change the plot formats quickly using the Copy/Paste Plot Format functions. These 
functions are very useful when you are displaying several plots within the plot window. 

To perform Copy/Paste Plot Format functions:

1. With your data plots displayed, make any changes in the format or scale of the plot to be 
copied. See Figure 10-36. In this example, the format of TCC12 was changed from step to 
impulse and the vertical scale was changed.

Figure 10-36 Change and Copy the Plot Format and Scale
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2. Click the right mouse button with the cursor over the plot to be copied, TCC12 in this 
example. Then click Copy Plot Format.

3. First, click the plot to be changed and right-mouse click the plot. Then click Paste Plot 
Format. See Figure 10-37.

The plot is now displayed with the new format and scale.

Figure 10-37 Select a Plot and Paste the Format

4. Repeat step 3 to change as many plots to the new format and scale that you like.
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Renaming Plots
Plots are labeled with the parameter that they display. These labels can be changed to text of 
your choice. Labels are limited to 22 characters in length. 

To rename a plot:

1. Right click on the plot to display the shortcut menu as shown in Figure 10-38. From the 
shortcut menu, select Rename Plot… to open the Rename Plot… dialog box.

Figure 10-38 Open the Rename Plot Dialog box
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2. Highlight the original label and type in the new label. See Figure 10-39.

Figure 10-39 Enter the New Label

3. When you have finished entering the new label, click the OK button. The new label is 
displayed above the plot. See Figure 10-40.

Figure 10-40 Saving the Label
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Printing
The Print feature in the File menu has three options. Refer to Figure 10-41. Each of the print 
options is described in this section.

• For Print Setup…, refer to page 325.

• For Print Preview…, refer to page 327.

• For Print…, refer to page 329.

Figure 10-41 Three Print Options from File Menu
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Print Setup…

The Print Setup dialog box allows you to set your printer settings to print the displayed PLTS 
information in the way you choose. 

To set the settings for the printer:

1. Select Print Setup… from the File menu to open the Print Setup dialog box. See Figure 
10-42.

Figure 10-42 Opening the Print Setup Dialog Box
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2. Confirm the settings in the Print Setup dialog box. See Figure 10-43. Change any incorrect 
settings for your printer.

The Print Setup dialog box allows you to change the following basic printer functions:

• The printer: Select a new printer from the Name list in the Printer area.

• The paper size: Select the paper size from the Size list in the Paper area.

• The paper source: Select the paper source from the Source list in the Paper area.

• The paper orientation: Select the orientation, either Portrait or Landscape in the 
Orientation area.

Figure 10-43 Print Setup Dialog Box

More advanced settings are available by selecting the Properties… button or the 
Network… button.

The OK button saves the changes that were made, exits the Print Setup dialog box, and 
returns to the PLTS window.

The Cancel button cancels any changes that were made, exits the Print Setup dialog box, 
and returns to the PLTS window.
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Print Preview…

The Print Preview… option allows you to preview your active plot window before printing 
the display. To preview your active plot window before printing:

1. Select Print Preview… from the File menu to open the preview screen of the active plot 
window. See Figure 10-44.

Figure 10-44 Opening the Print Preview Dialog Box

2. The active plot window is displayed for your review. See Figure 10-45.

The second page of the preview screen displays a list of the open DUT files.
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Figure 10-45 Preview Screen of the Active Plot Window

In addition to the area to be printed, the screen displays the following seven buttons across 
the top of the screen.

Print: Prints the active plot window in the preview screen to the printer.
Next Page: Active when One Page is selected. Moves the display to the next page 

of the display.
Prev Page: Active when One Page is selected. Moves the display to the previous 

page of the display.
One Page or 
Two Page:

Toggles between the two selections. When only one page of the display 
is shown, Two Page is displayed. When both of the pages of the 
display are shown, One Page is displayed.

Zoom In: Allows you to zoom in on the displayed active plot.
Zoom Out: Allows you to zoom out from the displayed active plot.
Close: Closes the preview screen without printing.
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Print…

The active plot window may be printed to the printer defined in the Print Setup dialog box. To 
print the active plot window:

1. Select Print… from the File menu to open the Print dialog box. See Figure 10-44.

Figure 10-46 Opening the Print Dialog Box
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2. Make the Print dialog box selections that meet your requirements. See Figure 10-47.

Figure 10-47 Print…

In the Printer area:

• Select another printer from the Name list if the displayed printer is not 
appropriate.

• Select the Print to file check box, to save the active plot window as a print (.prn) 
file rather than printing to a printer.

In the Print range area:

• Select All to print all pages.
• Select Pages to print specific pages. Then enter the first page to print in the from: 

entry box and enter the last page to print in the to: entry box.

In the Copies area:

• Enter the Number of copies to change the number of copies that you want to 
print. You may enter a number in the entry box or you may click the spinners (the 
up arrow and the down arrow at the right edge of the entry box) to change the 
number of copies.

• If the Number of copies entry is greater than “1”, you can toggle Collate check 
box on and off. If the check box has a check, the print copies will be collated.
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3. When the Print dialog box entries are correct, click the OK button to print the active plot 
window. 

The Cancel button exits the dialog box without printing and returns to the main PLTS 
window.

NOTE The display may also be printed by:

• Selecting the printer button on the Toolbar. See “Toolbar” under the “View 
Menu” section in the “Menu Reference” chapter of the PLTS Installation and 
Reference Guide.

• Selecting the Print button in the print preview display. See page 327.
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File Converter
The File Converter converts files in .dut, .cit, and .s2p formats to files in .txs format. These 
.txs files can be used as thru adapter files for calibration and as deembedding files. The File 
Converter was installed with PLTS, it is a separate utility. 

To begin the file conversion:

1. From the PLTS directory mentioned above, double-click the FileConverter.exe file icon to 
open the File Converter. 

Figure 10-48 FileConverter.exe Executable File
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2. Enter the connector type of the connector in the text boxes and then click the Add File… 
button to open the Open dialog box.

Figure 10-49 File Converter Dialog Box

3. In the Open dialog box, change to the directory where the files to be converted are located. 
In this case: C:/Program Files/Agilent/PLTS/Adapters

Select the type of file (.dut, .cit, or .s2p file) to be converted in the Files of type: box. Select 
the file that you want to convert. Click the Open button.

Repeat if you want to convert multiple files.

Figure 10-50 Selecting the File to Convert
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4. With the files in the left list of the Files conversion area, click the Convert -> button to 
convert and save the files into the original directory.

Figure 10-51 Convert and Save the Files

The converted files are listed in the right list of the Files conversion area.
In this case: C:/Program Files/Agilent/PLTS/Adapters 

5. Click the OK button to close the FileConverter dialog box.

6. Open the Adapters directory to find the newly converted files. In this case, two files were 
converted. 

Figure 10-52 Adapter Directory with Newly Converted Files

The new .txs files can now be used to define a calibration kit. We recommend you move the 
newly-converted .txs files into the Adapters directory of PLTS.
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Appendix is a collection of supplementary information that you may find useful.

Appendix A, “Procedures”

Provides procedures that may be needed but are not commonly used while using 
the physical layer test system.
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Procedures
The procedures in this appendix may be required while using the physical layer test system; 
however, they are not used commonly. The following is a list of the procedures.

• Setting Up the General Purpose Interface Bus Manually is used when you want to set up 
your GPIB in a manual mode.

• Using the Network Analyzer to Make 2-Port Measurements is used when you want to 
make 2-port measurements using only the network analyzer.

• Converting a CitiFile to a PLTS Adapter File is used when you want to convert a citifile 
(“.cit”) containing measured data to an adapter file (“.txs”) for de-embedding.

• IF Gain Adjustment is used to set up the E8362A, E8363A, or E8364A PNA network 
analyzer, with firmware revision less than 3.0, to be used in the PLTS system.
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Setting Up the General Purpose Interface Bus Manually
The Physical Layer Test System software will locate and identify your test system equipment 
automatically. However, there may be the occasion that you need to set up the GPIB address 
for equipment manually. 

The PC uses the General Purpose Interface Bus (GPIB) to communicate with the test system 
hardware. Each test system device must have a unique GPIB address. There are 32 GPIB 
addresses, numbered 0 to 31. GPIB addresses for test equipment are set either using switches 
on the rear panel (as in the case of the test sets for the VNA-based systems and some network 
analyzers (8720ES and 8753ES)) or using the equipment firmware (as in the case of the PNA 
network analyzers and Agilent TDR system).

In the case of GPIB addresses that are set using the rear-panel switches, the GPIB addresses 
are five-bit binary numbers that are set with the switches labeled “16” through “1” (“1” is the 
least significant digit). The five address switches allow for 32 GPIB addresses, numbered from 
0 to 31. The test set has a default address of “18” that is set at the factory. While this address 
is a unique address in most cases, the address may be changed (if required) to avoid conflicts 
with other equipment on the same bus.

There are three other switches labeled “T”, “L”, and “S” which correspond to Talk, Listen, and 
Status. The factory default for these switches is off.

CAUTION If your PC is using an Agilent 82357A USB/GPIB Interface for Windows or any 
Agilent GPIB card, you must perform the following task to allow the software to 
recognize the Agilent GPIB device:

In Windows, select Start, Programs, Agilent IO Libraries, then IO Config. 
Click “gpib0” in the Configured Interfaces list, then click Edit. Change the 
SICL Interface Name to “hpib7” and click OK. Then click OK to confirm the 
change. Restarting the software should allow the software to recognize the 
Agilent GPIB card.
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1. Make sure the GPIB address switch on the rear panel of the test set is set to the correct 
address. The illustration below shows the factory default setting of “18”, which is set by 
turning on switches “16” and “2”. Make sure the “T”, “L”, and “S” switches are set as shown 
(off).

2. Make sure that the network analyzer GPIB address is set to a unique address. The factory 
default address of the network analyzer is “16”. Refer to the network analyzer 
documentation for information about how to check and set the GPIB address of the 
analyzer.

3. If your equipment does not have a switch on the rear panel to change the GPIB address, 
refer to the equipment documentation to changed the address. 

4. Make sure that the GPIB cables are connected from the PC to the test equipment. Refer to 
the hardware installation chapter for your PLTS system in the PLTS Installation and 
Reference Guide.

NOTE After changing any GPIB address setting, cycle the ac power on all system 
equipment, including the PC, to establish the new GPIB address.
Appendix A340



Procedures
Using the Network Analyzer to Make 2-Port Measurements
Using the Network Analyzer to Make 2-Port Measurements
You can make two port measurements using the front panel control of the network analyzer 
without having to disconnect the network analyzer from the test set using the following 
procedure.

1. Turn off the PLTS software.

2. Toggle the power on the test set to reset the switches.

3. Leave the power of the test set in the ON position.

4. Use the network analyzer from the front panel.
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Converting a CitiFile to a PLTS Adapter File
The Physical Layer Test System uses adapter files to de-embed measurement data. PLTS 
adapter files (“.txs” files) can be created by adding a two-line comment near the top of an 
S-parameter citifile (“.cit” file) as shown below. You can use an MS Windows-based ASCII text 
editor such as Notepad to perform this procedure. The following shows a citifile for a thru 
device with 3.5mm connector at each end. (The measurement data within this example file 
has been replaced with a vertical ellipsis only as a space savings for this example.)

CITIFILE A.01.00
NAME S-Parameters
VAR FREQ MAG 400
DATA S[1,1] RI
DATA S[1,2] RI
DATA S[2,1] RI
DATA S[2,2] RI
SEG_LIST_BEGIN
SEG 50000000 20000000000 400
SEG_LIST_END
BEGIN
.
.
.
END

Using the two comment lines shown below, identified with “#TXS”, the type of device and the 
connector type of its ports are identified.

#TXS TYPE=THRU
#TXS PORT1=3.5MM   PORT2=3.5MM

These two comment lines are inserted be the first and second line of the citifile as shown 
below. This is then saved as a “.txs” file in the PLTS deembedding directory.

CITIFILE A.01.00
#TXS TYPE=THRU
#TXS PORT1=3.5MM   PORT2=3.5MM
NAME S-Parameters
VAR FREQ MAG 400
DATA S[1,1] RI
DATA S[1,2] RI
DATA S[2,1] RI
DATA S[2,2] RI
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SEG_LIST_BEGIN
SEG 50000000 20000000000 400
SEG_LIST_END
BEGIN
.
.
.
END
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IF Gain Adjustment
This procedure is for E8362A, E8363A, and E8364A PNA network analyzers that have 
firmware revisions less than Revision 3.0.

It is recommended that the Service IF Gain Adjustment test be run before using the test set. 
This routine adjusts the R Channel receivers ALC gain to ensure phase lock over the entire 
frequency range of the PNA Series Network Analyzer. Connect the test set to the analyzer 
before adjusting the IF gain. 

NOTE When the analyzer is removed from the test set for service, or for other 
applications that do not require the test set, the IF gain adjustment must be 
run again to return the R Channel receiver ALC gain back to normal.

Adjustment Test

1. Close the PNA Series Network Analyzer window.

2. Open “My Computer”, located on the desk top, double click on “Hard Disk (c:).”
(You may also use Explorer). Refer to Figure A-1.

3. Open the following folder path: Programs Files/Agilent/Network Analyzer/Service
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Figure A-1 File Path on PNA Network Analyzer Window

4. Double click “ifgainadjust.exe.”

5. Minimize the PNA Network Analyzer window when it appears. You should see the IF Gain 
Adjust window.

Figure A-2 IF Gain Adjustment Window

6. Select the test set in the “Select Specials, if any” pull down menu and click on “Begin Adj.” 
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Symbols
.cal file extension, 46, 64, 78
.cit file extension, 342
.cit file extension, converting, 332
.dut file extension, converting, 332
.ecl file extension, 49
.s2p file extension, converting, 332
.s4p file format description, 264–267
.txs file extension, 342
.txs file extension, converting to, 332

Numerics
2-port measurements, making, 341
4 box thru configuration, 41, 43
4 cross thru configuration, 41, 43
4-channel LRM calibration procedure, 71
4-channel SOLT calibration, 28, 29, 31
4-channel TRL calibration, 29
4-channel TRL calibration procedure, 57
6 cross thru configuration, 41, 43

A
adapter

all others characterization category, 80
characterization, 79–85
characterization file, 50
check box, 50
in-series, same-sex characterization 

category, 80
marking, 79
orientation, 79

adapter file, 342
Adapter Installation window, 81
address switch, 339
address, GPIB, 339
adjustment, IF gain, 344
ADS, 240
Advanced button, 28
all others adapter characterization category, 

80
amplitude, eye, 188
analysis type, 21, 123
analysis type, selecting the, 17, 119
analyzer model number, 7
analyzing measurement data, 21, 123
applying math formulas, 310
arbitrary bitstream, 198, 199
auto optimize start and stop time, 174
automated start and stop settings, 162
automatic de-skewing, 111
autoscale, 145, 181, 238, 303

averaging, 9, 94

B
bad data, 12, 166, 193
bad data icon, 13, 166, 193
Balanced 1234, 245
Balanced 1324, 245
balanced line, 30
balanced S-parameters, 132–133
balanced transmission line, connecting a, 118
bandwidth, sampler, 94
bandwidth, setting the IF, 9
bar

scaling for frequency domain, 143
scaling for RLCG, 237
scaling for time domain, 180

best throughput and flatness, 94
bit pattern

choosing a, 198
creating a, 194
menu selection, 194
saving, 196

bit pattern length, 199
bit rate, 188
bit representation area, 195
bitstream, arbitrary, 198, 199

C
cables

connecting ECal, 48
TDR, 88

calculations, time domain, 167
calibrate, reason to, 24
calibrating hardware, 9, 14, 94
calibration

changing parameters, 28
checking the data, 27
comparing thru path, 42
electronic, 47–50
icon color changes, 44, 45
interface, mechanical, 40
kit frequency range, 32
kit minimum rise time, 32
kit, defining a, 34, 54, 68
kit, selecting a, 28, 29, 31, 32, 53, 54, 66, 67
kit, TRL, 51
loading existing data, 8, 93
LRM, 65–78
mechanical, 40–46
parameters window, 28
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performing, 14
performing a new, 8, 93
performing TDR, 99–117
procedure, 28–85
prompt, 45
saving data, 46, 64, 78
short/open/load, 44
SOL, 44
thru, 41, 42
thru icon, 43
TRL, 51–64
type, selecting, 29, 31, 53, 66
type, selecting a, 28
without prompts, 44

calibration file name, TDR, 100
calibration kit

defining a TDR, 103
calibration kit selection, TDR, 100
calibration procedure, LRM, 71
calibration procedure, TRL, 57
calibration standards, TDR, 88
calibration times, approximate TDR, 98
calibration type differences, 30
calibration type, choosing a TDR, 107
calibration, performing a module, 109
calibration, performing a TDR standards, 

111–117
changing parameters, 28
changing spatial, 9
characteristic T-Line, 226
characterization file

adapter, 50
ECal module, 49, 50

characterization report generator, 315–319
Characterize Adapter menu selection, 79
characterize adapters, 79–85
check box, adapter, 50
check box, reverse orientation, 50
checking the calibration, 27
chirp-z transform, 148
CITIfile file format description, 259–263
CITIfile keywords, 261
Citifile menu selection, 245, 250
CITIfile terms

array of data, 260
header, 260
package, 260

CitiFile, converting a, 342
CITIfile, importing files, 245
cm, 179
colors

calibration icon changes, 44, 45

of icons, 43, 44
comparing thru path calibrations, 42
connecting the device under test, 118
conversion rules, 12, 166, 193
copying plot formats, 320–321
coupled transmission line, 211
coupled transmission line extraction, 214
creating math formulas, 305
Custom Adapter Characterization Wizard, 

80–85

D
data format, RLCG, 268–272
data sharing, 313–314
dB, angle menu selection, 251
decade, export points per, 258
de-embedding, 281

file, 342
de-skewing, automatic, 111
detecting hardware, 7, 91
deterministic jitter, 188
device under test

connecting a, 118
device, golden, 27
dielectric constant, 94

changing, 9
differential TDR parameters, 97
digital pattern

choosing a, 198
creating a, 194
generator, 194

drift errors, 24

E
ECal, 47–50

connecting the cables, 48
module, 47
module characterization file, 49, 50
module connections, 47
using adapters, 50
window, 47

effective dielectric constant, 94
electronic calibration, 47
electronic calibration. See also ECal
errors, 24
existing calibration data, loading, 8, 93
export file formats, 242
Export menu selection, 246
exporting, 256–258
exporting data files, 246–258
exporting data in CITIfile format, 250
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exporting data in Touchstone format, 251
exporting data to TDA MeasureXtractor, 254
exporting frequency domain data, 249
exporting plots to an image file, 248
exporting plots to clipboard, 247
exporting RLCG, 218
exporting RLCG data, 240
exporting time domain data, 252
exporting transmission line data, 240
extension, port, 281
extracted data, 232
extracting fitted parameters, 209
eye amplitude, 188
eye diagram, 187, 188

bit rate, 188
choosing a digital pattern, 198
creating a digital pattern, 194
deterministic jitter, 188
eye amplitude, 188
eye width, 188
fall time, 188
one level, 187
opening plots, 197
rise time, 188
viewing all plots, 201
viewing custom plots, 203
viewing plots, 197–203
viewing single plots, 202
zero level, 187

eye height, 188
eye width, 188

F
factor, changing velocity, 9
fall time, 188
file converter utility, 332–334
filtering, 157, 189
fitted data, 233
fitted parameters, 208
fitted parameters, extracting, 209
fitted W-element traces, 231–236
flatness, best, 94
format bar

frequency domain, 139
time domain, 178

format menu
frequency domain, 139
time domain, 178

formats
selecting frequency domain, 139–141
selecting time domain, 178–179

frequency
range, 32
setting start and stop, 9
step, setting, 9
uncoupled start and step, 11, 166, 193

frequency domain
changing parameters, 28
changing scale, 143
format bar, 139
format menu, 139
menu selection, 249
modifying measurement parameters, 10
opening plots, 134
scale units, 144
selecting formats, 139–141
view parameters window, 120
viewing all plots, 135
viewing custom plots, 138
viewing plots, 134–138
viewing single plots, 136

frequency domain markers, 291

G
gain, IF, 344
gating, 183, 276–280

adding a gate, 276
deleting a gate, 280
menu selection, 276
moving a gate, 280

generator, digital pattern, 194
golden device, 27
GPIB

address, 339
address switch, 339
address, viewing the, 7, 92

Group Delay format, 139

H
hardware

auto-detection, 7, 91
calibration values, 9, 94
rescan, 8, 92

hSpice, 240
menu selection, 256

I
icon color, 43, 44
icons, resample, interpolate, and bad data, 

13, 166, 193
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IF bandwidth
setting, 9

IF gain, 344
Imaginary format, 140
impedance

format selection, 178
impedance, port reference, 281
Import menu selection, 244
importing CITIfile files, 245
importing data files, 244–245
importing Touchstone files, 245
Impulse, 178
impulse

reflection, 151
transmission, 151

initial software setup, 6–13
initial TDR setup, 91–98
in-series, same-sex adapter characterization 

category, 80
interpolate data, 12, 166, 193
interpolate icon, 13, 166, 193
interpolate RLCG data, 258
inverse Fourier transform, 148

J
jitter, deterministic, 188

K
key, piano, 195
kit, defining a calibration, 34, 54, 68
kit, selecting a calibration, 28, 29, 31, 32, 53, 

54, 66, 67

L
licensing, iii
Linear Mag, 139
load

icon, 44
measurement button, 5, 90

loading existing calibration data, 8, 93
Log Mag, 178
Log Mag format, 139
LRM calibration, 65–78
LRM calibration procedure, 71

M
mag, angle menu selection, 251
making a measurement, 15–20, 118–122
markers, 291–301
masking, 156
math, 305–312

math formulas, applying, 310
math formulas, creating, 305
math, quick, 311
maximum time base, 9, 14, 94
MDIF format, 270
measurement

Load Measurement button, 5, 90
making a, 15–20, 118–122
New Measurement button, 5, 90
parameters, resetting, 9, 14
viewing and analyzing results, 21, 123
window, 15

measurement parameters, modifying the, 
121

measurement stimulus, modifying the, 120
measurement, running the TDR, 122
measurements, making 2-port, 341
mechanical calibration, 40–46

interface, 40
menu selection

Bit Pattern, 194
Citifile, 245, 250
dB, angle, 251
Export, 246
Frequency Domain, 249
Gating, 276
hSpice, 256
Import, 244
mag, angle, 251
Plots to Clipboard, 247
Plots to Image, 248
real, imaginary, 251
RLCG, 256
TDA MeasureXtractor, 254
Time Domain, 252
Touchstone, 245, 251

minimum rise time, 9, 14, 94
mixed-mode S-parameters, 132–133
ML2CTL Model format, 268
model number

module, 92
network analyzer, 7
TDR, 92
test set, 7

modify measurement stimulus, 17
modify time and frequency parameters, 10, 

28
module calibration, 107
module calibration, performing a, 109
module characterization file, 49
module connections, 47
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module model number, 92

N
network analyzer

model number, 7
new calibration, performing a, 8, 93
new measurement button, 5, 90
normalization and reference plane 

calibration, 107
ns, 179
number of points

changing, 9

O
octave, export points per, 258
one level, 187
open icon, 44
opening plots

choosing a digital pattern for eye 
generation, 198

eye diagram, 197
frequency domain, 134
RLCG, 225
time domain, 168

opening the startup wizard, 28
orientation of adapters, 79

P
parameters

changing, 28
mixed-mode (balanced) S, 132–133
recalculating, 28
S, 129–133
single-ended (unbalanced) S, 130–131
view window, 120
window, 28

parameters, modifying the measurement, 
121

pasting plot formats, 320–321
pattern length, 199
pattern, bit, 194, 198
Phase format, 139
piano key, 195
plot formats, copying and pasting, 320–321
plots

opening eye diagram, 197
opening frequency domain, 134
opening RLCG, 225
opening time domain, 168
viewing all eye diagram, 201

viewing all frequency domain, 135
viewing all RLCG, 228
viewing all time domain, 169
viewing custom eye diagram, 203
viewing custom frequency domain, 138
viewing custom RLCG, 230
viewing custom time domain, 172
viewing eye diagram, 197–203
viewing frequency domain, 134–138
viewing RLCG, 225–236
viewing single eye diagram, 202
viewing single frequency domain, 136
viewing single RLCG, 229
viewing single time domain, 170
viewing time domain, 168–172

Plots to Clipboard menu selection, 247
Plots to Image menu selection, 248
plots, renaming, 322–323
points per waveform, 94
points, changing the number of, 9
Polar Chart format, 140
port reference impedance, 281
port reference plane adjustment, 281–288
port rotation (extension), 281
port usage, 30
power

setting, 9
PRBS, 198
preview before printing, 327–328
print preview, 327–328
print setup, 325–326
printing, 329–331
procedures, 337–345
prompt, calibration, 45

Q
quick markers, 294
quick math, 311

R
random errors, 24
range

resolution, 160
Real, 178
Real format, 140
real, imaginary menu selection, 251
recalculate parameters, 9
Recalculate Parameters button, 28
record length, 9, 14, 94
reference impedance, 281
reference plane adjustment, 281–288
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reference plane calibration only, 107
reflection, impulse, 151
reflection, step, 151
relative velocity factor, 94
renaming plots, 322–323
report generator, 315–319
resample, 12, 166, 193
resample icon, 13, 166, 193
rescanning for hardware, 8, 92
reset scale, 146, 182, 239, 303
resetting parameter values, 9, 14
resolution, 9

range, 160
response, 160
spatial, 160

response resolution, 160
reverse adapter orientation

check box, 50
rise time, 188

minimum, 9, 14, 32, 94
setting, 9

RLCG
changing scale, 237
data formats, 268–272
export data formats, 218
exporting data, 240, 256–258
menu selection, 256
opening plots, 225
parameters, 205–240
scale units, 238
viewing all plots, 228
viewing custom plots, 230
viewing plots, 225–236
viewing single plots, 229

RLCG data, 256–258
RLCG format

MDIF, 270
ML2CTL Model, 268
W-element, 268
W-element tabular, 270

RLCG markers, 291
RLCG parameters

extracting, 222
rotation, port, 281
rules, conversion, 12, 166, 193

S
s4p file format description, 264–267
sampler bandwidth, 94
saving

a bit pattern, 196

calibration data, 46, 64, 78
scale

changing frequency domain, 143
changing RLCG, 237
changing time domain, 180
frequency domain horizontal, 144
frequency domain units, 144
frequency domain vertical, 144
RLCG horizontal, 238
RLCG units, 238
RLCG vertical, 238
time domain horizontal, 181
time domain units, 181
time domain vertical, 181

scale, reset, 146, 182, 239, 303
scaling bar

frequency domain, 143
RLCG, 237
time domain, 180

scanning for hardware, 8, 92
Select Adapter Files, 50
selecting the analysis type, 17, 119
setting up for printing, 325–326
Setup Stimulus button, 81
setup, software, 6–13
setup, TDR, 91–98
short icon, 44
short/open/load calibration, 44
signatures, time domain, 151
single-ended S-parameters, 130–131
single-ended TDR parameters, 97
Smith Chart format, 140
smoothed data, 233
smoothed W-element traces, 231–236
smoothing, 234–236
software

initial setup, 6–13
SOL calibration, 44
SOLT calibration, 29, 31

interface, 40
S-parameters, 129–133

mixed-mode (balanced), 132–133
single-ended (unbalanced), 130–131

spatial
resolution, 160
resolution, setting, 9

start frequency, setting the, 9
start frequency, uncoupled, 11, 166, 193
start settings, automated, 162
start time, 173
startup wizard, 5, 90
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opening, 28
Step, 178
step

reflection, 151
setting frequency, 9
transmission, 151

step frequency, uncoupled, 11, 166, 193
stepped measurement, selecting, 9
stimulus, modify the, 17
stimulus, modifying the measurement, 120
stimulus, view window, 120
stop frequency, setting the, 9
stop settings, automated, 162
stop time, 173
switch

GPIB address, 339
system

warmup time, 40, 47, 57, 71
systematic errors, 24

T
TDA MeasureXtractor

menu selection, 254
TDR cables, 88
TDR calibration

performing, 99–117
TDR calibration file name, 100
TDR calibration files, 102
TDR calibration kit

defining a, 103
TDR calibration kit selection, 100
TDR calibration parameters, 97
TDR calibration standards, 88
TDR calibration type, choosing a, 107
TDR measurement parameters, 97
TDR measurement, running the, 122
TDR model number, 92
TDR parameters, selecting, 97
TDR setup, 91–98
TDR standards calibration, performing a, 

111–117
test

set model number, 7
set ports, 79

throughput, best, 94
thru

calibration, 41, 42
configuration, 42
configuration options, 41
configuration patterns, 43
icon, 43

path calibrations, comparing, 42
paths, 41

time base
maximum, 9, 14, 94
setting, 9

time domain
calculation, 167
changing parameters, 28
changing scale, 180
comparison to frequency domain, 148
filtering, 157, 189
format bar, 178
format menu, 178
gating, 183, 276–280
horizontal axis, 179
masking, 156
measurement, 148
menu selection, 252
modifying measurement parameters, 10
opening plots, 168
range resolution, 160
response resolution, 160
scale units, 181
selecting formats, 178–179
signatures, 151
spatial resolution, 160
stimulus, 178
vertical axis, 178
view parameters window, 120
viewing all plots, 169
viewing custom plots, 172
viewing plots, 168–172
viewing single plots, 170
windowing, 157–159, 189–192

time domain markers, 291
time domain time scale, optimizing, 173
time, start and stop, 173
time, warmup, 40, 47, 57, 71
T-Line characteristic, 226
Touchstone file format description, 264–267
Touchstone menu selection, 245, 251
Touchstone, importing files, 245
transmission

impulse, 151
step, 151

transmission line
exporting data, 240
model, 207
models, 211
parameters, 205–240
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transmission line. See also RLCG
triggers to calibrate, 26
TRL calibration, 29, 51–64
TRL calibration kit, 51
TRL calibration procedure, 57

U
unbalanced S-parameters, 130–131
uncoupled start and step frequencies, 11–13, 

166, 193
user preferences, 174
utility, file converter, 332–334

V
validity of a time domain calculation, 167
velocity factor, 94

changing, 9
view, stimulus window, 120
Viewing, 135
viewing measurement data, 21, 123
viewing plots

all eye diagram, 201
all frequency domain, 135
all RLCG, 228
all time domain, 169
custom eye diagram, 203
custom frequency domain, 138
custom RLCG, 230
custom time domain, 172
eye diagram, 197–203
frequency domain, 134–138
RLCG, 225–236
single eye diagram, 202
single frequency domain, 136
single RLCG, 229
single time domain, 170
time domain, 168–172

Volts, 178

W
warmup time, 40, 47, 57, 71
waveform points, 94
welcome screen, 5, 90
W-element format, 268
W-element tabular format, 270
W-element traces, 231–236
when to calibrate, 26
window

Adapter Installation, 81
ECal, 47

windowing, time domain, 157–159, 189–192
wizard

custom adapter characterization, 80–85
startup, 5, 90

Z
zero level, 187
zooming in and out, 302–304
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